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1.1 Informazioni su questo manuale
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DONT NEED NEED A A MANVAL BUT STARTS WITH "HOW TO
A MANUAL  MANUAL  DONT HAVE ONE READ THIS MANUAL

Figura 1-1: 1l *bisogno* di manuali (xkcd.com).

Il Manuale dell'utente di MX ¢ il prodotto di un grande gruppo di volontari della comunita di
MX Linux. Come tale, conterra inevitabilmente errori ¢ omissioni, anche se abbiamo lavorato
duramente per ridurli al minimo. Vi preghiamo di inviarci feedback, correzioni o suggerimenti
utilizzando uno dei metodi elencati di seguito. Gli aggiornamenti avverranno secondo le
necessita.

Questo manuale ¢ stato progettato per guidare i nuovi utenti attraverso i passi per ottenere una
copia di MX Linux, installarlo, configurarlo per lavorare con il proprio hardware e utilizzarlo
quotidianamente. Si propone di fornire un'introduzione generale leggibile e privilegia gli
strumenti grafici quando disponibili. Per argomenti dettagliati o poco frequenti, 1'utente
dovrebbe consultare il Wiki e altre risorse o postare sul forum di MX Linux.

MX Fluxbox non ¢ incluso in questa sezione perché differisce talmente tanto da Xfce e KDE da
allungare e complicare questo manuale. Ogni installazione di MX Fluxbox ¢ accompagnata da
un documento di aiuto separato.

I nuovi utenti potrebbero trovare alcuni dei termini utilizzati in questo manuale poco familiari o
confusi. Abbiamo cercato di limitare 1'uso di termini e concetti difficili, ma alcuni sono
semplicemente inevitabili. I1 Glossario che si trova alla fine del documento fornisce definizioni
e commenti che aiutano a comprendere i passaggi piu difficili.

Tutti 1 contenuti sono © 2021 di MX Linux Inc. e rilasciati sotto licenza GPLv3. La citazione deve essere letta:
Progetto di documentazione comunitaria MX Linux. 2023. Manuale d'uso di MX Linux.
Feedback:

* Email: manual AT mxlinux DOT org


https://forum.mxlinux.org/

«  Forum: Documentazione e video MX

1.2 Informazioni su MX Linux

L'atteggiamento degli utenti nei confronti di MX Linux, o di qualsiasi altro sistema operativo, ¢
molto vario. Alcuni desiderano semplicemente un apparecchio che funzioni, come una
caffettiera che produce una bevanda calda su richiesta. Altri potrebbero essere curiosi di sapere
come funziona effettivamente, cio¢ perché si ottiene il caffe e non una melma densa. Questa
sezione ha lo scopo di orientare il secondo gruppo. Il primo gruppo potrebbe preferire saltare
alla Sezione 1.3: "Informati!".

MX Linux ¢ una versione desktop della fusione tra la raccolta di software libero GNU e il kernel
Linux, entrambi nati all'inizio degli anni Novanta. GNU/Linux, o pit semplicemente e
comunemente chiamato "Linux", ¢ un sistema operativo (OS) libero e open-source che ha un
approccio unico e di grande successo a tutto, dal kernel agli strumenti alla struttura dei file
(Sezione 7). Viene fornito agli utenti attraverso distribuzioni o "distro", tra cui una delle piu
antiche e popolari ¢ Debian, su cui ¢ stato costruito MX Linux.

1.2.1 Linux

Per fornire una rapida panoramica, ecco un diagramma e una descrizione semplificati di un
sistema operativo Linux, adattati da Anatomy of the Linux kernel.

/"
User
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GNU C Library (glibc)
"\
G_NU’ < System Call Interface
Linux T
Kernal Kernel
Space
|
Archdecture-Depandent Kamel Codea
. o
Hardware Platform

* In cima si trova lo spazio utente, noto anche come spazio delle applicazioni. Qui
vengono eseguite le applicazioni utente fornite dalla distribuzione o aggiunte dall'utente.
C'¢ anche l'interfaccia GNU C Library (g/ibc) che collega le applicazioni al kernel. (Da
qui il nome alternativo "GNU/Linux" mostrato nel diagramma).


https://forum.mxlinux.org/viewforum.php?f=101
https://www.gnu.org/
https://en.wikipedia.org/wiki/Linux
https://en.wikipedia.org/wiki/Linux_distribution
https://en.wikipedia.org/wiki/Debian

* Al di sotto dello spazio utente si trova lo spazio kernel, dove esiste il kernel Linux. Il
kernel ¢ dominato dai driver hardware.

Sistema di file

Uno dei primi problemi con cui molti nuovi utenti di Linux si scontrano ¢ il funzionamento del
file system. Molti nuovi utenti hanno cercato invano di trovare 1'unita C:\ o D:\, per esempio, ma
Linux gestisce 1 dischi rigidi e gli altri supporti di memorizzazione in modo diverso da
Windows. Invece di avere un albero di file system separato su ogni dispositivo, MX Linux ha un
unico albero di file system (chiamato la radice del file system), che ¢ indicato come "/" e
contiene ogni dispositivo collegato. Quando un dispositivo di archiviazione viene aggiunto al
sistema, il suo file system viene collegato a una directory o a una sottodirectory del file system;
questa operazione si chiama montaggio di un'unita o di un dispositivo. Inoltre, ogni utente ha
una sottodirectory dedicata sotto /home, e per impostazione predefinita ¢ qui che si cercano i
propri file. Per maggiori dettagli, vedere la Sezione 7.

La maggior parte delle impostazioni dei programmi e del sistema su MX Linux sono
memorizzate in file di configurazione di testo semplice; non esiste un "registro" che richiede
strumenti speciali per essere modificato. I file sono semplici elenchi di parametri e valori che
descrivono il comportamento dei programmi all'avvio.

Attenzione

I nuovi utenti hanno aspettative derivanti dalla loro precedente esperienza. Questo ¢ naturale,
ma puo portare all'inizio a confusione e frustrazione. Due nozioni fondamentali da tenere a
mente:

1. MX Linux non ¢ Windows. Come indicato in precedenza, non esiste un registro o
un'unita C:\ e la maggior parte dei driver ¢ gia presente nel kernel.

2. MX Linux non ¢ basato sulla famiglia Ubuntu, ma su Debian. Cio significa che i
comandi, i programmi e le applicazioni (in particolare quelli contenuti negli "Archivi
personali dei pacchetti" o PPA) della famiglia Ubuntu potrebbero non funzionare
correttamente o addirittura mancare.

1.2.2 MX Linux

MX Linux, rilasciato per la prima volta nel 2014, ¢ una collaborazione tra le comunita antiX ed
ex MEPIS che utilizza i migliori strumenti e talenti di ciascuna distro e include il lavoro e le idee
originariamente create da Warren Woodford. E un sistema operativo di peso medio progettato
per combinare un desktop elegante ed efficiente con una configurazione semplice, un'elevata
stabilita, prestazioni solide e un ingombro medio.

Facendo affidamento sull'eccellente lavoro upstream di Linux e della comunita open-source,

con MX-23 distribuiamo il nostro fiore all'occhiello Xfce 4.18 come ambiente desktop, insieme
a KDE/Plasma.

5.27. e Fluxbox 1.3.7 come versioni indipendenti separate. Tutti poggiano su una base Debian
Stable (Debian 12, "Bookworm"), attingendo anche al nucleo del sistema antiX. I continui
backport e le aggiunte esterne ai nostri repo servono a mantenere i componenti aggiornati con gli


https://antixlinux.com/
https://en.wikipedia.org/wiki/MEPIS
https://www.xfce.org/about/tour418
https://wiki.debian.org/DebianStable

sviluppi richiesti dagli utenti.



L'™MX Dev Team ¢ composto da un gruppo di volontari con background, talenti e interessi
diversi. Per 1 dettagli, vedere Chi siamo. Un ringraziamento speciale per il forte e continuo
sostegno a questo progetto va ai Packager di MX Linux, ai produttori di video, ai nostri grandi
volontari e a tutti 1 nostri traduttori!

1.3 Informatevi!

Le icone sul desktop rimandano a due documenti utili: le FAQ e il Manuale d'uso.

* Le FAQ forniscono un rapido orientamento ai nuovi utenti, rispondendo alle
domande piu frequenti sul Forum.

* Il Manuale d'uso fornisce una panoramica dettagliata del sistema operativo. Poche
persone lo leggono da cima a fondo, ma puo essere consultato rapidamente 1) usando
lo schema per saltare all'argomento generale che interessa, oppure 2) premendo A/t +
F1 per aprirlo e Ctrl + F per cercare una voce particolare.

e Altre fonti di informazione sono il Forum, il Wiki, la raccolta di video online e vari

account sui social media. Queste risorse sono piu facilmente raggiungibili dalla pagina
iniziale.

1.4 Supporto e EOL

Che tipo di supporto ¢ disponibile per MX Linux? La risposta a questa domanda dipende dal
tipo di supporto che si intende:

* Problemi basati sull'utente. Per MX Linux esiste una serie di meccanismi di
supporto, da documenti e video a forum e motori di ricerca. Per maggiori dettagli,
consultare la pagina del supporto comunitario.

* Hardware. L'hardware ¢ supportato nel kernel, dove ¢ in corso un continuo
sviluppo. Un hardware molto nuovo potrebbe non essere ancora supportato € un
hardware molto vecchio, anche se ancora supportato, potrebbe non essere piu
sufficiente per le esigenze del desktop e delle applicazioni. Tuttavia, la maggior parte
degli utenti trovera il supporto per il proprio hardware.

* Desktop. Xfce4 ¢ un desktop maturo che rimane in fase di sviluppo. La versione
fornita con MX Linux (4.18) ¢ considerata stabile; gli aggiornamenti importanti
saranno applicati non appena disponibili. L'ambiente KDE/Plasma viene mantenuto
costantemente.

» Applicazioni. Le applicazioni continuano a essere sviluppate dopo il rilascio di
qualsiasi versione di MX Linux, il che significa che le versioni fornite diventano piu
vecchie con il passare del tempo. Questo problema viene affrontato attraverso una
combinazione di fonti: Debian (compresi i Debian Backports), i singoli sviluppatori


https://mxlinux.org/about-us
https://forum.mxlinux.org/
https://mxlinux.org/wiki/
https://mxlinux.org/
https://mxlinux.org/
https://mxlinux.org/support
https://mxlinux.org/support

(compresi gli MX Devs) e il Community Packaging Team, che accetta il piu possibile
le richieste di aggiornamento degli utenti. MX Updater segnala quando sono
disponibili nuovi pacchetti da scaricare.



* Sicurezza. Gli aggiornamenti di sicurezza di Debian copriranno gli utenti di MX
Linux per un massimo di 5 anni. Consultare MX Updater per la notifica della loro
disponibilita.

1.5 Note per i traduttori

Alcune indicazioni per chi traduce il Manuale d'uso:

» Itesti in inglese dell'ultima versione si trovano in un repo GitHub. Le traduzioni sono
memorizzate nella directory "tr".

= E possibile lavorare all'interno del sistema GitHub: clonare il repository
principale, apportare le modifiche e quindi fare una richiesta di pull per ottenere

la revisione per l'unione con la sorgente.

= In alternativa, ¢ possibile scaricare cio che interessa e lavorarci localmente prima di
comunicare che ¢ pronto con un'e-mail a manual AT mxlinux DOT org o postando
sul forum.

* In termini di importanza, si consiglia di iniziare con le sezioni 1-3, che forniscono le
informazioni piu rilevanti per i nuovi utenti. Una volta terminate, queste possono
essere distribuite agli utenti come traduzione parziale, mentre le sezioni successive
vengono tradotte.


https://github.com/jerry3904/mxum
https://help.github.com/articles/cloning-a-repository/
https://help.github.com/articles/about-pull-requests/

2.1 Introduzione

Un supporto live MX Linux (chiavetta USB o DVD) avvia il computer senza accedere al disco
rigido. Copia un file system virtuale nella RAM che funge da centro di un sistema operativo
temporaneo per il computer. Quando si termina la sessione live, tutto il computer torna come
prima, immutato (contrasto con la Sezione 6.6.1).

Ci0 offre una serie di vantaggi:

* Consente di eseguire MX Linux sul computer senza installarlo.

* Consente di determinare se MX Linux ¢ compatibile con I'hardware in uso.

* Vi aiutera a capire come funziona MX Linux e a esplorare alcune delle sue caratteristiche.

+ E possibile decidere se MX Linux ¢ cio che si desidera senza modificare in modo
permanente il sistema attuale.

L'esecuzione da un LiveMedium presenta anche alcuni svantaggi:

* Poiché I'intero sistema funziona da una combinazione di RAM e supporto, MX Linux
richiedera piut RAM e potrebbe funzionare piu lentamente rispetto all'installazione sul
disco rigido.

* Alcuni hardware insoliti che richiedono driver specializzati o una configurazione
personalizzata potrebbero non funzionare in una sessione live di sola lettura (come un
DVD), dove non ¢ possibile installare file permanenti. La nostra chiavetta USB con
persistenza non presenta questo problema.

21.1 PAE
MX Linux ¢ disponibile per due architetture, a 32 e 64 bit, entrambe dotate di Physical Address

Extension (PAE). PAE ¢ un modo per consentire a un sistema operativo a 32 bit di accedere alla

RAM oltre i 4 GB circa. E possibile utilizzare una versione non PAE su un sistema PAE, ma non
viceversa. Se la vostra macchina non ¢ in grado di gestire PAE (ad esempio, ¢ molto vecchia), vi
consigliamo di installare la nostra distro sorella antiX Linux.

Se non si ¢ sicuri di aver bisogno della versione PAE o non PAE, utilizzare il metodo seguente
adatto al sistema operativo in uso.

* Linux. Aprite un terminale e digitate questo comando (installate prima inxi, se
necessario): inxi -f. Se la voce Flags della CPU non include PAE nell'elenco, non sara
possibile installare MX Linux.

* Mac. Le versioni Intel di OS X supportano PAE.

« Windows

*  Windows2000 e precedenti: nonPAE

* Windows XP e Vista. Fare clic con il pulsante destro del mouse su Risorse del
computer > Proprieta, scheda Generale. Se in basso ¢ presente la dicitura
Physical Address Extension (=PAE), allora PAE ¢ la versione corretta da


https://en.wikipedia.org/wiki/32-bit
https://en.wikipedia.org/wiki/64-bit_computing
http://en.wikipedia.org/wiki/Physical_Address_Extension
http://en.wikipedia.org/wiki/Physical_Address_Extension
https://antixlinux.com/

installare.



* Windows 7. Aprite la finestra del Prompt dei comandi facendo clic sul pulsante
Start > Tutti 1 programmi > Accessori > Prompt dei comandi. Verra visualizzata
una finestra di terminale. Inserite questo codice nel prompt dei comandi dove ¢

posizionato il cursore:
wmic os get PAEEnabled
Se PAE ¢ abilitato, si otterra un risultato simile a questo: PAEEnabled. Questo

ritorno puo essere seguito o meno dalla parola TRUE.
* Windows 8 e successivi. PAE abilitato per impostazione predefinita.

2.1.2 32 o 64 bit?

Qual é l'architettura della CPU?
Seguire il metodo appropriato qui di seguito per scoprire se la macchina ¢ a 32 o 64 bit.*
* Linux. Aprite un terminale e digitate il comando Iscpu, quindi esaminate le prime righe

per conoscere l'architettura, il numero di core, ecc.
* Windows. Consultate questo documento Microsoft.

» Apple. Consultate questo documento Apple.

*Se invece volete conoscere l'architettura del sistema operativo, usate il comando uname -m.

In generale, se disponete di una CPU a 64 bit e della RAM necessaria per il vostro particolare
computer e processore, dovreste utilizzare la versione a 64 bit. Questo perché i 64 bit sono
generalmente piu veloci, anche se nell'uso quotidiano la differenza potrebbe non essere notata.
A lungo termine, inoltre, un numero crescente di applicazioni di grandi dimensioni sara
probabilmente limitato alle versioni a 64 bit. Si noti che un'applicazione o un sistema operativo
a 32 bit puo funzionare su una CPU a 64 bit, ma non il contrario.

Per ulteriori informazioni, vedere qui.

Quanta memoria (RAM) avete?

* Linux. Aprite un terminale e inserite il comando firee -h ¢ guardate il numero nella
colonna Total.

* Windows. Aprite la finestra Sistema utilizzando il metodo consigliato per la vostra
versione e cercate la voce "Memoria installata (RAM)".

* Apple. Fate clic sulla voce "Informazioni su questo Mac" nel menu Apple di Mac OS
X e cercate le informazioni sulla RAM.

2.1.3 Requisiti di sistema

Per un sistema MX Linux installato su un disco rigido, sono normalmente necessari 1 seguenti
componenti.

Minimo

* Un'unita CD/DVD (e un BIOS in grado di eseguire I'avvio da tale unita) o una
chiavetta USB da 4 GB (e un BIOS in grado di eseguire l'avvio da USB)


https://support.microsoft.com/en-us/kb/827218
https://support.apple.com/en-us/HT201948
https://www.techsupportalert.com/content/32-bit-and-64-bit-explained.htm

* Un moderno processore 1686 Intel o AMD
 1GBdi RAM

* 6 GB di spazio libero sul disco rigido

Consigliato

* Un'unita CD/DVD (e un BIOS in grado di eseguire I'avvio da tale unita) o una
chiavetta USB da 8 GB, se si utilizza la persistenza (e un BIOS in grado di
eseguire 1'avvio da USB).

* Un moderno processore 1686 Intel o AMD

* 2GB di RAM o piu

* Almeno 20 GB di spazio libero sul disco rigido

* Una scheda video con capacita 3D per il supporto di desktop 3D

* Una scheda audio SoundBlaster, AC97 o HDA compatibile

NOTA: alcuni utenti di MX Linux 64-bit riferiscono che 2 GB di RAM sono sufficienti per un
uso generale, anche se si consiglia di utilizzare almeno 4 GB di RAM se si eseguono processi
(come la rimasterizzazione) o applicazioni (come un editor audio o video) che richiedono molta
memoria.

2.2 Creazione di un supporto avviabile

2.2.1 Ottenere I'immagine ISO

MX Linux ¢ distribuito come immagine ISO, un file immagine del disco nel formato del file
system ISO 9660. E disponibile in due formati nella pagina di download.

* Il rilascio originale di una determinata versione.

» Si tratta di una versione statica che, una volta rilasciata, rimane inalterata.
* Piu lungo ¢ il tempo trascorso dal rilascio, meno ¢ attuale.

* Un aggiornamento mensile di una determinata versione. Questa immagine ISO
mensile viene creata dalla release originale utilizzando MX Snapshot (vedere
Sezione 6.6.4).

* Include tutti gli aggiornamenti dalla versione originale e quindi elimina la
necessita di scaricare un gran numero di file dopo l'installazione.
» Inoltre, consente agli utenti di eseguire una sessione live con la versione


http://en.wikipedia.org/wiki/ISO_9660
http://www.mxlinux.org/download-links

piu recente dei programmi.
* Disponibile solo come download diretto!



q Creare una live-usb antiX/MX da Windows

Acquisto
Le unita USB, i computer e cosi via disponibili con immagine ISO preinstallata sono elencati nella

pagina hardware.
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Figura 2-1: Distribuzione dei mirror MX Linux (settembre 2021).
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Scaricare

MX Linux puo essere scaricato in due modi dalla pagina di download.

Diretto. I download diretti sono disponibili dal nostro Direct Repo o dai nostri mirror.
Salvare I'immagine ISO sul disco rigido. Se una fonte sembra lenta, provatene un'altra.
Disponibile sia per la versione originale che per 1'aggiornamento mensile.

Torrent. La condivisione di file BitTorrent fornisce un protocollo Internet per un
efficiente trasferimento di massa dei dati. Il trasferimento ¢ decentralizzato in modo da
utilizzare connessioni con buona larghezza di banda e ridurre al minimo la pressione
sulle connessioni a bassa larghezza di banda. Un ulteriore vantaggio ¢ che tutti i client
BitTorrent eseguono il controllo degli errori durante il processo di download, quindi non
& necessario eseguire un controllo mdSsum separato al termine del download. E gia stato
fatto!

Il Team Torrent di MX Linux mantiene uno swarm BitTorrent seminato dell'ultima
immagine [SO di MX Linux (solo la versione originale), registrata su archive.org entro
24 ore dal rilascio ufficiale. I link ai torrent si trovano nella pagina dei download.

Andare alla pagina di download e fare clic sul link torrent corretto per la propria
architettura. Il browser dovrebbe riconoscere che si tratta di un torrent e chiedere come
gestirlo.

In caso contrario, fare clic con il tasto sinistro del mouse sul torrent per visualizzare la
pagina e fare clic con il tasto destro per salvarlo. Facendo clic sul torrent scaricato si
avviera il client torrent (Transmission per impostazione predefinita), mostrando il
torrent nell'elenco; evidenziarlo e fare clic su Avvia per iniziare il processo di
download. Se avete gia scaricato I'immagine ISO, assicuratevi che si trovi nella stessa
cartella del torrent appena scaricato.

2.2.2 Controllare la validita dell'immagine ISO scaricata

Dopo aver scaricato un'immagine ISO, il passo successivo ¢ quello di verificarla. Sono

disponibili diversi metodi.

md5sum

Ogni immagine ISO ¢ accompagnata da un file md5sum corrispondente. E necessario verificare

I'mdSsum del file scaricato rispetto a quello ufficiale. Se I'immagine ISO scaricata ¢ autentica,

il suo mdSsum sara identico a quello ufficiale. I passaggi seguenti consentono di verificare

l'integrita dell'immagine ISO scaricata su qualsiasi piattaforma OS.

Finestre
Gli utenti possono verificare piu facilmente con il creatore di USB avviabili Rufus; ¢
inoltre disponibile uno strumento chiamato WinMDSFREE da scaricare e utilizzare

gratuitamente.

Linux

In MX Linux, navigare nella cartella in cui sono stati scaricati la ISO e il file md5sum.
Fare clic con il pulsante destro del mouse sul file md5sum > Verifica integrita dati. Verra
visualizzata una finestra di dialogo che dice "<nome della ISO>: OK" se i numeri sono


https://mxlinux.org/download-links
http://en.wikipedia.org/wiki/BitTorrent
https://mxlinux.org/download-links
https://rufus.akeo.ie/
http://www.winmd5.com/

identici. E anche possibile fare clic con il pulsante destro del mouse sull'ISO > Calcola
mdSsum e confrontarlo con un'altra fonte.



Per le situazioni in cui questa opzione non ¢ disponibile, aprite un terminale nella
posizione in cui avete scaricato I'ISO (i file manager di Linux di solito hanno un'opzione
Apri terminale qui), quindi digitate: md5sum filename.iso

Assicuratevi di sostituire "filename" con il nome effettivo del file (digitate le prime due
lettere, poi premete Tab e verra compilato automaticamente). Confrontate il numero
ottenuto con questo calcolo con il file mdSsum scaricato dal sito ufficiale. Se sono
identici, la vostra copia ¢ identica alla versione ufficiale.

MacOS

Gli utenti Mac devono aprire una console e accedere alla directory con i file ISO e
md5sum. Quindi, eseguire questo comando: md) -c filename.md5sum

Assicuratevi di sostituire "filename" con il nome effettivo del file.

sha256sum

Una maggiore sicurezza ¢ fornita da sha256 e sha512. Scaricate il file per verificare l'integrita
dell'ISO.

Windows: il metodo varia a seconda della versione. Effettuate una ricerca sul Web su
"windows <versione> verifica somma sha256".

Linux: seguire le indicazioni per md5sum, sopra, sostituendo
"sha256sum' o "sha512sum" per "mdSsum".

MacOS: aprire una console, passare alla directory con i file ISO e sha256 ed eseguire
questo comando:

shasum -a 256 /percorso/al/file

Firma GPG
I file ISO di MX Linux sono firmati dagli sviluppatori di MX Linux. Questo metodo di

sicurezza permette all'utente di essere sicuro che I'ISO sia quello che dice di essere:

un'immagine ISO ufficiale degli sviluppatori. Istruzioni dettagliate su come eseguire questo

controllo di sicurezza sono disponibili nel Wiki tecnico di MX/antiX.

2.2.3 Creare un LiveMedium

DVD

Masterizzare una ISO su un DVD ¢ facile, a patto che si seguano alcune importanti linee guida.

Non masterizzare 1'immagine ISO su un CD/DVD vuoto come se fosse un file di dati!
Un'immagine ISO ¢ un'immagine formattata e avviabile di un sistema operativo. E
necessario scegliere Masterizza immagine disco o Masterizza ISO nel menu del
programma di masterizzazione di CD/DVD. Se la si trascina semplicemente in un
elenco di file e la si masterizza come un normale file, non si otterra un LiveMedium
avviabile.

Utilizzare un DVD-R o DVD+R scrivibile di buona qualita con capacita di 4,7 GB.


https://en.wikipedia.org/wiki/SHA-2
https://mxlinux.org/wiki/system/signed-iso-files

Unita USB (alias unita di salto, unita flash, pen drive, chiavetta USB)

E possibile creare facilmente una chiavetta USB avviabile che funzioni con la maggior parte
dei sistemi. MX Linux include lo strumento MX Live USB Maker (vedere Sezione 3.2) per
questo compito.
» Se si desidera creare una chiavetta USB su Windows, si consiglia di utilizzare Rufus,
che supporta il nostro bootloader, o una versione recente di Unetbootin.
* Se utilizzate Linux, offriamo il nostro live-usb-maker-qt come Appimage a 64 bit.

* Se la chiavetta USB si avvia ma viene visualizzato il messaggio di errore gfxboot.c32:
not a COM32R image, si dovrebbe comunque essere in grado di avviare il sistema
digitando "live" al prompt della riga successiva. La riformattazione della chiavetta USB
e il riflash dell'immagine ISO dovrebbero eliminare 1'errore.

* Se i creatori di USB grafici falliscono, € possibile utilizzare il comando "dd" in MX
Live USB Maker.

* ATTENZIONE: fate attenzione a identificare correttamente la chiavetta USB di
destinazione, poiché il comando dd sovrascrivera completamente i dati sull'unita
di destinazione.

* Per verificare il nome/lettera del dispositivo corretto per la chiavetta USB,
aprire un terminale, digitare Isb/k e premere Invio.
Verra visualizzato un elenco di tutti 1 dispositivi collegati al sistema. Dovreste
essere in grado di identificare la vostra chiavetta USB in base alle dimensioni di
memoria elencate.

* Per i dettagli, consultare il Wiki MX/antiX.

$ lsblk
NAME ~ MAJ:MIN RM  SIZE RO TYPE MOUNTPOINT
sda 8:0 0 111.86 0 disk
t:sdal 8:1 0 20.56 0 part /
sda2 8:2 © 91.3G 0O part /home
sdb 8:16 © 931.5G6 0 disk
t:sdbl 8:17 © 10.8G 0 part [SWAP]
sdb2 8:18 0 920.8G 0O part /media/data

Figura 2-3: Tipico output del comando Isblk, che mostra due dischi rigidi, ciascuno con due
partizioni.

2.3 Pre-installazione

2.3.1 Provenienti da Windows

Se si intende installare MX Linux in sostituzione di Microsoft Windows®, € una buona idea
consolidare ed eseguire il backup dei file e degli altri dati attualmente memorizzati in Windows.
Anche se si prevede di eseguire il dual boot, ¢ necessario eseguire un backup di questi dati in
caso di problemi imprevisti durante 1'installazione.

Backup dei file
Individuare tutti i file, come documenti di Office, immagini, video e musica:

* In genere, la maggior parte di questi si trova nella cartella Documenti.
* Cercare vari tipi di file dal menu Applicazioni di Windows per assicurarsi di averli
trovati e salvati tutti.
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* Alcuni utenti fanno il backup dei loro font per riutilizzarli in MX Linux con
applicazioni (come LibreOffice) che possono aprire documenti Windows.

* Una volta individuati tutti questi file, copiarli su un CD, un DVD o un dispositivo
esterno come una chiavetta USB.

Backup dei dati di e-mail, calendario e contatti

A seconda del programma di posta elettronica o di calendario utilizzato, i dati della posta
elettronica e del calendario potrebbero non essere salvati in una posizione ovvia o0 con un nome
di file ovvio. La maggior parte delle applicazioni di posta elettronica o di pianificazione (come

Microsoft Outlook®y son6 in grado di esportare questi dati in uno o piu formati di file. Per sapere
come esportare 1 dati, consultare la documentazione della guida dell'applicazione.

* Dati e-mail: Il formato piu sicuro per le e-mail ¢ il testo semplice, poiché la maggior
parte dei programmi di posta elettronica supporta questa funzione; assicurarsi di
comprimere il file per garantire che tutti gli attributi del file siano mantenuti. Se si
utilizza Outlook Express, la posta ¢ memorizzata in un file .dbx o .mbx, che puo essere
importato in Thunderbird (se installato) su MX Linux. Utilizzare la funzione di ricerca
di Windows per individuare questo file e copiarlo nel backup. La posta di Outlook deve
essere importata in Outlook Express prima di essere esportata per 1'uso in MX Linux.

* Dati del calendario: esportare i dati del calendario in formato iCalendar o vCalendar, se
si desidera utilizzarli in MX Linux.

* Dati di contatto: i formati piu diffusi sono CSV (comma separated values) o vCard.

Conti e password

Anche se di solito non vengono memorizzati in file leggibili di cui € possibile eseguire il backup,
¢ importante ricordare di annotare le informazioni relative ai vari account che potrebbero essere
state salvate nel computer. I dati di accesso automatico ai siti web o ai servizi come il vostro ISP
dovranno essere inseriti di nuovo, quindi assicuratevi di memorizzare su disco le informazioni
necessarie per accedere di nuovo a questi servizi. Alcuni esempi sono:

* Informazioni di accesso all'ISP: Sono necessari almeno il nome utente e la password del
provider di servizi Internet e il numero di telefono per connettersi se si utilizza una
connessione dial-up o ISDN. Altri dettagli potrebbero includere il numero di uscita, il
tipo di composizione (a impulsi o a toni) e il tipo di autenticazione (per la connessione
telefonica); 1'indirizzo IP e la maschera di sottorete, il server DNS, I'indirizzo IP del
gateway, il server DHCP, il VPI/VCI, I'MTU, il tipo di incapsulamento o le impostazioni
DHCEP (per varie forme di banda larga). Se non si ¢ sicuri di cio che serve, consultare il
proprio ISP.

+ Rete wireless: E necessario disporre della chiave di accesso o della passphrase e del nome della rete.

» Password web: Le password di vari forum web, negozi online o altri siti sicuri sono
necessarie.

* Dettagli dell'account e-mail: Sono necessari il nome utente e la password, nonché gli
indirizzi o gli URL dei server di posta. Potrebbe essere necessario anche il tipo di
autenticazione. Queste informazioni dovrebbero essere recuperabili dalla finestra di
dialogo Impostazioni account del client di posta elettronica.



* Messaggistica istantanea: Il nome utente e la password dell'account di messaggistica
istantanea, l'elenco degli amici e le informazioni di connessione al server, se necessario.
* Altro: Se si dispone di una connessione VPN (ad esempio verso l'ufficio), di un
server proxy o di un altro servizio di rete configurato, assicurarsi di conoscere le
informazioni necessarie per riconfigurarlo in caso di necessita.



Preferiti del browser

I preferiti del browser web (segnalibri) sono spesso trascurati durante un backup e di solito non
sono memorizzati in un luogo ovvio. La maggior parte dei browser contiene un'utilita per
esportare 1 segnalibri in un file, che puo essere importato nel browser Web scelto in MX Linux.
Per indicazioni specifiche e aggiornate, consultare il gestore dei segnalibri del browser utilizzato.

Licenze software

Molti programmi proprietari per Windows non sono installabili senza una chiave di licenza o
una chiave CD. A meno che non vogliate abbandonare definitivamente Windows, assicuratevi di
avere una chiave di licenza per tutti i programmi che la richiedono. Se si decide di reinstallare
Windows (o se la configurazione del dual-boot va male), non sara possibile reinstallare questi
programmi senza la chiave.

Se non si riesce a trovare la licenza cartacea fornita con il prodotto, ¢ possibile individuarla nel
Registro di Windows o utilizzare un keyfinder come ProduKey. Se tutto il resto fallisce,

provare a contattare il produttore del computer per chiedere aiuto.

Esecuzione di programmi Windows

I programmi Windows non vengono eseguiti all'interno di un sistema operativo Linux, quindi
gli utenti di MX Linux sono incoraggiati a cercare gli equivalenti Linux (vedere la Sezione 4).
Le applicazioni critiche per 'utente possono essere eseguite sotto Wine (vedere Sezione 6.1),
anche se il successo varia.

2.3.2 Computer Apple Intel

L'installazione di MX Linux su computer Apple con chip Intel puo essere problematica; la
difficolta dipende dall'esatto hardware coinvolto. Agli utenti interessati a questa installazione si
consiglia di cercare e consultare il materiale Debian e 1 forum per gli sviluppi recenti. Un certo
numero di utenti Apple ha installato MX Linux con successo, quindi dovreste avere fortuna se
cercate o postate domande sul forum di MX Linux.

Collegamenti

Installazione di Debian su computer

Apple Forum Debian

2.3.3 Domande frequenti sul disco rigido

Dove devo installare MX Linux?

Prima di iniziare 1'installazione, € necessario decidere dove installare MX Linux.

* Intero disco rigido
* Partizione esistente su un disco rigido
* Nuova partizione su un disco rigido

E possibile selezionare semplicemente una delle prime due opzioni durante l'installazione; la
terza opzione richiede la creazione di una nuova partizione. E possibile farlo durante
l'installazione, ma si consiglia di farlo prima di avviare l'installazione. Su MX Linux, di solito
si utilizza GParted (Xfce) o Partition Manager (KDE) per creare e gestire graficamente le
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partizioni.



Una configurazione di installazione tradizionale per Linux prevede due partizioni, una per root e
una per home, come mostrato nella figura seguente. Si dovrebbe iniziare con questa
configurazione se si ¢ alle prime armi con Linux. Potrebbe essere necessaria anche una
partizione di sistema EFI (ESP) formattata in FAT-32 per le macchine con capacita UEFI. Sono

possibili altre disposizioni delle partizioni: alcuni utenti esperti combinano le partizioni root e
home con una partizione separata per i dati, ad esempio, e altri creano una partizione di swap

separata.
! fdevisda - GParted e =23
GParted Edit View Device Partition Help
/dev/sda (111.79 GIB
2 L] an79Ge) -
/devs/sdal /dev/sdaz
36.28 GiB 7148 GiB
Partition File Systermn Mount Point Label Size Used Unused Flags
fdevisdal - extd ! rootMx-16.1 36.28 GiB 11.15GiB 25.13 GiB boot
unallocated unallocated 748.69 MiB — —
fdev/sda2 M ext2 /home homeMX-16.1 71.48 GiB 35.31 GiB 36.17 GiB
/dev/sda3 |l exta [ | Swap [ 1.95GiB | 66.35 MiB | 1.89GiB |
unallocated unallocated 482 .46 MIB — —

0 operations pending
Figura 2-2: GParted mostra tre partizioni (sdal), (sda2) e swap (sda3). Le dimensioni delle

unita sono a discrezione dell'utente (vedere la Sezione 1.3 per i requisiti minimi).

ALTRO: Manuale GParted

] J Creare una nuova partizione con GParted
l ! Partire un sistema multi-boot

Come posso modificare le partizioni?

Uno strumento molto pratico, chiamato Disk Manager, fornisce una presentazione grafica di
tutte le partizioni della macchina (escluso lo swap) con una semplice interfaccia per montare,
smontare e modificare in modo rapido e semplice alcune proprieta delle partizioni del disco. Le
modifiche vengono scritte automaticamente e immediatamente in /etc/fstab e sono quindi
conservate per l'avvio successivo.

AIUTO: Gestione dischi

Cosa sono le altre partizioni della mia installazione di Windows?

I computer domestici recenti con Windows vengono venduti con una partizione di diagnostica e
una di ripristino, oltre a quella che contiene l'installazione del sistema operativo. Se in GParted
compaiono piu partizioni di cui non si era a conoscenza, probabilmente si tratta di quelle e vanno
lasciate stare.


https://en.wikipedia.org/wiki/EFI_system_partition
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Devo creare una partizione home separata?

Non ¢ necessario creare una partizione home separata, poiché il programma di installazione
creera una directory /home all'interno di / (root). Tuttavia, la presenza di una partizione separata
facilita gli aggiornamenti e protegge dai problemi causati dagli utenti che riempiono l'unita con
molte immagini, musica o video.

Quanto dovrebbe essere grande la / (radice)?

* (In Linux, la barra "/" indica la partizione principale). La dimensione di base installata
¢ di poco inferiore a 5 GB, quindi si consiglia un minimo di 6 GB per consentire le
funzioni di base.

* Questa dimensione minima non consente di installare molti programmi e puo causare
difficolta nell'esecuzione di aggiornamenti, nell'esecuzione di VirtualBox e cosi via. La
dimensione consigliata per un uso normale ¢ quindi di 20 GB.

* Se la partizione home (/home) si trova all'interno della directory root (/) e si
memorizzano molti file di grandi dimensioni, € necessario avere una partizione root piu
grande.

* Gli appassionati di giochi di grandi dimensioni (ad esempio, Wesnoth) devono tenere
presente che avranno bisogno di una partizione principale piu grande del solito per i
dati, le immagini e i file audio; un'alternativa ¢ quella di utilizzare un'unita dati

separata.

E necessario creare una partizione di swap?

Lo swap ¢ lo spazio su disco utilizzato per la memoria virtuale e puo essere un file o una
partizione. E simile al file "Page" che Windows utilizza per la memoria virtuale. Il programma di
installazione normalmente colloca un file di swap all'interno della partizione principale, ma puo
crearne uno separato (vedere Sezione 2.5.1). Se si intende ibernare (e non solo sospendere) il
sistema, ecco alcune raccomandazioni per la dimensione dello spazio di swap:
* SelaRAM ¢ inferiore a 1 GB, lo spazio di swap deve essere almeno pari alla quantita
di RAM e al massimo il doppio della RAM, a seconda della quantita di spazio

disponibile sul disco rigido del sistema.

* Per i sistemi con grandi quantita di RAM, lo spazio di swap dovrebbe essere almeno pari
alla dimensione della memoria.

* Tecnicamente un sistema Linux puo funzionare senza swap, anche se possono
verificarsi alcuni problemi di prestazioni anche su sistemi con grandi quantita di
RAM.

Cosa significano nomi come "sda"?

Prima di iniziare l'installazione, ¢ fondamentale capire come il sistema operativo Linux tratta i

dischi rigidi e le loro partizioni.

* Nomi delle unita. A differenza di Windows, che assegna una lettera a ogni partizione
del disco rigido, Linux assegna un nome di dispositivo breve a ogni disco rigido o altro
dispositivo di archiviazione del sistema. I nomi dei dispositivi iniziano con sd piu una
singola lettera (ad esempio, "sda", "sdb", ecc.) per le unita SATA e iniziano con
nvmeOn piu un singolo numero (ad esempio, "nvmeOn1", "nvmeOn2", ecc.) per le unita
NVMe. Esistono anche metodi piu avanzati per assegnare un nome alle unita, il piu


https://en.wikipedia.org/wiki/NVM_Express

comune dei quali ¢ 'UUID (Universally Unique IDentifier), utilizzato per assegnare un
nome permanente che non verra modificato dall'aggiunta o dalla rimozione di
apparecchiature.

Nomi delle partizioni. All'interno di ogni unita, ogni partizione viene indicata con un
numero aggiunto al nome del dispositivo. Pertanto, per SATA, sdal ¢ la prima

partizione del primo disco rigido.


https://en.wikipedia.org/wiki/Universally_unique_identifier

mentre sdb3 sarebbe la terza partizione della seconda unita. Per NVMe, nvmeOnlpl
sarebbe la prima partizione della prima unita disco, mentre nvmeOn2p3 sarebbe la terza
partizione della seconda unita.

» Partizioni estese. In origine i dischi rigidi dei PC potevano avere solo quattro partizioni
con il partizionamento MBR. Queste sono chiamate partizioni primarie in Linux e sono
numerate da 1 a 4. Utilizzando Gparted o l'equivalente, ¢ possibile aumentarne il
numero trasformando una delle partizioni primarie in una partizione estesa, quindi
dividendola in partizioni logiche (con un limite di 15) numerate da 5 in poi. Linux puo
essere installato in una partizione primaria o logica.

2.4 Prima occhiata

Accesso a Live Medium

Nel caso in cui si voglia uscire e rientrare, installare nuovi pacchetti e cosi via, ecco i
nomi utente e le password:

» Utente abituale
* nome: demo
* password: demo
* Superutente (Amministratore)

* nome: root

* password: root

2.4.1 Avviare il LiveMedium

CD/DVD dal vivo

E sufficiente inserire il CD/DVD nel vassoio e riavviare.

Chiavetta USB live

Potrebbe essere necessario eseguire alcune operazioni preliminari per far si che il computer si
avvii correttamente utilizzando la chiavetta USB.

* Per l'avvio con la chiavetta USB, molti computer dispongono di tasti specifici da
premere durante l'avvio per selezionare il dispositivo. I tasti tipici del menu del
dispositivo di avvio sono Esc, uno dei tasti funzione, Return o Shift. Osservare
attentamente la prima schermata visualizzata al riavvio per individuare il tasto corretto.

* In alternativa, potrebbe essere necessario accedere al firmware del PC (BIOS) per
modificare I'ordine dei dispositivi di avvio:

* Avviare il computer e premere il tasto richiesto all'inizio dell'avvio.



» Fare clic sulla scheda Avvio (o sulla freccia).

* Identificare ed evidenziare il dispositivo USB (di solito, I'unita disco USB),
quindi spostarlo in cima all'elenco (o inserire, se il sistema ¢ impostato per
questo). Salvare e uscire.

* Se non siete sicuri o non vi sentite a vostro agio nel modificare queste
impostazioni, chiedete assistenza nel Forum MX.

* Sui computer piu vecchi, privi di supporto USB nel BIOS, ¢ possibile utilizzare il

LiveCD di Plop Linux che carichera i driver USB e presentera un menu. Vedere il
sito web per i dettagli.

* Una volta che il sistema ¢ impostato per riconoscere la chiavetta USB durante il
processo di avvio, ¢ sufficiente collegarla e riavviare il computer.

UEFI

:]ﬂ Problemi di avvio UEFI e alcune impostazioni da controllare!

Se sulla macchina ¢ gia installato Windows 8 o successivo, ¢ necessario adottare misure speciali
per gestire la presenza di (U)EFI e Secure Boot. Gli utenti devono disattivare Secure e Fast Boot
entrando nel BIOS all'avvio della macchina. Purtroppo, 1'esatta procedura successiva varia a
seconda del produttore:

Nonostante le specifiche UEFI richiedano il pieno supporto delle tabelle di

partizione MBR, alcune implementazioni del firmware UEFI passano

immediatamente all'avvio CSM basato sul BIOS a seconda del tipo di tabella di

partizione del disco di avvio, impedendo di fatto l'avvio UEFI da partizioni EFI

System su dischi con partizione MBR. (Wikipedia, "Unified Extensible Firmware

Interface", recuperato il 10/12/19)
L'avvio e l'installazione UEFI sono supportati su macchine a 32 e 64 bit, nonché su macchine a
64 bit con UEFI a 32 bit. Si noti che le implementazioni UEFI a 32 bit possono ancora
presentare problemi. Per la risoluzione dei problemi, consultare il Wiki MX/antiX o chiedere

nel Forum MX.

Schermo nero

A volte puo capitare che all'avvio si veda una schermata nera vuota, con un cursore
lampeggiante nell'angolo. Questo rappresenta un fallimento nell'avvio di X, il sistema di finestre
utilizzato da Linux, ed ¢ spesso dovuto a problemi con il driver grafico utilizzato. Soluzione:
riavviare e selezionare le opzioni di avvio Safe Video o Failsafe nel menu; i dettagli su questi
codici di avvio sono disponibili nel Wiki. Vedere la sezione 3.3.2.


https://forum.mxlinux.org/
http://www.plop.at/
https://www.youtube.com/watch?v=cLFUZ6LtqiE
https://en.wikipedia.org/wiki/Unified_Extensible_Firmware_Interface
https://mxlinux.org/wiki/system/uefi
https://forum.mxlinux.org/
https://mxlinux.org/wiki/system/boot-parameters

2.4.2 Schermo di apertura standard

Virtual Box Video
check md5

Boot from Hard Disk
Memory Test

Switch to Grub Bootloader

Boot Options quiet splasht nosplash

Press Fl For Help

F1 Help F2 Language F3 Timezone F4 Options F5 Persist F6 Failsafe F7 Console
Englist S) auto none off default default

Figura 2-3: schermata di avvio LiveMedium (lo sfondo varia) dell'immagine ISO x64.

All'avvio di LiveMedium viene presentata una schermata simile a quella mostrata nella figura

precedente; la schermata di un sistema installato € molto diversa. Nel menu principale possono
comparire anche voci personalizzate.

Voci del menu principale

Tabella 1: Voci di menu in Live boot

Ingresso Commento
MX-XX.XX Questa voce ¢ selezionata per impostazione predefinita ed ¢ il
(<DATA DI modo standard con cui la maggior parte degli utenti avvia il
RILASCIO>) sistema live. E sufficiente premere Return per avviare il sistema.
Avvio da disco rigido Avvia tutto cio che ¢ attualmente installato sul disco rigido del
sistema.

Test di memoria Esegue un test per verificare la RAM. Se il test viene superato, ¢
possibile che vi sia ancora un problema hardware o anche un
problema di RAM; se il test fallisce, c'¢ qualcosa che non va

nella RAM.

Nella riga inferiore, lo schermo visualizza una serie di voci verticali, sotto le quali si trova una
riga di opzioni orizzontali; per i dettagli, premere F1 quando si é su questa schermata.

Opzioni

* F2 Lingua. Impostare la lingua per il bootloader e il sistema MX. Questa viene
trasferita automaticamente sul disco rigido al momento dell'installazione.

F3 Fuso orario. Impostare il fuso orario del sistema. Questo verra trasferito
automaticamente sul disco rigido al momento dell'installazione.

F4 Opzioni. Opzioni per il controllo e 1'avvio del sistema live. La maggior parte di
queste opzioni non viene trasferita sul disco rigido al momento dell'installazione.



* F5 Persisti. Opzioni per mantenere le modifiche alla LiveUSB quando la macchina si spegne.

* F6 Opzioni video sicure/failsafe. Opzioni per le macchine che non si avviano su X per impostazione
predefinita.

* F7 Console. Impostare la risoluzione delle console virtuali. Puo entrare in conflitto con
l'impostazione della modalita Kernel. Puo essere utile se si sta avviando l'installazione
da riga di comando o se si sta cercando di eseguire il debug del processo di avvio
iniziale. Questa opzione verra trasferita al momento dell'installazione.

ALTRO: Processo di avvio di Linux, Wiki MX/antiX

2.4.3 Schermata di apertura UEFI

Welcome to MX-23 alpha2 (Libretto}!

MX-23 alpha2 x64 (April 7, 2023}
Check integrity of the live media
»=>> Advanced Options <<<
Memory Test (64-bit UEFI}

Boot Rescue Menus

to edit, #*ESCy to go back.

#ENTER« to select/deselect.

The highlighted entry will start in 45 seconds

Figura 2-4: Schermata di avvio LiveMedium di x64 (da MX-21 in poi) quando viene rilevato UEFI.

Se l'utente utilizza un computer impostato per 1'avvio UEFI (vedere MX/antiX Wiki), apparira
invece la schermata di apertura dell'avvio live UEFI con scelte diverse.

* I'menu vengono utilizzati per impostare le opzioni di avvio al posto dei menu dei tasti funzione.
» L'opzione superiore avvia il sistema operativo con tutte le opzioni selezionate attivate.
* Le opzioni avanzate impostano elementi come la persistenza e altre voci presenti nei
menu della funzione di avvio legacy.
* Lingua - Tastiera - Fuso orario imposta queste opzioni.


http://en.wikipedia.org/wiki/Linux_startup_process
https://mxlinux.org/wiki/system/boot-parameters
https://www.mxlinux.org/wiki/system/uefi

Welcome to MX-21 (Wildflower}! Welcome to MX-21 (Wildflower}!

===> Language - Keyhoard - Timezone ===» Advanced Options <===

Language (lang=en_US} Pelslslenceoplion:—

Keyboard {kbd=us} Boot options:

Timezone (tz=America/New_York} Failsafe options:
Reset Console options:
«<=== Back to main menu Disable GRUB theme
Save options:
Power Off / Reboot

<=== Back to main menu

Use the 1 and | keys to highlight an entry. Hit sENTER« to select/deselect. Use the 1 and | keys to highlight an entry. Hit yENTER« to select/deselect.

Press ‘e’ to edit the selected entry, press *ESCx to go back. Press e’ o edit the selected entry, press »ESCk to go back.

Figura 2-5: Esempi di schermate per LiveMedium (a sinistra) e per le opzioni installate.

Se si desidera che le opzioni di avvio siano permanenti, assicurarsi di selezionare un'opzione di salvataggio.

2.4.4 Schermata di accesso

[Mon 10 Feb 2020 04:26:38 PM EST

12:43 PM

Monday, July 27, 2020

Figura 2-6: A sinistra: esempio di schermata di login Xfce, con il pulsante di sessione in alto
al centro. A destra: Schermata di accesso di KDE/Plasma.

A meno che non si sia selezionato Autologin, il processo di avvio dell'installazione termina con
la schermata di login; in una sessione live viene mostrata solo I'immagine di sfondo, ma se si
effettua il logout dal desktop si vedra la schermata completa. (Su schermi piccoli, I'immagine
puo apparire ingrandita; questa ¢ una proprieta del display manager utilizzato da MX Linux.

Xfce: si possono vedere tre piccole icone all'estremita destra della barra superiore; da destra a sinistra:

* [l pulsante di accensione sul bordo contiene le opzioni di sospensione, riavvio e spegnimento.



* Il pulsante della lingua consente all'utente di selezionare la tastiera appropriata per
la schermata di accesso.
» Il pulsante degli ausili visivi risponde alle esigenze speciali di alcuni utenti.

Al centro si trova il pulsante della sessione che consente di scegliere il desktop manager da
utilizzare: Xsession predefinito, Xfce Session e altri eventualmente installati (Sezione 6.3).
Fluxbox non ¢ piu incluso di default, ma puo essere installato con MX Package Installer.

Se si desidera evitare di dover effettuare il login a ogni avvio (sconsigliato in caso di problemi
di sicurezza), € possibile passare a "autologin" nella scheda "opzioni" di MX User Manager.

Le versioni MX KDE/Plasma vengono fornite con una schermata di accesso diversa,

contenente un selezionatore di sessioni, una tastiera su schermo e funzioni di
accensione/spegnimento/riavvio.

2.4.5 Diversi desktop

MX-Xfce

MX Linux &

Figura 2-7: Esempio di desktop Xfce predefinito.

MX-KDE

MX Linux X

X 8 54~ 5:04PM =

Figura 2-8: Esempio di desktop predefinito di KDE/Plasma.



I1 desktop ¢ creato e gestito da Xfce o KDE/Plasma; l'aspetto e la disposizione di ciascuno di
essi sono stati pesantemente modificati per MX Linux. Si notino le due caratteristiche
dominanti del primo sguardo: il pannello e la schermata di benvenuto.

Pannello

11 desktop predefinito di MX Linux presenta un singolo pannello verticale sullo schermo.
L'orientamento del pannello puo essere facilmente modificato in MX Tools > MX Tweak. Le
caratteristiche comuni del pannello sono:

» Pulsante di accensione, apre una finestra di dialogo per il log out, il riavvio, lo spegnimento e la
sospensione (Xfce)

* Orologio in formato LCD - clic per un calendario (xfce)
» Taskswitcher/Pulsanti finestra: area in cui vengono mostrate le applicazioni aperte.
* Browser Firefox
* Gestore di file (Thunar)
* Area di notifica

* Aggiornare il manager

* Gestione degli appunti

* Responsabile di rete

* Gestore del volume

* Manager di potenza

* Espulsore USB

* Pager: visualizza gli spazi di lavoro disponibili (per impostazione predefinita 2, fare clic con il pulsante
destro del mouse per modificarli).

* Menu delle applicazioni ("Whisker" su Xfce)
* Altre applicazioni possono inserire icone nel pannello o nell'area di notifica quando sono in esecuzione.

Per modificare le proprieta del pannello, vedere la sezione 3.8.

Schermata di benvenuto

MXx Welcome i MX Welcome

& o

MX-23 "Libretto" MX-23 "Libretto"
‘ Welcome | About Welcome | About
MX VERSION MX-23 DESKTOP 64 Desktop
K Install MX Linux
DEBIAN VERSIOMN: 12.0 SUPPORTED UNTIL: June 2028
FAQ E Forums The name “MX Linux” is covered by Linux Foundation Sublicense No. 20140605-0483. We
= develop software that is covered by a free license that can be examined in the Wiki list. We also

include software developed by others that is under a free license.
Videos

Users Manual -
| Terms of Use
W wiki n eeniribie SHORT SYSTEM REPORT:

CPU: triple core AMD Ryzen 5 2400G with Radeon Vega Graphics (-MCP-) speed: 3593 MHz
Tools ﬁ Popular Apps Kernel: 6.1.0-7-amd6é4 x86_64 Up: Sm Mem: 880.9/3911.3 MiB (22.5%) Storage: 0/8 GiB Procs:

176
- Tweak (Panel, etc...)

Client: Unknown Client: mx-welcome inxi: 3.3.25
User demo, password: demo. Superuser root, password: root. User demo, password: demeo. Superuser root, password: root.

| L] About...| % Close ] ‘ © About...

| Quick-System-Info Full Report



http://docs.xfce.org/xfce/getting-started
http://gottcode.org/xfce4-whiskermenu-plugin

Figura 2-9: Schermate di benvenuto e Informazioni su MX linux (installato).

Quando l'utente si avvia per la prima volta, al centro dello schermo appare una schermata di
benvenuto con due schede: "Welcome" offre un orientamento rapido e link di aiuto (Figura 2-
7), mentre "About" visualizza una serie di informazioni sul sistema operativo, sul sistema in
esecuzione, ecc. Quando si esegue una sessione live, le password per gli utenti demo e root
vengono visualizzate in basso. Una volta chiuso, in esecuzione o installato, ¢ possibile
visualizzarlo nuovamente utilizzando il menu o gli Strumenti MX.

E molto importante che i nuovi utenti esaminino attentamente i pulsanti, in quanto cio
risparmiera molta confusione e fatica nell'uso futuro di MX Linux. Se il tempo a disposizione €
limitato, si consiglia di scorrere il documento FAQ collegato al Desktop, in cui vengono fornite
le risposte alle domande piu comuni.

Suggerimenti e trucchi

Settings al
Customize your deskiop
Personal
- About Me H=W Appearance . Desktop = File Manager ] Keyboard Layouts
E MX System Sounds WX Tools MX Tweak J Notifications panel
Preferred == Window Manager .
* applications Wl Window Manager — Workspaces XFCE4 Screensaver
Hardware
Advanced
M ieowork Alsamixer ARandR e e
Adapters Manager
Configuration system Settings
Mouse and
[ B BB ceypoara @ wixTime seaings () Power manager e
P prin serings PULTN kY Remevable Drives BB system keyboard B sscem cocaes
= &= Volume Control and Media = 2 = o
System
Aaccessibility (s Disk Manager icwall iDeviceMounter nd Feel Deskiop Theme
configuration W/ Configuration
= LightDM GTK+ #9 Session and L) windows Wireless Personalization
] recter setings Minte Type editor (g samba | - 38 Sriers
. nt De
Other
= Adblock adgone pasn piayer [EER onboard settings :l: settings Editor
"
Hrelp € Al settings || x close

Figura 2-10: Impostazioni é il punto di riferimento per apportare modifiche. L: Xfce, R:

KDE; i contenuti variano.

Alcune cose utili da sapere all'inizio:

* Se si verificano problemi con 'audio, la rete e cosi via, vedere Configurazione (Sezione 3).
* Regolare il volume generale del suono scorrendo con il cursore sull'icona
dell'altoparlante o facendo clic con il pulsante destro del mouse sull'icona
dell'altoparlante > Apri Mixer.
* Per impostare il sistema sul proprio layout di tastiera, fare clic su Menu
Applicazioni > Impostazioni > Tastiera, scheda Layout e selezionare il modello
dal menu a discesa. E anche possibile aggiungere tastiere di altre lingue.
* Regolare le preferenze per il mouse o il touchpad facendo clic su Menu applicazioni



> Impostazioni > Mouse e touchpad.



Il cestino puo essere facilmente gestito nel file manager, dove si trova la sua icona nel
riquadro di sinistra. Fare clic con il tasto destro del mouse per svuotarlo. Puo anche
essere aggiunto al Desktop o al pannello. E importante sapere che I'uso dell'eliminazione,
sia evidenziando e premendo il pulsante di eliminazione che tramite una voce del menu
contestuale, rimuove I'elemento per sempre e non sara piu possibile recuperarlo.

* Per mantenere il sistema aggiornato, verificare che l'indicatore (riquadro
delineato) degli aggiornamenti disponibili su MX Updater diventi verde. Per i
dettagli, vedere la sezione 3.2.

* Comode combinazioni di tasti (gestite in Tutte le impostazioni > Tastiera > Scorciatoie applicazione).

Tabella 2: Combinazioni di tasti utili

Tastiera Azione
F4 Fa scendere un terminale dall'alto dello schermo
Chiave di (alias tasto Super o Logo) Visualizza il menu Applicazione
Windows
Ctrl-Alt-Esc Cambia il cursore in una x bianca per uccidere qualsiasi programma.
Ctrl-Alt-Bksp Chiude la sessione (senza salvarla!) e riporta alla schermata di accesso.
Ctrl-Alt-Canc Blocca il desktop su Xfce; logout su KDE/Plasma

Ctrl-Alt-F1 Esce dalla sessione X per tornare alla riga di comando; usare Ctrl-Alt-F7 per
tornare indietro.

Alt-F1 Apre il manuale d'uso di MX Linux (solo Xfce, menu su KDE/Plasma).
Alt-F2 Viene visualizzata una finestra di dialogo per l'esecuzione di un'applicazione.
Alt-F3 Apre il Finder delle applicazioni, che consente anche di modificare le voci di
menu (solo Xfce).
Alt-F4 Chiude un'applicazione in primo piano; sul desktop, fa apparire la finestra di
dialogo di uscita.
PrtScr Apre l'utilita screenshot per 'acquisizione dello schermo
Applicazioni

Le applicazioni possono essere avviate in vari modi.

o tuaztest

Run Program...
Enter a command you want to launch

Geany
A fast and lightweight IDE using GTK+

MX Tools

Configuration tools for MX Linux

MX Package Installer
“simple Package Installer

Conky Manager

cn Conky Theme Manager

. Appearance
%= customize the look of your desktop

) Jd
Cross-platform screenshot tool that provi...

MX Tweak
== Assorted useful tweaks
Panel Restart

g PulscAudio Volume Control
Adjust the volume level

Figura 2-11: SINISTRA: menu di Xfce Whisker (il contenuto varia). A destra: menu di KDE/Plasma.

* Fare clic sull'icona del menu Applicazione, nell'angolo in basso a sinistra.
» Siapre la categoria Preferiti e si puo passare il mouse su altre categorie sul lato
destro per vedere i contenuti nel riquadro sinistro.



 In alto si trova una potente casella di ricerca incrementale: basta digitare alcune
lettere per trovare qualsiasi applicazione senza doverne conoscere la categoria.
* Fare clic con il tasto destro del mouse sul desktop > Applicazioni.



* Se si conosce il nome dell'applicazione, ¢ possibile utilizzare Application Finder, avviato
facilmente in due modi.
* Fare clic con il tasto destro del mouse sul desktop > Esegui comando ...
* Alt-F2
* Alt-F3 (Xfce) porta a una versione avanzata che consente di controllare i
comandi, le posizioni ecc.

* Sul desktop di KDE/Plasma, basta iniziare a digitare
» Utilizzare una sequenza di tasti definita dall'utente per aprire un'applicazione preferita.

» Xfce- Fare clic su Menu applicazioni > Impostazioni, quindi Tastiera, scheda
Collegamenti applicazioni.

« KDE/Plasma - Scorciatoie globali nel menu

o Application Finder R B [ A
E | gparted-pkexec 4|
% Close % Launch

Figura 2-12: Application Finder che identifica l'applicazione.

Altro

Informazioni sul sistema
* Fare clic su Menu applicazioni > Informazioni rapide sul sistema per inserire 1 risultati del comando
inxi -Fxrz negli appunti, pronto per essere incollato nei messaggi del forum, nei file di testo, ecc.
* KDE/Plasma - Fare clic su Menu applicazioni > Sistema > Infocenter per
ottenere una bella visualizzazione grafica.

Video e audio
* Per le impostazioni di base del monitor, fare clic su Menu applicazioni> Impostazioni > Display
* Laregolazione dell'audio si effettua tramite il menu Applicazioni > Multimedia >
Controllo volume PulseAudio (o facendo clic con il pulsante destro del mouse
sull'icona del gestore del volume).

NOTA: per la risoluzione di problemi quali il display, I'audio o Internet, consultare la Sezione
3: Configurazione.
Collegamenti

¢ Documentazione di Xfce

¢ Domande frequenti su Xfce
 KDE



http://www.xfce.org/about
https://wiki.xfce.org/faq
https://userbase.kde.org/Welcome_to_KDE_UserBase

2.4.7 Uscita

Quando si apre il menu dell'applicazione, nell'angolo in alto a destra compaiono per
impostazione predefinita quattro pulsanti di comando (€ possibile modificare la visualizzazione
facendo clic con il pulsante destro del mouse sull'icona del menu > Proprieta, scheda Comandi).
Da sinistra a destra:

* Tutte le impostazioni (Tutte le impostazioni)

¢ Schermata di blocco
e Utenti dello switch
* Disconnettersi

Recently Save

Recent Applications Today

Recent Documents Yesterday

Search For
Development 5
= Documeni

Figura 2-13: pulsanti di comando. In al bdlicanar EJ Images
Xfce; destra: KDE/Plasma i | e

: B Vvideos
Graphics

Devices
B, 14.6 GiB K
B3 mxsystem
B} 14.6 GiB E

Internet

Multimedia

E importante uscire correttamente da
MX Linux al termine della sessione, in
modo che il sistema possa essere chiuso ,
in modo sicuro. Tutti i programmi in Syste £ Switch User
esecuzione vengono avvisati della Utilities € suspend

Help % Hibernate

chiusura del sistema, in modo da avere

|Power / Session | 2} Reboot

il tempo di salvare i file modificati, .
uscire dai programmi di posta e di
news, ecc.

Se si spegne semplicemente 1'alimentazione, si rischia di

le possibilita di danneggiare il sistema operativo.

Opzioni simili ai pulsanti di comando sono disponibili nel menu LASCIA di KDE/Plasma.

Permanente

Per abbandonare definitivamente una sessione, selezionare una delle seguenti opzioni nella finestra di dialogo
Esci:

* Esci. Questa opzione interrompe tutte le operazioni in corso, chiede di salvare i file
aperti se non sono stati chiusi da soli e riporta alla schermata di accesso con il sistema
ancora in funzione.

* Il comando in fondo alla schermata, "Salva sessione per gli accessi futuri", ¢
selezionato per impostazione predefinita. Il suo compito ¢ quello di salvare lo
stato del desktop (applicazioni aperte e loro posizione) e di ripristinarlo all'avvio
successivo. Se si sono verificati problemi con il funzionamento del desktop, ¢
possibile deselezionarlo per ricominciare da capo; se cio non risolve il problema,
fare clic su Tutte le impostazioni > Sessione e avvio, scheda Sessione, e premere



il pulsante Cancella sessioni salvate.
* Riavvia o Spegni. Opzioni autoesplicative che modificano lo stato del sistema stesso.
E disponibile anche utilizzando l'icona nell'angolo superiore destro della barra di
accesso.



SUGGERIMENTO: in caso di problemi, Ctrl-Alt-Bksp interrompe la sessione e riporta alla
schermata di accesso, ma i programmi e i processi aperti non vengono salvati.

Temporaneo

E possibile abbandonare temporaneamente la sessione in uno dei seguenti modi:

2.5
2.51

Schermata di blocco. Questa opzione ¢ facilmente accessibile da un'icona nell'angolo in
alto a destra del menu delle applicazioni. Protegge il desktop da accessi non autorizzati
mentre si € lontani, richiedendo la password utente per tornare alla sessione.

Avviare una sessione parallela come utente diverso. E possibile farlo dal pulsante di
comando Cambia utente nell'angolo in alto a destra del menu dell'applicazione. In questo
modo si lascia la sessione corrente al suo posto e si pud avviare una sessione per un altro
utente.

Sospensione tramite pulsante di alimentazione. Questa opzione ¢ disponibile dalla
finestra di dialogo Log Out e pone il sistema in uno stato di basso consumo. Le
informazioni sulla configurazione del sistema, sulle applicazioni aperte e sui file attivi
vengono memorizzate nella memoria principale (RAM), mentre la maggior parte degli
altri componenti del sistema viene spenta. E molto utile e generalmente funziona molto
bene in MX Linux. Invocata dal pulsante di accensione, la sospensione funziona bene
per molti utenti, anche se il suo successo varia a seconda della complessa interazione tra
1 componenti del sistema: kernel, display manager, chip video, ecc. In caso di problemi,
si consiglia di provare le seguenti modifiche:

* Cambiare driver grafico, ad esempio da radeon ad AMDGPU (per le GPU
piu recenti) o da nouveau al driver proprietario Nvidia.

» Regolare le impostazioni in Menu Applicazioni > Impostazioni > Power
Manager. Ad esempio: nella scheda Sistema, provare a deselezionare "Blocca
schermo quando il sistema va in sospensione".

» Fare clic su Menu Applicazioni > Impostazioni > Salvaschermo e regolare 1
valori di Gestione risparmio energetico dello schermo nella scheda Avanzate.

* Schede AGP: aggiungere l'opzione ""NvAgp'" "1" alla sezione Device di xorg.conf.
Sospendere utilizzando la chiusura del coperchio del portatile. Alcune configurazioni
hardware potrebbero avere problemi in questo senso. L'azione di chiusura del
coperchio puo essere regolata nella scheda Generale di Power Manager, dove "Spegni
display" si ¢ dimostrato affidabile nell'esperienza degli utenti MX.

Ibernazione. L'opzione di ibernazione ¢ stata rimossa dalla casella di logout nelle
versioni precedenti di MX Linux perché gli utenti hanno riscontrato diversi problemi.
Puo essere attivata in MX Tweak, scheda Altro. Consultare anche il Wiki MX/antiX.

Processo di installazione

Passi di installazione dettagliati

:]ﬂ Installazione di base di MX Linux (con



https://mxlinux.org/wiki/system/hibernate
https://youtu.be/jSYycsZPm_Q

partizionamento) ﬂ Installazione criptata di MX Linux

(con partizionamento)



https://youtu.be/jSYycsZPm_Q
https://youtu.be/tQjftZsoySg
https://youtu.be/tQjftZsoySg

Impostazione della cartella Home

Per iniziare, avviare il LiveMedium, quindi fare clic sull'icona del programma di installazione
nell'angolo in alto a sinistra. Se 1'icona non ¢ presente, fare clic su F4 e immettere: minstall-
pkexec (password di root su LiveMedium: root).

Help | Live Log Terms of Use

General Instructions MX Linux is an independent Linux distribution based on Debian
BEFORE PROCEEDING, Stable.

CLOSE ALL OTHER

APPLICATIONS.

MX Linux uses some companents from MEPIS Linux which are
released under an Apache free license. Some MEPIS components have

On each page, please read
been modified for MX Linux.

the instructions, make your
selections, and then click on
Next when you are ready to Enjoy using MX Linux
proceed. You will be
prompted for confirmation
before any destructive
actions are performed.

Limitations
Remember, this software is
provided AS-IS with no

warranty what-so-ever. It is Keyboard settings

solely your responsibility to

backup your data before [ [k

proceeding. Layout: us
Variant:

Change Keyboard Settings

| e

Figura 2-14: Schermata iniziale dell'Installatore.

Commenti

* Il lato destro della schermata del programma di installazione presenta le scelte dell'utente
man mano che l'installazione procede; il lato sinistro fornisce chiarimenti sul contenuto
del lato destro.

* Impostazioni tastiera consente di cambiare la tastiera per il processo di installazione.

Help | Live Log . select type of installation

Installation Options i O Regular install using the entire disk
If you are running Mac OS
or Windows OS (from Vista

onwards), you may have Use disk:

to use that system's =
e
partitions and boot 256 GB

manager before installing. Root

Using the root-home 100% . _ B
space slider

The drive can be divided L] encrypt

into separate system Encryption password: @

(root) and user data

(home) partitions using Confirm password: |
the slider.

i [ Enat t
The raot partition will LI Enable hibernation support

contain the operating
system and applications. ® customize the disk layout
The home partition will
contain the data of all
users, such as their
settings, files, documents,
pictures, music, videos,

e ‘ x Clnse| ‘ « Back |

e o e

Figura 2-15: Tipo di installazione (Personalizza selezionato).


https://www.youtube.com/watch?v=twDhZFBMgJ0

Commenti per Installazione regolare

» Utilizzare il disco. Se non si ¢ sicuri di quale sia la partizione desiderata, utilizzare 1
nomi visualizzati in GParted. Il disco selezionato verra esaminato sommariamente da
SMART per verificarne 1'affidabilita. Se vengono rilevati problemi, viene visualizzata
una schermata di avviso. Si dovra decidere se accettare il rischio e continuare, se
selezionare un altro disco o se terminare I'installazione. Per ulteriori informazioni, fare
clic su Menu applicazioni > Sistema > GSmartControl ¢ "Esegui test" sull'unita.

& Smartmon tool output:

196 Reallocated_Event_Count 1

The disk with the partition you selected for installation passes the
S.M.A.R.T. monitor test (smartctl)

but the tests indicate it will have a higher than average failure rate
in the upcoming year.

If unsure, please exit the Installer and run GSmartControl for more
information.

Do you want to continue?

Figura 2-16: Avviso SMART di rischio di guasto

* Installazione regolare utilizzando I'intero disco. Selezionare questa opzione se si
intende utilizzare l'intero disco rigido per MX Linux. Il disco verra ripartizionato e
tutti 1 dati esistenti andranno persi.
» Per impostazione predefinita, vengono create una partizione root e una partizione
swap. Se si sceglie di utilizzare la crittografia, viene creata anche una partizione
/boot.
* Se si desidera avere una partizione home separata, si puo usare il cursore per
dividere lo spazio disponibile tra partizione root e home.
* Un messaggio a comparsa chiedera di confermare 1'utilizzo dell'intero disco.

* Personalizza il layout del disco: Se sul disco vengono rilevate partizioni esistenti,
questa opzione sara quella predefinita. Sara possibile utilizzare la schermata di
selezione delle partizioni per utilizzare le partizioni esistenti.

Help | Live Log Choose partitions

Choose Partitions Device size Use For Label encype | Format  Check O <

The partition list allows

Visda 256.2 GB MBR
you to choose what
partitions are used for this sdal* 149.6 GB 7| rootmx23 ext4
installation. sda2 8.0 GB | swapmx swap
Beiice SThis i= the blodk sda3 i198.5 GB ¥|homemx ext4
device name that is, or will sdc 0 bytes

be, assigned to the
created partition.

Size - The size of the
partition. This can only be
changed on a new layout.

Use For - To use this

partition in an installation,

you must select

something here.

- Format - Format without

mounting. Encryption options
- BIOS-GRUB - BIOS Boot
GPT partition for GRUB.
- EFI - EFI System Partition. Confirm pass
- boot - Boot manager (/

boot).

- root - System root (/). | * Close | | € Back |

()

Encryption pa

.................

Figura 2-17: Selezione della partizione.


https://en.wikipedia.org/wiki/S.M.A.R.T

Help  Live Log

Choose partitions
Choose Partitions

The partition list allows you
to choose what partitions
are used for this installation. st stem ESP v Preserviv nu

Device size Label UseFor emm Format M, &f

Device - This is the block
device name that is, or will
be, assigned to the created

partition. Standard install

Encrypted system

Size - The size of the sdas 14.6GB = g %)

partition. This can only be

changed on a new layout. sda6 154.2 GB tapart . ~
Label - The label that is sda7 15.4GB wsystemd - X C
assigned to the partition -
once it has been formatted -_—
Use For - To use this partition
in an installation, you must
select something here.
- Format - Format without
mounting.
- EFI - EFI System Partition. rm pa ord
- boot - Boot manager (/ =
boot).
- root - System root (/).
- swap - Swap space.
X Close € Back 2 Next

- home - User data (/home).
T arditian ta tha ahaue wns

Figura 2-18: Fate clic con il tasto destro del mouse su un disco per visualizzare le opzioni del modello.

Commenti

* Scegliere Partizioni. Specificare le partizioni root e swap che si desidera utilizzare.
Usare la colonna USE FOR per scegliere I'uso che si vuole fare di una partizione. Se
¢ stata creata una partizione separata per la directory home, specificarla qui, altrimenti
lasciare /home impostata su root.

* Molti utenti preferiscono collocare la propria home directory in una partizione
diversa da quella di / (root), in modo che qualsiasi problema o sostituzione
totale della partizione di installazione lasci inalterate tutte le impostazioni e 1
file individuali dell'utente.

* A meno che non si utilizzi I'encrpytion o non si sappia cosa si sta facendo,
lasciare I'avvio impostato su root.

* In questa schermata ¢ disponibile una semplice gestione delle partizioni. Fare
clic con il tasto destro del mouse su un disco per visualizzare i modelli di
partizione. I modelli sono adatti solo per le modifiche all'intero disco, quindi se
si desidera ridimensionare o mettere a punto in altro modo il layout delle
partizioni, ¢ necessario utilizzare un gestore di partizioni esterno (ad esempio,
GParted) disponibile facendo clic sul pulsante Partition Manager in basso a
destra del selezionatore di partizioni.

* Preferenze.

» Selezionare Conserva dati in /home se si sta eseguendo un aggiornamento e i dati
sono gia presenti in una partizione o cartella esistente. Questa opzione non ¢
generalmente consigliata a causa del rischio che le vecchie configurazioni non
corrispondano alla nuova installazione, ma puo essere utile in situazioni
specifiche, ad esempio per riparare un'installazione.

» Selezionare Verifica blocchi danneggiati se si desidera eseguire una scansione
dei difetti fisici del disco rigido durante la formattazione. Questa opzione ¢
consigliata agli utenti con unita piu vecchie.

* E possibile modificare l'etichetta della partizione in cui si desidera installare (ad



esempio, in "Installazione di prova MX- 23") nella colonna Etichetta.
Infine, ¢ possibile selezionare il tipo di file system che si desidera utilizzare
sul disco rigido. In MX Linux si consiglia il tipo predefinito ext4, se non si ha

una scelta particolare.



» E possibile perfezionare le impostazioni del cifrario con il pulsante "Impostazioni
di crittografia avanzate" o mantenere le impostazioni predefinite.

Help Live Log

Installation in progress
Select Boot Method

MX Linux uses the GRUB .
bootloader to boot MX Linux and
MS-Windows.

7% - Pretending to install MX Linux

Select Boot Method

By default GRUB2 s Installed i the Install GRUB for Linux and Windows
Master Boot Record (MBR) or ESP
{EFI System Partition for 64-bit UEFI
boot systems) of your boot drive
and replaces the boot loader you
were using before. This is normal.

Location to install on: MBR PBR © EsP

Partition to use: @ sda1 (100.0 MB vfat - EFI System)

If you choose to install GRUB2 to
Partition Boot Record (PBR) instead,
then GRUB2 will be installed at the
beginning of the specified partition.
This option is for experts only.

If you uncheck the Install GRUB

box, GRUB will not be installed at

this time. This option is for experts k
only.

$¢ Close

5 Next

Abort

Figura 2-19: 1l programma di installazione chiede il metodo di avvio.

Commenti

* Mentre il sistema operativo linux principale viene copiato sul disco rigido, ¢ possibile

fare clic sul pulsante "Avanti" per inserire alcune informazioni di configurazione
aggiuntive. La Figura 2-19 mostra le opzioni di installazione del bootloader GRUB.

La maggior parte degli utenti medi accettera le impostazioni predefinite, che
installeranno il bootloader all'inizio del disco. Questa ¢ la posizione abituale e non causa

Gli utenti UEFI devono scegliere la partizione ESP che desiderano utilizzare.

Quando si fa clic su Avanti, un messaggio a comparsa controllera che si accetti la
posizione del bootloader GRUB. L'installazione di GRUB puo richiedere alcuni minuti

°
alcun danno.
L]
L'impostazione predefinita ¢ la prima trovata.
L]
in alcune situazioni.
°

Si noti che la partizione mostrata (sda) ¢ solo un esempio; la scelta della
partizione potrebbe essere diversa.

Help Live Log

Computer Identity
Tt computer name is a common
unique name which will identify

Installation in progress

94% - Paused for required operator input

Abort

your computer if it is on a network.
The computer domain is unlikely to
be used unless your ISP or local
network requires it.

The computer and demain names
can contain only alphanumeric
characters, dots, hyphens. They
cannot contain blank spaces, start
or end with hyphens

The SaMBa Server needs to be
activated if you want to use it to
share some of your directories or
printer with a local computer that is
running MS-Windows or Mac OSX.

Computer Network Names
Computer name: mx
Computer domain: example.dom
SaMBa Server for MS Networking

Workgroup: Workgroup

¥ Close  Back

5~ Next

Figura 2-20: Impostazione dei nomi della rete di computer.



Commenti

* Molti utenti scelgono un nome unico per il proprio computer: laptopl, MyBox,
StudyDesktop, UTRA, ecc. Si puo anche lasciare il nome predefinito.

* Se non si dispone di una rete di computer, ¢ sufficiente fare clic su Avanti.

* Se non si intende ospitare cartelle di rete condivise sul proprio PC, ¢ possibile
disabilitare Samba. Questo non influira sulla capacita del PC di accedere alle
condivisioni ospitate altrove sulla rete.

Help Live Log

Localization Defaults
set the default locale. This will
apply unless they are overridden

Installation in progress
94% - Paused for required operator input

Localization Defaults

Abort

later by the user.

Locale: United States - American English id

Configure Chack

If you have an Apple or a pure
Unix computer, by default the
system clock is set to Greenwich
Meridian Time (GMT) or
Coordinated Universal Time
(UTC). To change this, check the
"System clock uses local time"
box.

Configure Clock

Timezone: America v New York bd

System clock uses local time

Format: 13:57 @ 1:57PM
Service Settings (advanced)
The system boots with the
timezone preset to GMT/UTC. To
change the timezone, after you
reboot into the new installation,
right click on the clock in the
Panel and select Properties.

View

Service Settings

Most users should not change
the defaults. Users with low-
resource computers sometimes
want to disable unneeded

services in order to keep the RAM
1kana ac lnu a€ nnccibla Maba

% Close < Back o Next

Figura 2-21: Impostazioni di Locale, Fuso orario e Servizio.

Commenti

* Le impostazioni predefinite saranno di solito corrette, a patto che si sia fatto attenzione
a inserire eventuali eccezioni nella schermata di avvio di LiveMedium.
* Le impostazioni possono essere modificate nuovamente una volta avviato Xfce.

Help Live Log

Installation in progress
94% - Paused for required operator input

Common Services to Enable
Select any of these common

Abort

""""""" *hat you might need with .
X im configuration and the Common Services to Enable
— fill be started senvice Description
:ally when you start MX o Adimif
[ anacron Runs commands periodically
cron Time-based job scheduler
B sudo Execute a command as another user
- Hardware
cpufrequtils  CPU frequency irgbalance
smartmontools S.M.A.R.T. monitoring tools
acpid Advanced Configuration of Power Interface event daemon
hddtemp HDD temperature monitor
dbus Message bus daemon
saned Scanner daemon
haveged Random number generator
- Networking
bluetooth Bluetooth
rsync File copying teol
- Printing
% Close < Back oK

Figura 2-22: Abilitazione/disabilitazione dei servizi.



Commenti

Questa schermata viene visualizzata solo se si ¢ fatto clic su "Visualizza" nella
schermata Impostazione locale, fuso orario e servizi.

I servizi sono applicazioni e funzioni associate al kernel che forniscono funzionalita ai
processi di livello superiore. Se non si ha familiarita con un servizio, ¢ meglio lasciarlo
perdere.

Queste applicazioni e funzioni richiedono tempo per avviarsi e richiedono memoria,
quindi se siete preoccupati per la capacita del vostro computer, potete consultare questo
elenco per gli elementi di cui siete sicuri di non avere bisogno.

Se in seguito si desidera modificare o regolare i servizi di avvio, € possibile utilizzare
uno strumento a riga di comando chiamato sysv-re-conf. Sysv-rc-conf ¢ installato

per impostazione predefinita e deve essere eseguito come root.

Help Live Log

Default User Login

The root user is similar to the
Administrator user in some other
operating systems. You should not
use the raof user as your daily user
account. Please enter the name for
a new (defaulf) user account that
you will use on a daily basis. If
needed, you can add other user
accounts later with MX Linux User
Manager.

Passwords

Enter a new password for your
default user account and for the
root account. Each password must
be entered twice.

No passwords

If you want the default user
account to have no password, leave
its password fields empty. This
allows you to log in without
requiring a password.

Obviously, this should only be done
in situations where the user
account does not need to be
secure, such as a public terminal.

Installation in progress
94% - Paused for required operator input

Default User Account

Default user login name:

Default user password;

Confirm user password:
Root (administrator) Account

Root password:

Confirm root password:

Show passwords

Autologin

save live desktop changes

% Close - Back

Abort

Figura 2-23: Configurazione utente.

Commenti

Il livello di sicurezza delle password scelte dipende in larga misura dall'impostazione del
computer. Un desktop domestico ha generalmente meno probabilita di essere scassinato.
Se si seleziona Autologin, si potra bypassare la schermata di accesso e accelerare il
processo di avvio. Lo svantaggio di questa scelta ¢ che chiunque abbia un qualche tipo di
accesso al computer sar in grado di accedere direttamente al vostro account. E possibile
modificare le preferenze di Autologin nella scheda "Opzioni" di MX User Manager.

E possibile trasferire le modifiche apportate al desktop live all'installazione su disco
rigido selezionando I'ultima casella. Alcune informazioni critiche (ad esempio, il nome
del punto di accesso wireless) verranno trasferite automaticamente.

Se non si imposta una password di root, le autenticazioni della GUI saranno impostate
sulla password dell'utente, se non lo sono gia.



Help Live Log

Installation in progress

Installation in Progress 96% - Pretending to install MX Linux Abort
MX Linux is installing. For a fresh .

install, this will probably take 3-20 .

minutes, depending on the speed ips

of your system and the size of any support MX Linux

partitions you are reformatting. MX Linux is supported by people like you. Some help others at the support forum -

https:/forum.mxlinux.org - or translate help files into different languages, or make

If lick the Abort button, the
Sl ieranth b suggestions, write documentation, or help test new software.

installation will be stopped as soon
as possible.

Change settings while you wait
‘While MX Linux is being mslall‘sd,
you can click on the Next or Back
buttons to enter other information
required for the installation.

Complete these steps at your own
pace. The installer will wait for your
input if necessary.

$¢ Close

Figura 2-24: Installazione completata.

Commenti

* Una volta terminata la copia del sistema e completate le fasi di
configurazione, viene presentata la schermata "Installazione completata" e si
¢ pronti a partire!

* Se non si desidera riavviare il sistema al termine dell'installazione, deselezionare
I'opzione di riavvio automatico prima di fare clic su Fine.

2.6 Risoluzione dei problemi

2.6.1 Nessun sistema operativo trovato

Al riavvio dopo un'installazione, a volte capita che il computer segnali che non ¢ stato trovato
alcun sistema operativo o disco di avvio. Potrebbe anche non mostrare un altro sistema
operativo installato, come Windows. Di solito, questi problemi significano che GRUB non ¢
stato installato correttamente, ma ¢ facile da correggere.

» Se si avvia con UEF]I, assicurarsi che Secure Boot sia disattivato (non abilitato) nelle
impostazioni del BIOS/UEFI del sistema.
* Se ¢ possibile avviare almeno una partizione, aprire un terminale root ed
eseguire questo comando:
aggiornare-grub
* Altrimenti, procedere con MX Boot Repair.
* Avvio del LiveMedium.
* Avviare Strumenti MX > Riparazione avvio.
» Assicurarsi che sia selezionato "Reinstall GRUB Bootloader", quindi fare clic su OK.
* Se il problema non si risolve, ¢ possibile che il disco rigido sia difettoso. In

genere, all'inizio dell'installazione ¢ stata visualizzata una schermata di avviso
SMART.



2.6.2 | dati o altre partizioni non sono accessibili.

Le partizioni e le unita diverse da quella designata per I'avvio potrebbero non essere avviate o
richiedere I'accesso root dopo l'installazione. Ci sono un paio di modi per cambiare questa
situazione.

* Per le unita interne, utilizzare Start > Impostazioni > Tweak MX, scheda Altro:
selezionare "Abilita il montaggio delle unita interne da parte di utenti non root".

* GUI. Usare Disk Manager per controllare tutto cio che si vuole montare all'avvio e
salvare; al riavvio dovrebbe essere montato e si potra accedere al file manager
(Thunar).

* CLI. Aprire un file manager e navigare nel file /etc/fstab; utilizzare 1'opzione del clic
destro per aprirlo come root in un editor di testo. Cercare la riga contenente la partizione
o l'unita a cui si desidera accedere (potrebbe essere necessario digitare blkid in un
terminale per identificare 'UUID). Modificatela seguendo questo esempio per una
partizione dati.

UUID=9501<snip>912 /data ext4 utenti 0 2

Questa voce fa si che la partizione venga montata automaticamente all'avvio e permette di
montarla e smontarla come un normale utente. Questa voce fara anche in modo che il file
system venga controllato periodicamente all'avvio. Se non si vuole che venga montata
automaticamente all'avvio, cambiare il campo delle opzioni da "user" a "user,noauto".
* Se non si vuole che venga controllato regolarmente, cambiare il "2" finale con uno "0".
Poicheé si dispone di un filesystem ext4, si suggerisce di attivare il controllo automatico.
* Se l'elemento ¢ montato ma non viene visualizzato nel file manager, aggiungere un
ulteriore "comment=x-gvfs-show" alla riga del file fstab, per forzare il montaggio a

essere visibile. Nell'esempio precedente, la modifica sara simile a questa:
UUID=9501<snip>912 /data extd4 users,comment=x-gvfs-show 0 2

NOTA: nessuna di queste procedure modifica 1 permessi di Linux, che vengono applicati a
livello di cartella e di file. Vedere la Sezione 7.3.

2.6.3 Problemi di portachiavi

Un portachiavi predefinito dovrebbe essere creato automaticamente e 1'utente non dovra fare
nulla. Se si utilizza l'autologin, quando un'applicazione accede al portachiavi, all'utente viene
chiesto di inserire una nuova password per creare un nuovo portachiavi predefinito. Per
maggiori dettagli, consultare il Wiki tecnico di MX/Antix.

Si noti che se agenti malintenzionati ottengono l'accesso fisico al computer, 1'utilizzo di una
password vuota ne facilitera I'accesso. Ma sembra abbastanza chiaro che se un agente
malintenzionato ha accesso fisico al vostro computer, ¢ comunque tutto finito.

2.6.4 Bloccaggio

Se MX Linux si blocca durante I'installazione, di solito € dovuto a un problema di hardware
difettoso del computer o a un supporto di installazione difettoso. Se si ¢ stabilito che il problema
non ¢ il supporto, potrebbe essere dovuto a una RAM difettosa, a un disco rigido difettoso o a


https://mxlinux.org/wiki/system/gnome-keyring

qualche altro componente hardware difettoso o incompatibile.

* Aggiungere una delle opzioni di avvio utilizzando F4 all'avvio o consultando la
Wiki MX/antiX. Il problema piu comune ¢ dovuto al driver grafico.



https://mxlinux.org/wiki/system/boot-parameters

* L'unita DVD potrebbe avere dei problemi. Se il sistema lo supporta, creare una
chiavetta USB avviabile di MX Linux e provare a installare da li.
* Spesso i sistemi si bloccano a causa del surriscaldamento. Aprite il telaio del computer
e assicuratevi che tutte le ventole del sistema siano in funzione all'accensione. Se il
BIOS lo supporta, controllare le temperature della CPU e della scheda madre (inserire
1 sensori in un terminale root, se possibile) e confrontarle con le specifiche di
temperatura del sistema.
Spegnere il computer e rimuovere 1'hardware non essenziale, quindi tentare nuovamente
l'installazione. L'hardware non essenziale puo includere dispositivi USB, seriali e a porta
parallela; schede di espansione PCI/PCI Express, AGP, PCIE, slot per modem o ISA rimovibili
(escluso il video, se non ¢ presente il video a bordo); dispositivi SCSI (a meno che non si stia
effettuando l'installazione da o verso uno di essi); dispositivi IDE o SATA che non si stanno
installando da o verso; joystick, cavi MIDI, cavi audio e qualsiasi altro dispositivo multimediale
esterno.



3 Configurazione

j VIDEOQO: Cose da fare dopo l'installazione di MX Linux

Questa sezione contiene le istruzioni di configurazione per far funzionare correttamente il
sistema a partire da una nuova installazione di MX Linux e una breve guida alla
personalizzazione.

3.1 Dispositivi periferici

3.1.1 Smartphone (Samsung, Google, LG, ecc.)

j VIDEO: Smartphone e MX-16 (samsung galaxy s5 e iphone 6s)

Android

Condivisione di file con un dispositivo Android.

1. E possibile accedere ai telefoni Android tramite un browser web installando
un'applicazione dal Play Store di Google, come AirDroid.

2. Possono anche essere montati direttamente.

» La maggior parte dei telefoni con sistema operativo Android 4.xx e successivi
include la funzionalita MTP e si puo utilizzare la seguente procedura.

* Collegare il telefono e toccare il link visualizzato per assicurarsi che I'opzione
di archiviazione id sia impostata su "scambio di file" o qualcosa di simile.

* Aprire MX File Manager. Quando in Dispositivi viene visualizzato il nome del
telefono (0o: Memoria), fare clic su di esso. Se non viene visualizzato, riavviare
il telefono. 11 telefono potrebbe visualizzare una finestra di dialogo che chiede
di autorizzare l'accesso.

* Navigare fino alla posizione desiderata.


https://youtu.be/aESEb8lTvz4
https://www.youtube.com/watch?v=YoMRRXP3Pic
http://web.airdroid.com/

* Alcuni file possono essere visualizzati e gestiti con le applicazioni MX Linux: fare
clic su Dispositivo nel riquadro di sinistra, quindi fare doppio clic su Unita CD, se
necessario.

+ KDE Connect ¢ anche un'opzione per condividere file con un telefono Android.
KDE Connect ¢ disponibile nel menu delle applicazioni di MX KDE. Se non ¢ gia
installato sul vostro telefono Android, ¢ disponibile su Google Play Store.

* Per impostazione predefinita, il firewall blocca la connessione dal dispositivo
Android. Dovra essere disattivato o dovra essere impostata una regola del firewall
per consentire la connessione.

* Musica: utilizzare il lettore musicale predefinito (Strawberry)

* Immagini: utilizzare 1'applicazione predefinita per la visualizzazione delle
immagini (nomacs) o installare un'applicazione diversa utilizzando MX
Package Installer.

- Mike's AD3

File Edit View Go Bookmarks Help
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Figura 3-1a: Thunar collegato a un telefono Android Samsung.
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Figura 3-1b: Dolphin collegato a un telefono Android Samsung.



iPhone Apple

MX iDevice Mounter consente di accedere tramite Thunar ai dispositivi piu vecchi. I telefoni
piu recenti non sono piu accessibili con questo processo.

3.1.2 Stampante

Print Settings - localhost

Printer View Help

+ Add | - = Filter: |Q

Brother_HL_L2380DW _series

Connected to localhost

Figura 3-2: schermata Nuova stampante di Print Setting.

Stampante allegata

MX Linux offre due utility per la configurazione e la gestione delle stampanti. Print Settings di
solito funziona bene, ma in caso di problemi si consiglia di passare a CUPS in un browser
inserendo "localhost:631:" nella barra degli indirizzi di un browser web.

* Applicazione Impostazioni di stampa
= Fare clic sul menu Start > Sistema > Impostazioni di stampa
<= Fare clic sul pulsante "+Aggiungi".

= Attendere nella schermata Nuova stampante mentre 1'applicazione cerca le
stampanti collegate e wireless.

= Mostra il software consigliato per ogni stampante trovata.



= Seguire le istruzioni per concludere l'installazione della stampante.
* In caso di problemi, a volte ¢ possibile risolverli passando a CUPS.

< Inserite http://localhost:63/admin in un browser web

= In questa pagina ¢ possibile aggiungere stampanti, esaminare i lavori, ecc.

HELP: il Wiki Debian.

Stampante di rete

Samba su MX Linux consente di stampare attraverso la rete verso stampanti condivise su altri
computer (Windows, Mac, Linux) e dispositivi NAS (Network Attached Storage) che offrono
servizi Samba (Sezione 3.5).

Utilizzo delle impostazioni di stampa

* Fare clic sul menu Start > Sistema > Impostazioni di stampa
* Selezionare Server > Nuovo > Stampante
» Selezionare Stampante di rete > Stampante Windows via SAMBA.

* Nella finestra di dialogo per smb:// inserire nome del server/nome della
stampante o indirizzo del server/nome della stampante. Ad esempio:
smb://bigserver/usbprinterl oppure smb://192.168.0.100/printer2

* Se avete difficolta a identificare i nomi dei server e delle stampanti, fate clic sul
menu Start > Sistema > Samba per maggiori dettagli.

» Lasciare selezionato il pulsante Richiedi all'utente se ¢ richiesta l'autenticazione,
quindi fare clic su Avanti.

» Lasciate selezionato il pulsante Seleziona stampante dal database e fate clic su Avanti.
» Selezionate il driver e poi Avanti.
* Se necessario, descrivere la stampante e applicare.
* Quando la stampante appare nella finestra, fare clic con il pulsante destro del
mouse su Proprieta > Stampa pagina di prova per verificare che la connessione e

1l driver funzionino correttamente.

Risoluzione dei problemi


https://wiki.debian.org/SystemPrinting
https://wiki.samba.org/index.php/Main_Page

» Nell'applicazione Impostazioni di stampa ¢ integrata un'utilita per la risoluzione dei
problemi. Fare clic su Guida > Risoluzione dei problemi.

* Per le stampanti HP, il pacchetto aggiuntivo HP Printing (') installera nell'area di
notifica un'utile applet che fornisce strumenti per la risoluzione dei problemi.

* Se la stampante smette improvvisamente di stampare, verificare che sia ancora
abilitata facendo clic sul menu Start > Sistema > Impostazioni di stampa, quindi
fare clic con il pulsante destro del mouse sulla stampante e abilitarla nuovamente.

* Se la stampante non viene riconosciuta o non funziona correttamente, consultare il

Wiki MX/antiX per un aiuto dettagliato su come ottenere il driver corretto.

3.1.3 Scanner

Gli scanner sono supportati in Linux da SANE (Scanner Access Now Easy), un'interfaccia di
programmazione delle applicazioni (API) che fornisce un accesso standardizzato a qualsiasi
hardware di scansione di immagini raster (scanner piano, scanner portatile, videocamere e
fotocamere, frame-grabber, ecc.)

Fasi di base

E possibile gestire lo scanner in MX Linux con Simple Scan. E molto facile da usare e pud
esportare in PDF con un solo clic.

Risoluzione dei problemi

* Alcuni scanner richiedono un frontend (interfaccia di sistema con lo scanner) diverso: ¢
possibile installare gscan2pdf, fare clic su Modifica > Preferenze e utilizzare il menu a
discesa per selezionarne un altro (ad esempio, scanimage).

* Assicuratevi che il vostro scanner sia elencato come supportato da SANE in questo elenco.

* Se si continuano a riscontrare problemi, consultare il Wiki MX/antiX per trovare soluzioni.

3.1.4 Webcam

Molto probabilmente il video della vostra webcam funzionera in MX Linux; potete verificarlo
lanciando il menu Start > Multimedia > webcamoid e usando le impostazioni in fondo alla
finestra per regolare il vostro sistema. Se non sembra funzionare, c'¢ una recente discussione
dettagliata sui driver e sulla configurazione nel Wiki di Arch. L'audio della webcam a volte ¢ piu

complicato, si veda la Sezione 4.1 su Skype.


https://mxlinux.org/wiki/hardware/printer-drivers
http://www.sane-project.org/sane-mfgs.html
https://mxlinux.org/wiki/hardware/scanner
https://wiki.archlinux.org/index.php/Webcam

3.1.5 Immagazzinamento

Unita disco (come SCSI, SATA e SSD), fotocamere, unita USB, telefoni, ecc. - sono tutte
forme diverse di archiviazione.

Montaggio in magazzino

Per impostazione predefinita, 1 dispositivi di archiviazione collegati al sistema vengono montati
automaticamente nella directory

/media/<nome utente>/ ¢ per ognuno si apre una finestra del browser dei file (questo
comportamento puod essere modificato in Thunar: Modifica > Preferenze o KDE: Impostazioni di
sistema > Archiviazione rimovibile).

Non tutti 1 dispositivi di archiviazione, in particolare le unita e le partizioni interne aggiuntive,
vengono montati automaticamente quando vengono inseriti nel sistema e potrebbero richiedere
l'accesso come root. Le opzioni possono essere regolate con MX Tweak > Altro e Impostazioni
> Unita e supporti rimovibili.

Permessi di archiviazione

L'ampiezza dell'accesso dell'utente allo storage dipende dal file system che contiene. La
maggior parte dei dispositivi di archiviazione esterni commerciali, in particolare 1 dischi rigidi,
sono preformattati come fat32 o ntfs.

Sistema di file di Permessi
archiviazgione
FAT32 Nessuno.
NTFS Per impostazione predefinita, le autorizzazioni/proprieta sono
concesse all'utente che monta il
dispositivo.
ext2, ext4 e la maggior Montato per impostazione predefinita con proprieta
parte dei file impostata su Root. Regolazione dei
system Linux permessi: vedere la Sezione 7.3.

E possibile modificare la necessita di Root per l'accesso ai dispositivi di archiviazione interni
con file system Linux utilizzando MX Tweak, scheda Altro (Sezione 3.2).

Unita a stato solido

Le macchine piu recenti possono essere dotate di un'unita SSD interna: un'unita a stato solido
che non ha componenti in movimento. Queste unita tendono ad accumulare blocchi di dati che
non sono piu considerati in uso, rallentando questa unita molto veloce. Per evitare che cio
accada, MX Linux esegue un'operazione di TRIM con cadenza settimanale che puo essere
visualizzata aprendo il file /var/log/trim.log.


https://en.wikipedia.org/wiki/Solid-state_drive
https://en.wikipedia.org/wiki/Trim_(computing)

3.1.6 Dispositivi Bluetooth

I dispositivi Bluetooth esterni, quali tastiera, altoparlante, mouse e cosi via, normalmente
funzionano automaticamente. In caso contrario, procedere come segue:



» Xfce: fare clic sul menu Start > Impostazioni > Bluetooth Manager (oppure: fare
clic con il pulsante destro del mouse sull'icona Bluetooth nell'area di notifica >
Dispositivi).

» KDE: fare clic sul menu Start > Impostazioni > Impostazioni di sistema > Hardware > Bluetooth

* Verificare che l'adattatore sia abilitato e che sia visibile facendo clic sul menu Start >
Impostazioni > Adattatori Bluetooth.

 Assicurarsi che il dispositivo desiderato sia visibile; in Bluetooth Manager fare
clic su Adapter > Preferences e selezionare I'impostazione di visibilita.

» Se la periferica desiderata ¢ presente nella finestra Dispositivi, selezionarla e fare clic su Impostazione.

* In caso contrario, fare clic sul pulsante Cerca e premere Connetti sulla riga del
dispositivo per avviare l'associazione.

* Per un telefono, ¢ probabile che si debba confermare il numero di accoppiamento sia
sul telefono che sul desktop.

* Dopo l'accoppiamento con il dispositivo Bluetooth, la finestra di dialogo Setup
chiede di confermare il tipo di configurazione Bluetooth da associare al dispositivo.

* Al termine del processo di configurazione, il dispositivo dovrebbe essere funzionante.

Trasferimento di oggetti

Per poter passare oggetti (documenti, foto, ecc.) da un desktop MX Linux a un dispositivo
come un telefono utilizzando la tecnologia Bluetooth, ¢ necessario procedere come segue:

* Installare obex-data-server dai repo.
* Portera con sé libopenobex?2.

* Inrari casi, il pacchetto obex-data-server puo bloccare I'uso del mouse o
della tastiera Bluetooth.

» Verificare che il telefono e il desktop siano entrambi abilitati al Bluetooth e siano visibili.
 Inviare il file.
» Dal desktop di MX Linux: fare clic con il tasto destro del mouse sull'icona
Bluetooth nell'area di notifica > Invia file (oppure utilizzare Bluetooth

Manager)

* Dal telefono: seguite le istruzioni appropriate per il vostro dispositivo.



* Tenere d'occhio il dispositivo ricevente per confermare l'accettazione
dell'oggetto trasferito.

E anche possibile utilizzare hcitool alla riga di comando.

Collegamenti

» Risoluzione dei problemi di Blueman

* Wiki Arco

*  Wiki Debian sull'accoppiamento

3.1.7 Pastiglie a penna

Le tavolette con penna Wacom vengono rilevate automaticamente e supportate in modo nativo
su Debian. I dettagli nel Wiki MX/antiX.

Collegamenti

e [l progetto Linux Wacom

3.2 Strumenti MX di base

Un certo numero di applicazioni sono state sviluppate specificamente per MX Linux, adattate
o portate da antiX, o adattate da fonti esterne per risparmiare all'utente la fatica di compiti
importanti che spesso comportano passaggi poco intuitivi. (Snapshot e altri strumenti avanzati
sono trattati nella Sezione 6.6).


http://www.linuxjournal.com/content/bluetooth-hacks
https://github.com/blueman-project/blueman/wiki/Troubleshooting
https://wiki.archlinux.org/index.php/Blueman
https://wiki.debian.org/BluetoothUser#Pairing
https://www.wacom.com/en-us/
https://mxlinux.org/wiki/hardware/wacom/
https://linuxwacom.github.io/
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Maintenance

4~ Chroot Rescue Scan

MX Tools

These MX applications save time and effort with important tasks.
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@ Date & Time
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+  Boot Repair
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"b Deb Installer

? Fix GPG keys

[ ] Hide individual tools from the menu

| Q@ About.. || ? Manual @

Q} Package Installer

B Repo Manager
|:— arch

®x Close

Figura 3-3: Cruscotto di MX Tools (Xfce installato). I cruscotti di Live e KDE sono
leggermente diversi.

3.2.1 MX Updater (ex Apt-Notifier)

Questa versatile applet (solo per Xfce, KDE usa Discover) si trova nell'area delle notifiche e
segnala la disponibilita di pacchetti. Assicuratevi di controllare le opzioni importanti disponibili
attraverso il menu contestuale (tasto destro del mouse). Se non appare, lanciare MX Updater
per aggiornarlo. Solo Xfce, KDE usa Discover.

X, At Natifier—View and Upgrade, previesing: api-get dist-upgrade NG

use apt-get's ~yes option for distupgrade

apiget dist

switch to 'apt-get upgrade’ W5 aptgetdist-upgrade C Reload @ Cancel

Figura 3-4: Schermata di visualizzazione e aggiornamento da MX Updater.


https://userbase.kde.org/Discover

Si noti la scelta tra upgrade e dist-upgrade.

full-upgrade (dist-upgrade): ¢ I'azione predefinita. Aggiornera tutti i pacchetti che
hanno aggiornamenti, anche quelli in cui l'aggiornamento comportera la rimozione
automatica di altri pacchetti esistenti o 'aggiunta di nuovi pacchetti all'installazione, in
modo che tutte le dipendenze siano risolte.

upgrade: consigliato solo agli utenti piu esperti. Aggiorna solo i pacchetti aggiornabili
che non comportano la rimozione o l'installazione di altri pacchetti. L'uso di questa
opzione significa che alcuni pacchetti aggiornabili potrebbero rimanere "bloccati" sul
sistema.

Nelle Preferenze ¢ disponibile un'opzione per I'aggiornamento non presidiato.
Questo avviene in background e non aggiunge nuovi pacchetti o ne rimuove di
esistenti, utilizzando il metodo "upgrade" piuttosto che il dist-upgrade.

Altre opzioni sono disponibili nel file di configurazione: ~/.config/MX-Linux/apt-

notifier.conf HELP: qui.

3.2.2 Configurazione di Bash

Bash (il linguaggio di shell predefinito in MX Linux) puo ora essere impostato con questa

piccola applicazione. Essa consente all'utente avanzato di apportare modifiche agli alias e alla

tematizzazione del prompt del terminale nel file bashrc nascosto dell'utente.

Bash Config

Aliases | Prompt
Alias Command
11s Is —color=auto
2 dir dir —color=auto
3 vdir vdir --color=auto
4 grep grep --color=auto
5 fgrep fgrep --color=auto
6 egrep egrep --color=auto
71 Is -lh
8 la Is -A
gl Is -CF
| + Add Alias [ = Remove Alias(es) |
L
@ About || ? Help || ¥ Apply || x Close |

Figura 3-5: la scheda per aggiungere o modificare un alias.


https://mxlinux.org/wiki/help-files/help-mx-apt-notifier

Aiuto: qui.

3.2.3 Opzioni di avvio

MX Boot Options

Options
Menu timeout 10 . seconds
Bootto [mx 23 Libretto :

Enable saving last boot choice [_| Use flat menus (no submenus)

Kernel parameters quiet splash

| 1"} Manage UEFI Boot Options l

Background

Enable theme [ /boot/grub/themes/mx_linux/theme.txt ]

Splash

Enable theme [MXLiveLugn ” I [ ] Previewl

Messages
) |Very detailed

@ Detailed (default setting)

‘. e Display log |

o 7 B oo

Figura 3-6a: Schermata principale che mostra le varie opzioni.

Le opzioni di avvio includono i parametri del kernel, i temi di GRUB, le immagini Splash e altri
elementi. Questa applicazione consente agli utenti di gestirle in modo semplice e veloce.
L'opzione "Manage UEFI Boot Options" appare solo quando il PC ¢ avviato in modalita UEFI.
Esempio seguente

©] Edit UEFI Boot Entries 4+ x

You can use the Up/Down buttons, or drag & drop items to change boot order.
- Items are listed in the boot order.
- Grayed out lines are inactive.

BOOt0001 * MX23 [ileweele

Boot0002* MX21
Boot0000* Windows Boot Manager [ + Add entry ‘

[ ~ Move down |

[ - Boot next ‘
Boot Current: 0001
Timeout: 10 seconds [ E Change timeout ‘
Boot Next: 0001 | © Resetnext |

I X Close |

Figura 3-6b

AIUTO: qui.


https://mxlinux.org/wiki/help-files/help-bash-config/
https://mxlinux.org/wiki/help-files/help-mx-boot-options

3.2.4 Riparazione degli stivali

I1 bootloader ¢ il primo programma software ad essere eseguito ed ¢ responsabile del
caricamento e del trasferimento del controllo al kernel. A volte capita che il bootloader di
un'installazione convenzionale (GRUB2) diventi disfunzionale; questo strumento consente di
ripristinare il bootloader in uno stato funzionale da un avvio LIVE.

MX Boot Repair

MX Boot Repair is a utility that can be used to reinstall GRUB bootloader on
the ESP (EFI System Partition), MBR (Master Boot Record) or root partition.
It provides the option to reconstruct the GRUB configuration file and to
back up and restore MBR or PBR (root).

What would you like to do?
@ [Reinstall GRUB bootloader on ESP, MBR or PBR (root)

) Repair GRUB configuration file
) Backup MBR or PBR (legacy boot only)

) Restore MBR or PBR from backup (legacy boot only)

| © About... || ? Help | @ | « Apply |[ x Cancell

Figura 3-7: Schermata principale di Boot Repair, con l'opzione piu comune selezionata.

AIUTO: qui.

3.2.5 Voci di sistema della luminosita

Questo strumento inserisce un'icona nel Systray che visualizza una piccola applicazione con la
quale I'utente puo regolare la luminosita dello schermo.

| eDP-1 = =

Software (xrandr) Brightness

100 Save |

Figura 3-8: pronti a regolare la luminosita.

3.2.6  Scansione di salvataggio di Chroot

Questo strumento consente di accedere a un sistema anche se il file

initrd.img ¢ rotto. AIUTO: qui.


https://mxlinux.org/wiki/help-files/help-mx-boot-repair
https://mxlinux.org/wiki/system/chroot-rescue-scan/

Terminal -
ing chroot-rescue-scan

Scanning partitions ...
Scanning directories ...
Only one Linux system was found

Please select a Linux system to visit

Distro Date Dir Device Arch Label
% 21 Vi ldf Lower 2021-09-65 _TrootHXz1 nvmeonipd 64-bit rootMX2d ]
> Rescan all partitions for Linux systems
> Quit
Press <Enter> to select the highlighted entry

Use 'r' to redraw, 'q' to quit

Figura 3-9: risultati della scansione per i sistemi Linux.

3.2.7 Correggere le chiavi GPG (in precedenza Check apt GPG)

Se si tenta di installare dei pacchetti non autenticati, si incorre in un errore di apt: Non é stato
possibile verificare le seguenti firme perché la chiave pubblica non é disponibile. Questa utile
utility evita di eseguire 1 numerosi passaggi necessari per ottenere tale chiave.

] Terminal [P

Checking mx.debian.nz_mx_repo_dists_mx16_InRelease

ing ftp.nz.debian.org_debian_dists_jessie-updates_InRelease

g mx.debian.nz_antix_jessie_dists_jessie_Release

g ftp.nz.debian.org_debian_dists_jessie_Release

ing mx.debian.nz_mx_repo_dists_mx15_InRelease

g security.debian.org_dists_jessie_updates_InRelease

Press 'H' for online help, press any other key to close this window.

Figura 3-10: Risultati della verifica delle chiavi pubbliche del repo con quelle di Fix GPG.

AIUTO: qui.

3.2.8 Pulizia MX


https://mxlinux.org/wiki/help-files/help-mx-check-apt-gpg

B MX Cleanup + = O x

Free Disk Space for User

select user: mike s
Clean Folders Clear APT Cache

|+ ~fthumbnails @ old files

[¥] ~t.cache O Allfiles

® Mot accessed for: 2 days 2 Don't empty

(! all {potentially dangerous)
& Y J Clean Flatpak

|_| Remove unused runtimes

Delete Logs Empty Trash
@ old logs @ selected user
Al logs ) Al users
Don't empty () Don't empty
Logs older than: | 7 days : Trash older than: 30 days
Schedule
@ No automaticclean () Atreboot (U Daily () Weekly (U Monthly

Kernel removal tool

= List and select kernels to remove

Graphical Tool for Analyzing Disk Usage

™ Run Disk Usage Analyzer

0 About... | ? Help @ v Apply | x Close

Figura 3-11: Cleanup pronto a lavorare.

Questa piccola applicazione offre un modo semplice e sicuro per rimuovere i file non necessari
e ripristinare lo spazio. Lo strumento di rimozione del kernel viene utilizzato per rimuovere 1
kernel piu vecchi non piu in uso.

AIUTO: qui.

3.2.9 Installatore di codec

Un codec ¢ un software che consente di codificare/decodificare un flusso di dati o un segnale
digitale. La maggior parte dei codec viene installata in MX Linux, ma alcuni sono limitati.
Verranno installati anche Libdvdcss2 (per la lettura di DVD commerciali) e libtxc-dxtn0 (per
alcune texture di giochi 3D). Questo strumento consente di installare facilmente alcuni codec
con restrizioni, trasferendo la responsabilita all'utente.

g Mx Codecs Installer @

X

This application allows you to install restricted codecs that permit advanced video
and audio functions.

In some juridictions their distribution may be limited so the user must meet local
regulations.

Do you assume legal responsibility for downloading these codecs?

| © rbout..

?
|| Help | ~ OK | X Cancel |

Figura 3-12: Schermata principale del programma di installazione dei codec.


https://mxlinux.org/wiki/help-files/help-mx-cleanup/

AIUTO: qui.

3.2.10 MX Conky

L'applicazione denominata MX Conky funziona insieme a Conky Manager per manipolare con

estrema facilita i dettagli di un Conky, in particolare il colore, nella collezione MX Conky. Nel
menu ¢ presente anche un'applicazione "Conky Toggle" per spegnere e accendere qualsiasi
Conky configurato.

This app enables detailed changes to the active conky. It
supplements Conky Manager, which should be used for
basic settings.

Launch
| X MX-Asq_clock_new

| *€ Run | # Edit C Undo
| ‘& Conky Manager

Drag
To Move ' |+ Left Click

ToResize *' | +Right Click

NOTE: changes last only for the current session

Desktop
= Desktop 1 > All Desktops

Format
Day < long O short
Month Long = Short

Colors
Default
Color0
Color1
Color2
Color3
Color4

© About... | 2 Help |

=3

x Close

Figura 3-13: Conky pronto a modificare i dettagli di un Conky predefinito.

AIUTO: qui.

3.2.11 Programmatore di lavori

Questa pratica applicazione presenta un frontend grafico per l'applicazione a riga di comando
crontab, facilitando l'impostazione dei lavori.

Figura 3-14: Programmatore di lavori.


https://mxlinux.org/wiki/help-files/help-mx-codecs-installer
https://teejeetech.in/conky-manager/
https://mxlinux.org/wiki/help-files/help-mx-conky
https://mxlinux.org/wiki/system/crontab/

HELP: file dei lavori locali: /usr/share/job-scheduler/locale/



3.2.12 Creatore di USB dal vivo

Questo semplice strumento consente di creare rapidamente una Live-USB partendo da un file
ISO, da un CD/DVD live, da una Live-USB esistente o anche da un sistema live in esecuzione.

MX Live Usb-Maker

Select Target USB Device | sdb 1.9G Flash Disk Generic = C Refresh drive list |
Select ISO file [[0 /home/mike/MX-21.3_May_x64.iso ]J | \» Show advanced options |
Options Mode
[] Dry run (no change to system) [_] Clone an existing live system @ Full-featured mode - writable LiveUSB
[ ] Encrypt [ clone running live system © Image mode - read-only LiveUSB (dd)
For distros other than antiX/MX use image
Percent of USB-device to use: | 100% _ i
Label ext partition:
| © About... | | ? Help | | e View Log | @ = Next | | % Close

Figura 3-15: Live USB Maker.

Aiuto: qui

3.2.13 Assistente di rete

Questa applicazione semplifica il processo di risoluzione dei problemi di rete, rilevando
I'hardware, modificando lo stato di uno switch hardware, consentendo la gestione dei driver
Linux e fornendo strumenti di rete generali.



MX Network Assistant

© status | f Linuxdrivers -5 Net diagnostics

Hardware detected

Enabled 4 Interface Driver Description Vendor Product

(] M eth0 e1000e Ethernet interface Intel Corporation Ethernet Connection (5) 1219-LM (rev 00)

=Y @ Rescan|

IP address
External IP address: 174.166.63.142
IP address from router: 192.168.1.105

Active interface
etho

| O About... | | ? Help @

Figura 3-16: Network Assistant rileva I'hardware wireless.

ELP: qui.

3.2.14 Programma di installazione dei driver Nvidia

Il programma di installazione dei driver grafici Nvidia semplifica notevolmente una procedura
importante: l'installazione di un driver grafico proprietario utilizzando lo script sottostante ddm-
mx. Facendo clic sull'icona del programma di installazione dei driver Nvidia si accede a un
terminale e, nella maggior parte dei casi, l'utente non deve fare altro che accettare le
impostazioni predefinite.


https://mxlinux.org/wiki/help-files/help-mx-network-assistant

Terminal + - + x
lAbout to execute /usr/local/bin/ddm-mx -i nvidia.

|This command needs root privileges to be executed.

Using su...

Enter root password at prompt.

[Password:

fcreating lock .

367.44-3mx150+3
IInstalled is: 367.44-3mx150+3
[nvidia driver already installed

Press <Enter> to exit

Figura 3-17: Il programma di installazione del driver MX Nvidia non trova alcuna necessita di continuare.

AIUTO: qui.

3.2.15 Installatore di pacchetti

VIDEO: Installare le applicazioni con MX Package Installer

Il semplice gestore di pacchetti personalizzato per MX Linux consente di cercare, installare o
rimuovere sia 1 pacchetti piu diffusi sia qualsiasi pacchetto presente nei repository MX/Debian
Stable, MX Test, Debian Backports e Flatpak in modo rapido, sicuro e semplice.

MX Package Installer

‘ Popular Applications ‘ Enabled Repos | MX Test Repo ' Debian Backports Flatpaks Console Output

Manage popular packages
= Installed packages |f—a h

Category Package Info  Description
Audio

Browser

Children

Desktop Environments

Development

Docks

Email

File Managers

FTP

YYVYVYVYVYVVYY
EEEEREEEETR

| ©® About... | | ? Help @ _ _| X Close -

Figura 3-18: Il programma di installazione dei pacchetti mostra i pacchetti pin diffusi per lo sviluppo.

AIUTO: qui.


https://mxlinux.org/wiki/help-files/help-amdati-and-nvidia-installers
https://www.youtube.com/watch?v=4kXSMfPkQSA
https://mxlinux.org/wiki/help-files/help-mx-package-installer

3.2.16 Gestore delle operazioni di pronti contro termine

Ci sono molte ragioni per cui l'utente potrebbe voler cambiare il mirror predefinito, da un
server offline a un cambiamento nella posizione fisica del computer. Questo ottimo strumento
consente di cambiare i repo con un solo clic, risparmiando molto tempo e fatica.

E inoltre disponibile un pulsante che consente di testare tutti i repo (MX o Debian) e di selezionare il piu
veloce.

MX Repo Manager

Select the APT repository that you want to use:

MX repos | Debian repos = Individual sources

]

=he United Kingdom, Manchester - https://mirrors.ukfast.co.uk/sites/MX_antiX_packages
EE united States, Atlanta GA - http://www.gtlib.gatech.edu/pub/MX-Linux/workspace
) EE united States, Brekeley, CA - https://mirrors.ocf.berkeley.edu/mx-packages

) EE united States, Herndon, VA - http://mirror.cogentca.com/pub/linux/mxlinux

EE united States, Lenexa KA - https://mirror.us.oneandone.net/linux/distributions/mx/packages

EE united States, Los Angeles CA - http://la.mxrepo.com

EE united States, Madison WI - http://mxlinux.mirrors.tds.net/mxlinux

EE united States, Maryland MD - http://mirrorumd.edu/mxlinux
EE united states, OR, IL, NY - http://ftp.osuosl.org/pub/mxlinux
EE united States, Princeton N - http://mirror.math.princeton.edu/pub/mxlinux

) EE united States, Rochester NY - http://mirrors.rit.edu/mxlinux/mx-packages
) EE united States, Salt Lake City UT - http://mxrepo.com

‘ k Select fastest MX repo for me search

| @ About... || ? Help ‘ @ | v Apply ‘

Figura 3-19: Scelta del repository da usare in Repo Manager.

AIUTO: qui.

3.2.17 Configurazione di Samba

MX Samba Config ¢ uno strumento che aiuta gli utenti a gestire le loro condivisioni di rete
samba/cifs. Gli utenti possono creare e modificare le condivisioni di cui sono proprietari, nonché
gestire i permessi di accesso degli utenti per tali condivisioni.

MX Samba Config

Shares

Name

No samba user shares found

Samba

s enabled Disable Automatic Samba Startup

© About..| ? Help () % Close

AIUTO: qui


https://mxlinux.org/wiki/help-files/help-mx-repo-manager
https://mxlinux.org/wiki/help-files/help-mx-samba-config/

3.2.18 Scheda audio

Spesso 1 computer dispongono di piu di una scheda audio e I'utente che non sente nulla pud
concludere che il suono non funziona. Questa piccola applicazione intelligente permette
all'utente di selezionare quale scheda audio deve essere utilizzata dal sistema.

MX Select Sound

If your computer has more than one sound card, you can use this application to select the
one to be default.

Your current default sound card is: none

Select another sound card if necessary: ‘ PCH: HDA-Intel - HDA Intel PCH =
I © About... I ? Help ‘ @ [ ~ Apply |

Figura 3-220: Effettuare la selezione in Scheda audio.
AIUTO: qui.

3.2.19 Tastiera di sistema

System Keyboard

Layouts§| Hotkeys | Advanced ‘

Keyboard Model
Generic 105-key PC E‘

Keyboard Layouts
EE us English (US)

‘: 0Help| |.prpIyH.§ancelH v 0K ]

Figura 3-21: La schermata principale é pronta per consentire all'utente di selezionare una tastiera diversa.

Nel caso in cui l'utente abbia trascurato di selezionare la tastiera di sistema dal menu di accesso,
non l'abbia impostata nella sessione Live o abbia semplicemente bisogno di apportare una
modifica, questa piccola applicazione offre un modo semplice per eseguire 1'operazione dal
menu Start.

AIUTO: qui.


https://mxlinux.org/wiki/help-files/help-sound-card
https://mxlinux.org/wiki/help-files/help-mx-system-keyboard

3.2.20 Lingue del sistema
-+ o]

Configuiring locales Locales to be generated:

iHeEp
All locales I
aa_D].UTF-8 UTF-8
aa_ER UTF-8
aa_ER@saaho UTF-8
aa_ET UTF-8
af ZAUTF-8 UTF-8
agr_PE UTF-8
ak_GH UTF-8
am_ET UTF-8

an_ES.UTF-8 UTF-8

mMiTE o

Back| [Next

Figura 3-22: Presentazione dei locali da generare per l'utente.

Nel caso in cui l'utente abbia trascurato di selezionare la localizzazione del sistema dal menu di
accesso, non l'abbia impostata nella sessione Live o abbia semplicemente bisogno di una
modifica, questa piccola applicazione offre un modo semplice per eseguire 1'operazione dal
menu Start.

AIUTO: qui.

3.2.21 Suoni di sistema (solo Xfce)

Questo piccolo strumento raccoglie in un'unica posizione le varie azioni e scelte coinvolte
nell'impostazione dei suoni del sistema, come login/logout, azioni, ecc.

MX System Sounds

Event Sounds Session Sounds
[ ]|XFCE Event Sounds [] Login

[_] XFCE Input Feedback Sounds

Custom Sounds

Theme | Borealis =

Login Sound |E| | | Default | |§|

omu 2w (B [ s o]

Figura 3-23: Impostazione dei suoni di login e logout in Suoni di sistema.

AIUTO: qui.

3.2.22 Data e ora

MX Date & Time consente di effettuare regolazioni di ogni tipo da un'unica applicazione. Solo Xfce.


https://mxlinux.org/wiki/help-files/help-mx-system-locales
https://mxlinux.org/wiki/help-files/help-mx-system-sounds

Date and Time | Hardware Clock  Netwerk Time
= September 2019 - EEERCCEER PR T TCE SN -
5 - e | L '.'I.
Mon | T | Wed | Tha | Fri | Sst Sue .‘\ X]I i"
T ) P P R L
L r 3
E - i
2 4|5 |6 7|8 - ]
o (1011|1223 14|15 || =X E=
- __,.‘-"""- p
16 17 |18 |19 20 21 22 ol -
il | - L
= hout
23 2425|2627 218 79 L o
30 4 ‘ A W
| Yigkust
abaut. 23| Help Apply 3 Close

Figura 3-24: La scheda principale di Data e ora

AIUTO: qui.

3.2.23 MX Tweak

MX Tweak riunisce una serie di personalizzazioni piccole ma spesso utilizzate, come la
gestione dei pannelli, la selezione dei temi, 'abilitazione e 1'impostazione del compositore, ecc.

su base individuale.

affects 15t panel Panel Plugin Scales

0 Sed Scales

Wolume (080 l

Pawer Menager

@ Display panel horieontally |Baltom 3|
O Display panel vertically  [teil &

Affects all panels

> Restore default panel

' Backup current panel configuration

0 Restore backup pansl configuration | panel backup 01.06.2023.01.52.13 &

Tasklist
() Sat Tasklist plugin to: docklike g
Docklike
I options |
e ey 000 ]
Hfce Setrings.
|i| Fane =1 windaw sanager Bl Appearance

© sbout | 7 Help @ | % Close

Plasma Other

Affects 1st panel

Placement Bottorn
Workspace

(M) Enable single-click

(M) Show windows from all workspaces in panel
Reset Defaults

] Reset KDE/Plasma defaults

@ About & Help

MX Tweak

b4 Systray Icon Size | Default b4

@ Close

Figura 3-25: Le facce di MX-Tweak. A destra: Plasma, sinistra: XFCE.

AIUTO: qui.

3.2.24 Formato USB



https://mxlinux.org/wiki/help-files/date-time/
https://mxlinux.org/wiki/help-files/help-mx-tweak

? Format USB + = 0 X

Select Target USB Device sdb  1.9G Flash Disk Generic + | C Refresh drive list

Format fat32 %
File Systern Label USB-DATA
Partition Table Type Defaults .

|:| Show partitions

(| [Show all devices|

© About... | f ? Help @ -+ Next l. x Close

Figura 3-26: 1l formattatore USB é pronto a riformattare con FAT32.

Questo pratico strumento pulisce e riformatta un'unita USB per renderla disponibile per nuovi
scopi.

AIUTO: qui.

3.2.25 Smontaggio USB (solo Xfce)

Questo strumento per smontare rapidamente i supporti USB e ottici si trova nell'area di notifica
quando ¢ abilitato (impostazione predefinita). Con un solo clic vengono visualizzati i supporti
disponibili da smontare con un doppio clic.

Hash_Disk 1.9G Volume Live-usb

. USB3.0 251G Volume 250 GbExt

Double-Click to Unmount | ‘

Figura 3-27: USB Unmounter con un dispositivo evidenziato per lo smontaggio.

AIUTO: qui.

3.2.26 L'applicazione aiuta ad aggiungere, modificare e rimuovere utenti e
gruppi nel sistema.


https://mxlinux.org/wiki/help-files/help-mx-format-usb/
https://www.mxlinux.org/wiki/help-files/help-mx-usb-unmounter

M User Manager

2 = il
Administration | |- Qptions Copysync < Add/Remove Groups | 4 | Group Membership

Add User Account
User login name:
User passwerd;
Confirm user passwond:

] Grant this user administrative rights to the system (sudo)

Change User Password

Select user to modity: none
New user password:

Confirm new password:

Delete User Acoount

Usarto delete: | none

] Delete user home directory

Rename User ACCount

Select user to modif: :msne

Mew user name:

B about. ? Help @ - T x Closs |

Figura 3-28: Gestione utenti, scheda Amministrazione.

AIUTO: qui.

3.2.27 Pacchetti installati dall'utente

Questa applicazione ha lo scopo di facilitare la reinstallazione dei pacchetti che
l'utente ha aggiunto all'installazione predefinita.

Puo visualizzare un elenco di pacchetti installati manualmente dall'utente, che puo
essere salvato in un semplice file di testo. Inoltre, 'applicazione consente di
caricare un elenco salvato di pacchetti per rivederlo e selezionarlo per
reinstallarlo. Questa procedura ¢ particolarmente facile e utile quando si installa

un nuovo sistema.

MX - User Installed Packages

This app is designed to make it easy to reinstall packages that the user has added
to the default installation and retained.

It combines two steps:
1) quickly and easily create a list of those packages

2) use that list in another location to review and reinstall those packages, if still
available

Create a list of user installed packages

Open a previously saved list and install selected packages

| @About ? Help ‘ x Close

Figura 3-29

HELP:: file:///usr/share/user-installed-packages/help.html

3.2.28 Installatore Deb

Questo semplice strumento installa i pacchetti deb (Sezione 5.5.2) scaricati.


https://mxlinux.org/wiki/help-files/help-mx-user-manager

» Fare clic con il pulsante destro del mouse sul pacchetto deb che si desidera installare > "Apri con Deb
Installer".



* Fare clic su Installa. Quando viene richiesto, inserire la password di root.

Deb Installer

The following packages will be installed. Click 'Show Details..." for information about
the packages.

Will install the following:
"fhome/mike/Downloads/refind_0.14.0-1_amdé&4.deb”

Show Details.. | | @ cancel | [ Install l

Figura 3-30

Deb Installer tentera di installare il pacchetto e ne riportera i risultati.

3.2.3 Strumenti deprecati

Alcuni utenti cercano strumenti che non esistono piu o che sono stati incorporati in nuovi
strumenti.

* ATI/AMD Driver Installer: rimosso per mancanza di un candidato driver adatto.

* Broadcom Manager: riscritto per esigenze piu generali come Network Assistant.

» Compton Manager: incorporato in MX Tweak.

* Installatore Debian Backports: incorporato nel programma di installazione dei pacchetti.
* Aspetto predefinito: incorporato in MX Tweak.

* Trova condivisioni di rete: rimosso per problemi di licenza.

* Flash Manager: Adobe® Flash® Player ¢ ormai deprecato ed ¢ stato
completamente rimosso.

* Idevice Mounter: rimosso per mancanza di supporto software.
» Editor di menu: sostituito da MenuLibre.

* Orientamento del pannello: incorporato in MX Tweak.

* Test Repo Installer: incorporato nel Package Installer .

¢ (Gdebi: lo strumento Deb Installer MX lo ha sostituito.



3.3 Display

3.3.1 Risoluzione del display

Display

Configure screen settings and layout

Display Configuration — System Settings

« Display and Monitor

General Advanced
L

|Laptop ~| u NI o samsung Electric Company 5220300

Resolution: MEZDxmsn 'I (192001080)

Refresh rate: }60.0 Hz v|

Rotation: ; None e |

Reflection: | None M

Resolution: 1920x1080 [16:]

Global scak; 100%
Save displays’ properties; ) For any display arangement

1 H Help ‘ x Close

Far anly this specfic display arrangemen

# Highiight thanged Sattings

Figura 3-31: Utilita di visualizzazione. Sinistra: Xfce, destra: KDE/Plasma.

La risoluzione si riferisce al numero fisico di colonne e righe di pixel che creano il display (ad
esempio, 1920x1200). Nella maggior parte dei casi, la risoluzione viene impostata correttamente
dal kernel durante 1'installazione o quando si collega un nuovo monitor. In caso contrario, €
possibile modificarla nei seguenti modi:

» Xfce: fare clic su Menu Start > Impostazioni > Schermo. Utilizzare 1 menu a discesa
per impostare 1 valori corretti per il monitor che si desidera regolare. Per ulteriori
opzioni e un controllo piu preciso, installare xrandr dai repo.

* KDE: Menu Start > Impostazioni di sistema > Schermo e monitor > Configurazione dello schermo.

» Il display di Xfce consente di scalare in modo frazionario per i monitor HiDPI. Fare
clic sul menu a tendina "Scala" e selezionare Personalizzato.

* In situazioni difficili, ¢ possibile modificare manualmente il file di configurazione
/ete/X11/xorg.conf. Potrebbe non esistere, quindi potrebbe essere necessario crearlo
prima. Eseguire sempre un backup del file prima di modificarlo e consultare il forum
per informazioni sull'uso del file.

3.3.2 Driver grafici

Se non si ¢ soddisfatti delle prestazioni dello schermo, potrebbe essere necessario aggiornare il
driver grafico (assicurarsi di eseguire prima un backup del file /etc/X11/xorg.conf, se
utilizzato). Si noti che dopo un aggiornamento del kernel potrebbe essere necessario ripetere
questa operazione, si veda la Sezione 7.6.3.

Esistono vari metodi per farlo.

* Per la maggior parte delle schede Nvidia, il metodo di gran lunga piu semplice &


https://xorg-team.pages.debian.net/xorg/howto/use-xrandr.html
https://wiki.debian.org/Xorg#What_if_I_do_not_have_a_xorg_config_file.3F

quello di utilizzare gli installatori accessibili dalla dashboard di MX Tools
(vedere Sezione 3.2).



* Alcune schede video piu vecchie o meno comuni richiedono driver (come
openchrome, mach64 e fbdev) che sono facilmente installabili solo con sgfxi
(Sezione 6.5.3).

* Alcune schede Nvidia non sono piu supportate da Debian Stable ("Jessie"), si
veda la Wiki MX/antiX. Sono tuttavia supportate dai driver nouveau e vesa.

+ E possibile installare il pacchetto nvidia-settings per uno strumento grafico
che puo essere utilizzato per modificare le impostazioni come root con il
comando: nvidia-settings

* Consultare il Wiki Debian sui driver open-source per ati, radeon e amdgpu. Si noti
che i driver aperti per AMD non sono piu disponibili.

» E anche possibile, ma piu complicato, scaricare direttamente dal produttore. Questo
metodo richiede di selezionare e scaricare il driver corretto per il proprio sistema; per

informazioni sul sistema, aprire un terminale e digitare: inxi -Gxx.

Ecco 1 siti web dei driver per i marchi piu diffusi (per gli altri fate una ricerca sul web su
"<nome> driver linux"):

* Nvidia
* Intel

I driver Intel devono essere compilati, ma i driver Nvidia scaricati sono facilmente installabili:
* Navigare in Thunar fino alla cartella in cui ¢ stato scaricato il driver.

* Fare clic con il tasto destro del mouse sul file, selezionare la scheda Autorizzazioni e
selezionare Is executable.

* Premere CTRL-ALT-F1 per uscire da X (I'ambiente grafico) e
accedere al prompt del terminale.

* Accedere come root.

* Tipo: servizio lightdm stop.

» Digitare: sh <nomefile>.run (assicurarsi di utilizzare il nome effettivo del file).

* Consentire al driver NVIDIA di disattivare il kernel nouveau.

* Al termine, digitare: service lightdm start per avviare nuovamente lightdm e xorg.

* Un'altra importante opzione di driver ¢ MESA, un'implementazione open-source


https://mxlinux.org/wiki/hardware/unsupported-nvidia-gpus
https://en.wikipedia.org/wiki/Nouveau_(software)
https://wiki.debian.org/AtiHowTo
http://www.nvidia.com/Download/index.aspx
https://www.intel.com/content/www/us/en/download-center/home.html
https://mxlinux.org/wiki/applications-system/compiling-software

della specifica OpenGL, un sistema per il rendering della grafica 3D interattiva. Gli
utenti di sistemi ad alta


http://www.opengl.org/

Le macchine ad alte prestazioni riferiscono che l'aggiornamento porta una significativa
stabilizzazione del sistema.

» Una versione piu recente potrebbe essere disponibile nel Repo di prova; per
ottenerla, usare 'MX Package Installer (Sezione 3.2). Deselezionare la casella
che nasconde i pacchetti lib e dev, cercare "MESA" e selezionare i pacchetti
aggiornabili per l'installazione.

* Le schede grafiche ibride combinano due adattatori grafici sulla stessa unita. Un
esempio popolare ¢ I'NVidia Optimus, che ¢ supportato su Linux con Bumblee. Le

schede grafiche piu recenti possono anche utilizzare le funzioni primus incorporate
nel driver nvidia senza il sistema bumblee. Per eseguire un'applicazione con le
funzioni primus, utilizzare "nvidia-run-mx APP" per avviare un'applicazione con
l'accelerazione grafica abilitata.

3.3.3 Caratteri
Regolazione di base

1. XFCE- Fare clic sul menu Start > Tutte le impostazioni > Aspetto, scheda Caratteri.
2. KDE/Plasma - Fare clic sul menu Start > Impostazioni di sistema > Aspetto > Caratteri.
3. Fare clic sul menu a discesa per visualizzare 1'elenco dei font e delle dimensioni dei punti.

4. Selezionare quella desiderata e fare clic su OK.

Regolazioni avanzate

1. Sono disponibili diverse opzioni eseguendo in un terminale root: dpkg-
reconfigure fontconfig-config

2. Le singole applicazioni possono avere i propri controlli, spesso presenti in
Modifica (o Strumenti) > Preferenze.

3. Per ulteriori regolazioni, consultare il Wiki MX/antiX.

4. 1 display ad alta risoluzione hanno esigenze particolari, vedere il Wiki MX/antiX.



https://en.wikipedia.org/wiki/Nvidia_Optimus
https://www.mxlinux.org/wiki/system/font-adjustment
https://mxlinux.org/wiki/other/high-resolution-displays

Aggiunta di font

1. Ci sono alcuni pacchetti di font in MX Package Installer disponibili con un solo clic.
Per ulteriori possibilita, fare clic su (Xfce) Menu Start > Sistema > Synaptic Package
Manager; KDE: usare Discover invece di Synaptic.

2. Utilizzate la funzione di ricerca dei font.

3. Selezionare e scaricare quelli desiderati. Il pacchetto Microsoft (Core) Fonts ttf-
mscorefonts-installer in MX Package Installer fornisce una facile installazione dei
Microsoft True Type Core Fonts da utilizzare con i siti web e le applicazioni MS
che girano sotto Wine.

4. Estrarre se necessario, quindi copiare come root (piu facilmente in un Thunar root) la cartella dei font in
/usr/share/fonts/.

5. I nuovi caratteri dovrebbero essere disponibili in (Xfce) il menu a discesa in Tutte le
impostazioni > Aspetto, scheda Caratteri o (KDE) Menu di avvio > Impostazioni di
sistema > Aspetto > Caratteri.

3.3.4 Doppio monitor

I monitor multipli sono gestiti in MX Linux Xfce con il menu Start > Impostazioni > Display. E
possibile utilizzarlo per regolare la risoluzione, selezionare se uno clona l'altro, quali monitor
saranno accesi, ecc. Spesso ¢ necessario uscire e rientrare per vedere il display selezionato. Si
consiglia di consultare anche la scheda Display di MX Tweak. Un controllo piu preciso di
alcune caratteristiche ¢ talvolta disponibile con xrandr.

Xfce 4.18 ha migliorato notevolmente la gestione dei monitor multipli, con impostazioni nella
scheda Avanzate di Display che consentono impostazioni dettagliate per ogni monitor e la
possibilita di salvare i profili dei monitor e di utilizzarli automaticamente quando lo stesso
hardware viene nuovamente collegato. Se i problemi persistono, cercate nel Forum Xfce, nel
Forum MX Linux e nel WIki MX/antiX se avete problemi insoliti.

In KDE/Plasma i doppi monitor vengono impostati con lo Strumento di configurazione del display.

Collegamenti

Documenti Xfce: Display



https://forum.xfce.org/
https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff
https://docs.xfce.org/xfce/xfce4-settings/4.14/display

3.3.5 Gestione dell'alimentazione

Fare clic sull'icona dei plugin di Power Manager nel Pannello. Qui si puo facilmente passare
alla modalita Presentazione (Xfce), oppure andare alle Impostazioni per impostare quando uno
schermo si spegne, quando il computer va in sospensione, 1'azione avviata dalla chiusura del
coperchio di un portatile, la luminosita, ecc. Su un computer portatile, vengono visualizzati lo
stato della batteria e le informazioni, ed ¢ disponibile un cursore per la luminosita.

3.3.6 Regolazione del monitor

Sono disponibili diversi strumenti per regolare la visualizzazione per determinati monitor.

* La luminosita dello schermo puo essere impostata (solo per Xfce) con il menu Start >
Impostazioni > Power Manager, scheda Display; MX Tweak o MX Brightness Systray
che inserisce un pratico widget nel Systray.

* Per gli utenti con Nvidia, utilizzare nvidia-settings come root per regolare con precisione la
visualizzazione.

* Per modificare la gamma (contrasto), aprire un terminale e digitare:
xgamma -gamma 1.0

1.0 ¢ il livello normale; modificarlo in aumento o in diminuzione per diminuire/aumentare il contrasto.

* L'adattamento del colore del display all'ora del giorno puo essere controllato con
fluxgui o Redshift.

* Perregolazioni piu avanzate e creazione di profili, installare displaycal.

 E possibile creare profili colore (solo Xfce): Start > Impostazioni > Profili colore.
Un profilo di colore ¢ un insieme di dati che caratterizzano un dispositivo di input

o di output del colore e la maggior parte di essi deriva dai profili ICC.
(= e .- - 0]

Color Profilas
Configure color profiles for your devices

Mioded:  Uinbnowm
= vendor: Unknown
& ocenericcursror. ) -

Colorspace: rgb

@ Officejet Pro BG0O Frinter

HHelp ® Close

Figura 3-32: Preparazione all'aggiunta di un profilo colore.

AIUTO: qui.


https://en.wikipedia.org/wiki/Gamma_correction
https://justgetflux.com/linux.html
http://jonls.dk/redshift/
https://displaycal.net/
https://en.wikipedia.org/wiki/ICC_profile
https://docs.xfce.org/xfce/xfce4-settings/4.16/display

3.3.7 Strappo dello schermo

Lo screen tearing ¢ un artefatto visivo nella visualizzazione video in cui un dispositivo di
visualizzazione mostra informazioni da piu fotogrammi in un'unica schermata (Wikipedia). Il
fenomeno tende a variare notevolmente in base a fattori quali I'hardware grafico, la particolare
applicazione e la sensibilita dell'utente.

In MX Linux sono disponibili diverse soluzioni:

» Fare clic sulla scheda Compositore in MX Tweak e utilizzare il menu a discesa per
passare da xfwm predefinito a Compton, un compositore indipendente.

» Utilizzare il menu a discesa per modificare la spaziatura verticale (vblank).

* Quando viene rilevato un driver grafico Intel, nella scheda MX Tweak > Config Options
¢ disponibile una casella di controllo che allontana il sistema dal "modesetting"
predefinito, un interruttore che attiva I'opzione TearFree del driver Intel. Le opzioni
Tearfree esistono anche per nouveau, radeon e amdgpu e vengono visualizzate a seconda
dei casi.

Collegamenti
e Wiki MX/antiX

3.4 Rete

Le connessioni a Internet sono gestite da Network Manager:

--Fare clic con il tasto sinistro del mouse sull'applet nell'area di notifica di Systray per visualizzare lo stato, la
connessione e le opzioni di esplorazione.

--Fare clic con il tasto destro del mouse sull'applet > Modifica connessioni per aprire una finestra
di impostazioni con cinque schede. KDE: facendo clic con il tasto destro si aprira Configura
connessioni di rete. Fare clic su di esso per aprire la casella delle impostazioni.

» Cablato. Nella maggior parte delle situazioni non ¢ necessario prestare attenzione; per
le configurazioni speciali, evidenziare e fare clic sul pulsante Modifica.

* Senza fili

* Network Manager di solito rileva automaticamente la scheda di rete e la
utilizza per trovare i punti di accesso disponibili.

* Per i dettagli, vedere la sezione 3.4.2.

* Banda larga mobile (solo Xfce). Questa scheda consente di utilizzare un dispositivo
mobile 3G/4G per accedere al web. Fare clic sul pulsante Aggiungi per configurare.


https://docs.xfce.org/xfce/xfwm4/start
https://en.wikipedia.org/wiki/Compositing
https://mxlinux.org/wiki/hardware/screen-tearing

* VPN. Fare clic sul pulsante Aggiungi per eseguire la configurazione. In caso di
problemi di configurazione, consultare il Wiki MX/antiX.



https://mxlinux.org/wiki/networking/vpn

» DSL (solo Xfce). Fare clic sul pulsante Aggiungi per configurare.

ALTRO: Wiki Ubuntu: Gestore di rete

3.4.1 Accesso via cavo

In genere MX Linux rileva l'accesso a Internet via cavo all'avvio senza problemi. Se ¢
necessario un driver Broadcom (raro), utilizzare MX Network Assistant (Sezione 3.2).

Ethernet e cavo

MX Linux viene fornito preconfigurato per una LAN (Local Area Network) standard che utilizza
il protocollo DHCP (Dynamic Host Configuration Protocol) per assegnare gli indirizzi IP e la
risoluzione DNS (Domain Name System). Nella maggior parte dei casi funziona cosi com'¢. E
possibile modificare la configurazione con Network Manager (KDE: Interfacce di rete).

Quando si avvia MX Linux, agli adattatori di rete viene assegnato un nome di interfaccia breve
da udev, il gestore di dispositivi del kernel. Per i normali adattatori cablati questo ¢ solitamente
ethO (con i successivi ethl, eth2, eth3, ecc.). Gli adattatori USB vengono spesso visualizzati
sull'interfaccia ethO in MX Linux, ma il nome dell'interfaccia pud anche dipendere dal chipset
dell'adattatore. Ad esempio, le schede Atheros vengono spesso visualizzate come athO, mentre
gli adattatori usb ralink possono essere rausb0. Per un elenco dettagliato di tutte le interfacce di
rete trovate, aprire un terminale, diventare root e digitare: ifp -a.

E consigliabile collegarsi a Internet tramite un router, poiché quasi tutti i router cablati
contengono firewall opzionali. Inoltre, 1 router utilizzano il NAT (Network Address Translation)
per tradurre i grandi indirizzi Internet in indirizzi [P locali. Questo offre un ulteriore livello di
protezione. Se ci si collega al router direttamente o tramite un hub o uno switch, la macchina si
autoconfigura tramite DHCP.

ADSL o PPPoE (solo Xfce)

Se si utilizza ADSL o PPPoE, la connessione a Internet € facile in MX Linux. Fare clic con il
tasto destro del mouse sull'icona Network Manager, quindi sulla scheda DSL. Fare clic sul
pulsante Aggiungi... e compilare le informazioni richieste, selezionando se si desidera la
connessione automatica.

NOTA: se si verificano problemi durante la connessione di un dispositivo USB, collegare
l'unita al computer, aprire un terminale e digitare:

dmesg | tail

Pubblicare I'output sul forum MX Linux per ottenere aiuto nella ricerca del driver necessario.


https://help.ubuntu.com/community/NetworkManager

[ | Editing DSL connection 1 [T+E X

Connection name:

General |DSL| Ethernet | PPP Settings | IPv4 Settings

Username:

Service:

Password:

Show password

@Cancel Save

Figura 3-33: Impostazione del servizio DSL.

Internet in Dial-Up

Nella scheda Dispositivo € necessario impostare le informazioni seriali. Accettare il valore predefinito
/dev/modem puo funzionare, ma potrebbe essere necessario provare un'altra interfaccia. Questi
sono gli equivalenti Linux delle porte COM in Windows:

Tabella 3: equivalenti Linux per le porte COM.

Porto | Equivalente
COM1 | /dev/ttySO
COM 2 | /dev/ttyS1
COM 3 | /dev/ttyS2
COM 4 | /dev/ttyS3

3.4.2 Accesso wireless.

MX Linux ¢ preconfigurato per rilevare automaticamente una scheda WiFi e nella maggior
parte dei casi la scheda viene trovata e configurata automaticamente.

Un driver nativo viene solitamente fornito come parte del kernel Linux (esempio: ipw3945 per
Intel), ma su alcune macchine, soprattutto quelle piu recenti, potrebbe essere necessario scaricare
un driver utilizzando le informazioni contenute in Informazioni rapide sul sistema > Rete.

A volte sono disponibili piu driver. E possibile che vogliate confrontarli per velocita e
connettivita e che dobbiate inserire nella lista nera o rimuovere quello che non utilizzate per
evitare un conflitto. Le schede wireless possono essere interne o esterne. [ modem USB (dongle
wireless) di solito vengono visualizzati nell'interfaccia wlan, ma se non lo sono, controllare gli



altri nell'elenco.



NOTA: Il metodo corretto varia a seconda degli utenti a causa delle complicate interazioni tra
il kernel Linux, gli strumenti wireless e il chipset della scheda wireless locale e il router.

Passi base per il wireless

Fare clic sul menu Start > Impostazioni > Connessioni di rete (KDE: Menu Start >
Connessioni), oppure fare semplicemente clic sull'icona Network Manager nell'area di notifica),
quindi sulla scheda Wireless. Si presentera una delle tre situazioni.

-E stata trovata una rete wireless.
* Fare clic sul nome della rete per utilizzarla.
» Fare clic con il tasto destro del mouse sull'icona per accedere ad altre opzioni.
* Al termine, fare clic su OK.
-La rete trovata non funziona.

Se le reti wireless vengono viste ma il computer non riesce a connettersi, significa che 1) la
scheda wireless ¢ gestita correttamente dal driver giusto, ma ci sono problemi di connessione al
modem/router, al firewall, al provider, al DNS e cosi via; oppure 2) la scheda wireless ¢ gestita
in modo anomalo perché il driver non ¢ il piu adatto per quella scheda o ci sono problemi di
conflitto con un altro driver. In questo caso ¢ necessario raccogliere informazioni sulla scheda
wireless per verificare se i driver della scheda possono avere problemi e quindi provare a testare
la rete con un set di strumenti diagnostici.

* Le informazioni di base si ottengono aprendo un terminale e inserendo un dato alla volta:
inxi -n
Isusb | grep -i
net Ispci | grep -i
net E come root:
iwconfig
L'output di questi comandi fornisce il nome, il modello e la versione (se presente) della scheda
wireless (esempio sotto), nonché il driver associato e l'indirizzo mac della scheda wireless.

L'output del quarto comando fornisce il nome dell'Access Point (AP) a cui si € collegati e altre
informazioni sulla connessione. Ad esempio:



Rete

Scheda-2: Scheda di rete wireless Qualcomm Atheros AR9462 driver:

ath9k IF: wlan0O stato: attivo mac: 00:21:6a:81:8c:5a

A volte ¢ necessario il numero MAC del chipset oltre a quello della scheda wireless. I1 modo
piu semplice per farlo ¢ fare clic sul menu Start > Sistema > MX Network Assistant, scheda
Introduzione. Ad esempio:

Scheda di rete wireless Qualcomm Atheros AR9485 [168c:0032] (rev. 01)

Il numero tra parentesi identifica il tipo di chipset della scheda wireless. I numeri prima dei due
punti identificano il produttore, quelli dopo il prodotto.

Utilizzate le informazioni raccolte in uno dei seguenti modi:

» Effettuare una ricerca sul Web utilizzando queste informazioni. Alcuni esempi che utilizzano 1'output
di Ispci di cui sopra.

linux Qualcomm Atheros AR9462
linux 168c:0032
debian stable 0x168c 0x0034
* Consultare i siti Linux Wireless e Linux Wireless LAN Support per scoprire
di quale driver ha bisogno il vostro chipset, quali conflitti potrebbero esserci
e se ha bisogno di un firmware installato separatamente. Pubblicare le
informazioni sul forum MX Linux e chiedere aiuto.

» Disattivare il Firewall, se presente, finché non si verifica il collegamento
tra il computer e il router.

e Provare a riavviare il router.

» Utilizzare la sezione diagnostica di MX Network Assistant per eseguire il
Ping del router utilizzando l'indirizzo MAC, il Ping di un sito Web come
Google o il traceroute. Se ¢ possibile eseguire il Ping di un sito utilizzando il
suo IP (ottenuto da una ricerca sul web) ma non ¢ possibile raggiungerlo con
il suo nome di dominio, allora il problema potrebbe essere nella
configurazione del DNS. Se non sapete come interpretare 1 risultati di Ping e
traceroute, fate una ricerca sul web o pubblicate i risultati sul forum MX
Linux.

* A volte l'uso dell'applicazione terminale Ceni (nei repo) puo rivelare punti di
accesso nascosti e altri fattori difficili. NOTA: I'uso di Ceni per configurare
l'interfaccia di rete in MX Linux interferira e/o disabilitera la gestione di tale
interfaccia da parte del Network Manager predefinito. Ceni memorizza le
informazioni di configurazione in /etc/network/interfaces. Qualsiasi interfaccia
definita in /etc/network/interfaces sara ignorata da Network Manager, poiché
quest'ultimo presume che, se esiste una definizione, sia un'altra applicazione a
gestire il dispositivo.


https://en.wikipedia.org/wiki/Traceroute

-Non ¢ stata trovata alcuna interfaccia wireless.



* Aprire un terminale e digitare 1 4 comandi elencati all'inizio della sezione
precedente. Identificare la scheda, il chipset e il driver necessari effettuando una
ricerca sul web e consultando 1 siti segnalati, secondo la procedura descritta
sopra.

» Cercate la voce relativa alla rete e prendete nota delle informazioni
dettagliate sul vostro hardware specifico, quindi cercate ulteriori informazioni
sul sito LinuxWireless elencato di seguito o chiedete sul forum.

» Se si dispone di un dispositivo wifi esterno € non vengono trovate
informazioni su una scheda di rete, scollegare il dispositivo, attendere
qualche secondo e ricollegarlo. Aprire un terminale e inserire:

dmesg | tail
Esaminare 1'output per trovare informazioni sul dispositivo (come l'indirizzo
mac) che possono essere utilizzate per risolvere il problema sul web o sul forum

di MX Linux.

* Un esempio comune di questa situazione ¢ rappresentato dai chipset
wireless Broadcom,; si veda il Wiki MX/antiX.

Firmware

Per alcune schede ¢ necessario installare il firmware (ad esempio, firmware-ti-connectivity per
Texas Instruments WL1251). MX Linux viene fornito con una buona quantita di firmware gia
disponibili, installati o nei repo, ma potrebbe essere necessario rintracciare la propria esigenza
particolare o controllare il forum di supporto di MX linux.

Sicurezza

La sicurezza wireless ¢ gestita da Network Manager. Ecco 1 passi fondamentali da seguire (i
passi sono simili in KDE, con piccole differenze terminologiche e di posizione che sono ovvie):

* Fare clic con il tasto destro del mouse sull'icona Network Manager nell'area di
notifica > Modifica connessioni (KDE: Configura connessioni di rete).

» Fare clic sulla scheda Wireless ed evidenziare il nome del punto di accesso a cui
ci si vuole collegare (ad esempio, "linksys" o "starbucks 2345").

» Fare clic sul pulsante Modifica e quindi sulla scheda Sicurezza wireless.

« Utilizzare il menu a discesa per selezionare la sicurezza desiderata (ad esempio: WPA
e WPA?2 Personal).


https://mxlinux.org/wiki/hardware-networking/broadcom-wireless

* Inserire la password e fare clic su Salva.

- Editing WIi-Fi connection 1 + 4+ X Edit your Network Connections
Connection name: |Wi-Fi connection 1 Connection name: | leonidas
Wired Ethernet
. —— . N . = . = General configuration | Wi-Fi | Wi-FiSecurity  IPva
General Wi-Fi \Wi-Fi Security | IPv4 Settings  IPv6 Settings ] Weed conoection
Last used 2 hours ago SSID: | & leonidas
. N bt Mode: | Infrastructure
Security: WEP 128-bit Passphrase - | S
% connected BSSID:
Key: Oz N o o 27085
Show kE)" Cloned MAC address: | _:_:_:_:_:
U
WEP index: 1 (Default) A visiitty: (] piddon network
Authentication: | Open System -
s
® Cancel Save
B o

Figura 3-34: Sicurezza wireless in Network Manager (sinistra: Xfce, destra: KDE/Plasma).

E ugualmente possibile utilizzare Ceni per gestire la sicurezza wireless, purché successivamente
non si utilizzi Network Manager, con il quale interferisce.

Collegamenti

e Linux senza fili

» Supporto LAN wireless Linux

e Wiki Debian: Wifi

e Arch Wiki: Senza fili

3.4.3 Banda larga mobile

Per l'accesso a Internet senza fili con un modem 3G/4G, consultare le pagine 3G di Debian
Wiki collegate qui sotto per informazioni sulla compatibilita. Molti modem 3G/4G vengono
riconosciuti su MX Linux da Network Manager.

3.4.4 Tethering

I1 tethering si riferisce all'uso di un dispositivo come un telefono cellulare o un HotSpot WiFi
mobile per fornire accesso a Internet mobile ad altri dispositivi, come un computer portatile. E
necessario creare un "HotSpot" sul dispositivo con accesso all'altro dispositivo. E facile
configurare un telefono Android come HotSpot

Random..

Automatic


https://wireless.wiki.kernel.org/
http://linux-wless.passys.nl/
http://wiki.debian.org/WiFi
https://wiki.archlinux.org/index.php/Wireless

: Impostazioni > Connessioni > Hotspot mobile e Tethering > Hotspot mobile. Per rendere il
portatile 'Hotspot, consultate questo video.

Risoluzione dei problemi

Su alcuni sistemi, le connessioni via modem falliscono a causa dell'aggiornamento dei pacchetti
udev e libudevl. Per risolvere il problema, aprire Synaptic, evidenziare i pacchetti e fare clic
su Pacchetto>Forza versione.... Utilizzate il menu a discesa per passare a una versione inferiore
e fate clic sull'icona Applica.

In alcuni casi questa soluzione non ha funzionato in modo coerente, ma gli utenti hanno
scoperto che la rimozione completa di Network Manager ha risolto i problemi.

ALTRO: Wiki Debian: Modem 3G

3.4.5 [Utilita a riga di comando

Le utilita della riga di comando sono utili per visualizzare informazioni dettagliate e sono anche
comunemente utilizzate per la risoluzione dei problemi. La documentazione dettagliata ¢
disponibile nelle pagine man. Quelle pit comuni che seguono devono essere eseguite come root.

Tabella 4: Servizi di pubblica utilita senza fili.

Comando Commento
ip Utilita di configurazione principale per le interfacce di rete.
ifup <interfaccia> Visualizza l'interfaccia specificata. Ad esempio:
ifup eth0 fara apparire la porta ethernet ethQ
ifdown L'opposto di ifup
<interfaccia>
iwconfig Utilita di connessione alla rete wireless. Utilizzata da sola, visualizza

lo stato della rete wireless. Puo essere applicata a un'interfaccia
specifica, ad esempio per selezionare un particolare punto di accesso.

rfkill Disabilita il softblock per le interfacce di rete wireless (ad
esempio, wlan).

depmod -a Esamina tutti 1 moduli e, se sono cambiati, abilita la nuova
configurazione.

3.4.5 DNS statico

A volte ¢ auspicabile cambiare la configurazione di Internet da quella automatica predefinita del
DNS (Dynamic Name Service) a una statica manuale. I motivi per farlo possono essere una
maggiore stabilita, una migliore velocita, il controllo parentale, ecc. Tale modifica puo essere
effettuata per l'intero sistema o per singoli dispositivi. In entrambi i casi, prima di iniziare,
procurarsi le impostazioni DNS statiche che si intende utilizzare da OpenDNS, Google Public
DNS, ecc.


https://www.youtube.com/watch?v=WeKcWTQc7mY&feature=youtu.be
http://wiki.debian.org/Modem/3G
https://en.wikipedia.org/wiki/Domain_Name_System

DNS a livello di sistema

E possibile effettuare la modifica per tutti gli utenti del router utilizzando un browser. Sono necessari:
* 1'URL del router (elencarlo qui se lo si ¢ dimenticato).
* la sua password, se ¢ stata impostata.

Individuare e modificare il pannello di configurazione del router, seguendo le indicazioni
relative al router in questione (elenco delle guide qui).

DNS individuale

Per la modifica di un singolo utente, ¢ possibile utilizzare Network Manager.

* Fare clic con il tasto destro del mouse sull'icona della connessione nell'area di notifica > Modifica
connessioni...

* Evidenziare la connessione e fare clic sul pulsante Modifica.

» Nella scheda IPv4, utilizzare il menu a discesa per modificare il metodo in
"Solo indirizzi automatici (DHCP)".

* Nella casella "Server DNS" inserire le impostazioni DNS statiche che si intende utilizzare.

» Fare clic su Salva per uscire.

3.5 Gestione dei file

La gestione dei file in MX Linux avviene tramite Thunar su Xfce e Dolphin su KDE / Plasma.
Gran parte del loro utilizzo di base ¢ evidente, ma ecco alcune cose da sapere:

« [ file nascosti non sono visibili per impostazione predefinita, ma possono essere resi
visibili tramite il menu (Visualizza > Mostra file nascosti); oppure premendo Ctrl-H.

* Il riquadro laterale puo essere nascosto e i collegamenti alle directory (cartelle)
possono essere inseriti facendo clic con il pulsante destro del mouse > Invia a
(KDE: Aggiungi a posizioni) o trascinandoli.

* Il menu contestuale ¢ stato popolato con procedure comuni ("Azioni personalizzate"
su Xfce e "Azioni" e "Azioni radice" su KDE / Plasma) che variano a seconda di cio

che ¢ presente o sotto il fuoco.

* L'azione di root ¢ disponibile tramite il menu contestuale per aprire un terminale,


http://www.techspot.com/guides/287-default-router-ip-addresses/
https://support.opendns.com/forums/21618374

modificare come root o aprire un'istanza di File Manager con privilegi di root.



* I File Manager gestiscono facilmente i trasferimenti FTP, vedi sotto.

» Le azioni personalizzate aumentano notevolmente la potenza e 1'utilita dei File

Manager. MX Linux viene fornito con molte azioni preinstallate, ma ve ne sono

altre che possono essere copiate e che I'utente puo creare per le proprie esigenze.
Vedere Suggerimenti e trucchi (Sezione 3.5.1), piu avanti; e il Wiki MX/antiX.

Custom Actions

Dolphin Preferences — Dolphin

You can configure custom actions that will appear in the file

managers context menus for certain kinds of files.

Check the
samples.

Run command ...

Launch a program

Open Terminal Here

for a collection of custom action

Launch terminal emulator here

Open root Thunar here

COpen this lolder wilth administrative rights

Edit as Root

Make adrministrative chamn

Find files here
Search current Molder

Create symlink

yges to text files

Softink between owao files or directories

Compute sha/mdSsum
I:li'\.;:-l.:!,- checksum al [50

Check data integricy

Compare 50 and hash files

Close

General

w

Startup
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View Modes
Navigation

-

Services

LI

Trash

Defaults

Services

select which services should be shown in the context menu:
[M] & Root Actions: Change Permissions

(] § Root Actions: Compress.

(W] [B Root Actions: Copy

(M) T Root Actions: Delete

[m] @ Root Actions: Open File Manager Here

Bl Root Actions: Open Terminal Here

Bl Root Actions: Open Terminal Here

(L] Root Actions: Open as Text

(M) @ Root Actions: Open in File Manager
(M) & Root Actions: Open with ...

[M] 2= Root Actions: Ownership to ...

[M] @ Root Actions: Ownership to Active User
(M) ¥ Root Actions: Ownership to Root
(W § 'Compress' service menu

[] [® 'Copy To' and 'Move To' commands
W) § ‘Extract service menu

[M] & Create Audic CD with K3b

(M) & Create Video CD with K3b

[M] & Create file project with K3b

[] £ pelete

(W] & Encrypt File

(=] Bl File Checksum: MDS

(M) Bl File Checksum: SHA1

(=] Bl File Checksum: SHA256

% Download New Services...

~ OK ~ © Cancel

Figura 3-35: A sinistra: Azioni personalizzate impostate in Thunar. A destra: Servizi personalizzati in
Dolphin.

3.5.1

Suggerimenti e trucchi

Quando si lavora in una directory che richiede i privilegi di superutente, ¢ possibile fare

clic con il pulsante destro del mouse > Apri root Thunar qui (o File > Apri root Thunar

qui) o I'analoga "Azione root" in Dolphin.

I privilegi di superutente possono essere modificati nella scheda MX Tweak > Altro,

utilizzando la password dell'utente (predefinita) o una password amministrativa, se ¢ stata

impostata.

E possibile impostare le schede con File > Nuova scheda (o Ctrl-T), quindi spostare gli

elementi da una posizione all'altra trascinandoli in una scheda e rilasciandola.

E possibile dividere lo schermo e navigare in un'altra directory in uno dei pannelli.

Quindi spostare o copiare i file da uno all'altro.


http://docs.xfce.org/xfce/thunar/custom-actions
https://mxlinux.org/wiki/applications/thunar-custom-actions

* In Xfce 4.18 e versioni successive, ¢ possibile impostare una visualizzazione a schede
multiple per impostazione predefinita; a tale scopo ¢ piu facile utilizzare la scheda
MX Tweak > Config Options.

E possibile assegnare un tasto di scelta rapida da tastiera all'azione personalizzata "Apri il terminale qui".

= Thunar/Xfce

Attivare gli acceleratori modificabili in Tutte le impostazioni > Aspetto > Impostazioni.

* In Thunar, passate il mouse sulla voce di menu File > Apri nel terminale
e premete la combinazione di tasti che desiderate utilizzare per
quell'azione.

* Quindi, quando si naviga in Thunar, utilizzare la combinazione di tasti
per aprire una finestra di terminale nella directory attiva.

* Questo vale anche per altre voci del menu File di Thunar; per esempio,
si puo assegnare Alt-S per creare un collegamento simbolico a un file
evidenziato, ecc.

* Le azioni elencate nel menu contestuale possono essere
modificate/eliminate e ne possono essere aggiunte di nuove facendo
clic su Modifica > Configura azioni personalizzate...

* Dolphin / KDE Plasma: selezionare Impostazioni > Configura scorciatoie da
tastiera e trovare la voce Terminale.

* Sono visibili anche varie opzioni e comandi nascosti, vedi Collegamenti qui sotto.

* Sia Java che Python sono talvolta utilizzati per produrre applicazioni, con il termine
* jar e *.py, rispettivamente. Questi file possono essere aperti con un solo clic, come
qualsiasi altro file; non ¢ piu necessario aprire un terminale, capire qual ¢ il comando,
ecc. ATTENZIONE: fate attenzione ai potenziali problemi di sicurezza.

[ file compressi (zip, tar, gz, xz, ecc.) possono essere gestiti con un clic del tasto destro del mouse sul
file.

e Per trovare 1 file:

--Thunar/Xfce: aprire Thunar e fare clic con il pulsante destro del mouse su
qualsiasi cartella > Trova file qui. Verra visualizzata una finestra di dialogo con
le opzioni disponibili. In esecuzione in background c'¢ Catfish (menu Start >
Accessori > Catfish).

--Dolphin / KDE Plasma: Utilizzare Modifica > Cerca nella barra degli strumenti di Dolphin.



* Link/Symlink



--Thunar/Xfce: Per impostare un soft link (alias link simbolico) - un file che punta
a un altro file o a un'altra directory - fare clic con il tasto destro del mouse sulla
destinazione (file o cartella a cui si desidera che il link punti).

> Crea collegamento simbolico. Quindi trascinare (o fare clic con il pulsante
destro del mouse, tagliare e incollare) il nuovo collegamento simbolico nel punto

desiderato.

--Dolphin / KDE Plasma: Fate clic con il tasto destro del mouse su un punto vuoto
della finestra di Dolphin e utilizzate Crea nuovo > Collegamento di base a un file

0 a una directory.

* Azioni personalizzate Thunar. Si tratta di un potente strumento per espandere le funzioni
del file manager. Per vedere quelle predefinite durante lo sviluppo di MX Linux, fare
clic su Modifica > Configura azioni personalizzate. La finestra di dialogo che si aprira
mostrera cio che ¢ predefinito e dara un'idea di cio che si puo fare da soli. Per creare una
nuova Azione personalizzata, fare clic sul pulsante "+" a destra. I dettagli nel wiki di

MX/antiX.

* Le cartelle possono essere visualizzate con immagini inserendo un'immagine che termina

con *jpg o *.png nella cartella e rinominandola "cartella".
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Figura 3-36: utilizzo di immagini per etichettare le cartelle.

3.5.2 FTP


https://mxlinux.org/wiki/applications/thunar-custom-actions
https://mxlinux.org/wiki/applications/thunar-custom-actions
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Figura 3-37: Utilizzo di Thunar per accedere a un sito FTP.

I1 protocollo di condivisione dei file (FTP) viene utilizzato per trasferire file da un host a un
altro host attraverso una rete.

Xfce FTP

* Aprire Thunar File Manager e fare clic su Sfoglia rete nella parte inferiore del
riquadro sinistro. Quindi fare clic sulla barra degli indirizzi nella parte superiore
del browser (oppure utilizzare Cntrl+L) e fare un backspace per

* Il backspace nel campo dell'indirizzo cancella quello che c'¢ (network:///), quindi
digitate il nome del server con il prefisso ftp://. Ad esempio, per raggiungere la

documentazione MX (se si ha l'autorizzazione) si dovrebbe digitare questo indirizzo:
ftp://mxlinux.org

* Viene visualizzata una finestra di dialogo di autorizzazione. Compilate il nome

utente e la password e lasciate che la password venga salvata, se siete a vostro
agio.

* Ecco fatto. Una volta che si ¢ arrivati alla cartella che si intende utilizzare sempre, ¢
possibile fare clic con il tasto destro del mouse sulla cartella e su Thunar > Invia a >
Riquadro laterale per creare un modo molto semplice di collegarsi.

KDE FTP

e Consultare la base utenti di KDE.

E possibile utilizzare anche applicazioni FTP dedicate, come Filezilla. Per una discussione sul
funzionamento dell'FTP, vedere questa pagina.


https://userbase.kde.org/File_transfers
http://www.ncftp.com/libncftp/doc/ftp_overview.html

3.5.3 Condivisione di file

Esistono diverse possibilita per condividere i file tra computer o tra un computer e un
dispositivo.

» Samba. SAMBA ¢ la soluzione piu completa per condividere file con i computer
Windows in rete senza apportare modifiche ai computer Windows. SAMBA puo
essere utilizzato anche da molti lettori multimediali di rete e dispositivi NAS
(Network-attached storage). SAMBA offre altri servizi per interfacciarsi con le reti
Windows, come 1'autenticazione di dominio, i servizi di messaggistica e la risoluzione
dei nomi NETBIOS. Per i dettagli, vedere di seguito.

« NFS. E il protocollo standard di Unix per la condivisione dei file. Molti ritengono
che sia migliore di Samba per la condivisione dei file e puo essere usato con
macchine Windows (2000 e XP) se si installa "Services for Unix" o un client NFS
di terze parti. Dettagli: vedere MX/antiX Wiki.

* Bluetooth: Per lo scambio di file, installare blueman dai repo, riavviare,
accoppiare il dispositivo, quindi fare clic con il pulsante destro del mouse
sull'icona Bluetooth nell'area di notifica > Invia file al dispositivo.

3.5.4 Azioni (Samba)

File Edit View Go Help

‘ | g= o= Find || Preview| [T split = control
<« A | ® networks// C| < = = =] "
Network
e Name v Sze  Type Date Modified
B8 GORDONDESKTOP Obytes unknown  Unknown SR EiModines
B Fite system o —
[ GORDONLAP Obytes unknown  Unknown Bluetooth
Windows xp tablet a=
Windows Network 0bytes unknown  Unknown
pLACES B, v oevice:
[r—
# sordon E Network
B Deskop .
= 1 Today v BB shared rotders smey
- S =
INETWORK Add Network Folder
+
Browse Network

4 Folders, 1 File (0 B) B — Unknown size

3 items

Figura 3-38: Navigazione delle condivisioni di rete Sinistra: Thunar, destra: Dolphin.

I File Manager possono collegarsi a cartelle condivise (alias Samba Shares) su computer
Windows, Mac, Linux e dispositivi NAS (Network Attached Storage). Per la stampa con
Samba, vedere la Sezione 3.1.2.

* Fare clic su Sfoglia rete nel riquadro di sinistra per visualizzare le varie reti.


https://mxlinux.org/wiki/networking/nfs

* Fare clic sulla rete desiderata per visualizzare i server disponibili. Ora scendete verso
il basso per trovare quello che state cercando.

* Selezionare un server per le condivisioni Samba disponibili
» Selezionate una condivisione Samba per vedere tutte le cartelle disponibili.
* Nella sezione della barra laterale Rete viene creato un collegamento per la condivisione selezionata.

« La navigazione non funziona, soprattutto in Windows. E possibile accedere
direttamente a una condivisione remota utilizzando la barra di localizzazione del File
Manager (Ctrl+L) e usando smb://servername/sharename. Questi luoghi possono
essere inseriti come segnalibri nei riquadri laterali.

3.5.5 Creazione di azioni

Su MX, Samba puo anche essere usato per creare condivisioni a cui altri computer (Windows,
Mac, Linux) possono accedere. La creazione di condivisioni pubbliche con MX Samba Config
¢ abbastanza semplice, ma si tenga presente che la creazione di condivisioni Samba ¢ un'area
complessa dal punto di vista della configurazione.

3.6 Suono

:ﬂ VIDEO: Come abilitare 1'audio HDMI con Linux

L'audio di MX Linux dipende a livello di kernel da Advanced Linux Sound Architecture

(ALSA) e a livello di utente da PulseAudio. Nella maggior parte dei casi l'audio funziona
subito, anche se potrebbe essere necessario qualche piccolo aggiustamento. Fare clic
sull'icona dell'altoparlante per disattivare I'audio, poi di nuovo per ripristinarlo, se le
preferenze sono impostate in questo modo. Posizionare il cursore sull'icona dell'altoparlante
nell'area di notifica e usare la rotella di scorrimento per regolare il volume. Vedere anche le
sezioni 3.6.4, 3.6.5 ¢ 3.8.9.

3.6.1 Configurazione della scheda audio

Se si dispone di piu di una scheda audio, assicurarsi di selezionare quella che si desidera
regolare utilizzando lo strumento MX Seleziona suono (Sezione 3.2). Per configurare la
scheda audio e regolare il volume delle tracce selezionate, fare clic con il tasto destro del
mouse sull'icona dell'altoparlante nell'area di notifica > Apri Mixer. Se i problemi persistono
dopo il logout e il rientro, vedere Risoluzione dei problemi, piu avanti.

3.6.2 Uso simultaneo della carta


https://youtu.be/gjqcmZK5SnE
http://www.freedesktop.org/wiki/Software/PulseAudio/

Puo capitare di voler utilizzare piu di una scheda contemporaneamente; ad esempio, si
potrebbe voler ascoltare la musica sia in cuffia che attraverso gli altoparlanti in un altro luogo.
Questo non ¢ facile da fare in Linux, ma controllate le FAQ di PulseAudio. Inoltre, le
soluzioni presenti in questa pagina Wiki MX/antiX possono funzionare, se si fa attenzione ad
adattare 1 riferimenti delle schede alla propria situazione.



http://www.freedesktop.org/wiki/Software/PulseAudio/FAQ/
https://mxlinux.org/wiki/sound-not-working

A volte ¢ necessario cambiare scheda audio, ad esempio quando una ¢ HDMI e l'altra
analogica. Questo puo essere fatto con la scheda Pulse Audio Volume Control >

Configuration; assicuratevi di selezionare l'opzione Profile che funziona per il vostro
sistema. Per rendere automatico il cambio, consultare lo script su questo sito GitHub.

3.6.3 Risoluzione dei problemi

e Il suono non funziona

* Nessun suono, anche se l'icona dell'altoparlante € presente
nell'area di notifica.

* Provare ad alzare tutti i controlli a un livello superiore. Per un suono di
sistema, ad esempio un login, utilizzare la scheda Riproduzione di
PulseAudio.

* Modificare direttamente il file di configurazione: vedere la
sezione 7.4.

» Nessun suono e nessuna icona dell'altoparlante nell'area di notifica. Potrebbe essere
che la scheda audio sia assente o non riconosciuta, ma il problema piu comune ¢
quello delle schede audio multiple, che affrontiamo qui.

* Soluzione 1: fare clic sul menu Start > Impostazioni > Scheda audio MX
(KDE: Impostazioni di sistema > Hardware > Audio) e seguire la
schermata per selezionare e testare la scheda che si desidera utilizzare.

* Soluzione 2: utilizzare il controllo del volume di PulseAudio (pavucontrol)
per selezionare la scheda audio corretta

e Soluzione 3: accedere al BIOS e disattivare 'HDMI.

* Controllare la matrice della scheda audio ALSA elencata di seguito.

3.6.4 Server audio

Mentre la scheda audio € un elemento hardware accessibile all'utente, il Sound Server € un
software che lavora in gran parte in background. Permette la gestione generale delle schede
audio e consente di eseguire operazioni avanzate sul suono. Il pit usato dai singoli utenti &
PulseAudio. Questo avanzato server audio open-source pud funzionare con diversi sistemi
operativi ed ¢ installato di default. Ha un proprio mixer che permette all'utente di controllare il
volume e la destinazione del segnale sonoro. Per 1'uso professionale, Jack audio ¢ forse il piu
noto.


https://gist.github.com/3v1n0/ad3ad73e0bdd466d7f4a95b3aa376285
https://mxlinux.org/wiki/sound-not-working
http://jackaudio.org/

Audio — System Settings
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Figura 3-39: Utilizzo di PulseAudio Mixer. A sinistra: Pavucontrol A destra: Volume audio di KDE.

3.6.5 Collegamenti

¢ Wiki MX/antiX: Il suono non funziona

 ALSA: Matrice di schede audio

¢ Wiki ArchLinux: Informazioni su PulseAudio

¢ Documentazione di PulseAudio: Desktop gratuito

3.7 Localizzazione

MX Linux ¢ gestito da un team internazionale di sviluppatori che lavora costantemente per
migliorare ed espandere le opzioni di localizzazione. Ci sono molte lingue in cui 1 nostri
documenti non sono ancora stati tradotti; se potete aiutare in questo sforzo, registratevi su
Transifex e/o scrivete sul Forum di traduzione.

3.7.1 Installazione

L'atto principale di localizzazione avviene durante 1'uso di LiveMedium USB.

* Quando viene visualizzata la schermata di avvio, assicurarsi di utilizzare 1 tasti
funzione per impostare le preferenze.

* F2. Selezionare la lingua.

e F3. Selezionare il fuso orario che si desidera utilizzare.


https://mxlinux.org/wiki/sound-not-working
https://wiki.archlinux.org/index.php/PulseAudio
http://www.freedesktop.org/wiki/Software/PulseAudio/Documentation/User/
https://forum.mxlinux.org/viewtopic.php?f=96&t=38671
https://forum.mxlinux.org/viewtopic.php?f=96&t=38671
https://forum.mxlinux.org/viewforum.php?f=96

* Se si dispone di una configurazione complicata o alternativa, ¢ possibile
utilizzare 1 codici di avvio. Ecco un esempio per impostare una tastiera tartara
per il russo: lang=ru kbvar=tt . Un elenco completo dei parametri di avvio
(=codici truffa) ¢ disponibile nella Wiki MX/antiX.

Se 1 valori di localizzazione sono stati impostati nella schermata di avvio, Screen 7
dovrebbe mostrarli durante I'installazione. In caso contrario, o se si desidera
modificarli, selezionare la lingua e il fuso orario desiderati.

Dopo la schermata di avvio sono disponibili altri due metodi.

3.7.2

La prima schermata del programma di installazione consente all'utente di selezionare una particolare
tastiera da utilizzare.

La schermata di accesso presenta dei menu a discesa nell'angolo in alto a destra
in cui ¢ possibile selezionare sia la tastiera che il locale.

Post-installazione

MX Tools include due strumenti per cambiare la tastiera e il locale. Si vedano le precedenti
sezioni 3.2.15 e 3.2.16.

Anche Xfce4 e KDE/Plasma hanno 1 loro metodi:

B e 5 Deices Keyboard Hardware and Layout

ardw

Layours | Advanced

Keyboard modet: | Generic | Generic 101-key PC

B Kobord youseecion |GuEhed £ Touchpod Tumon

Tun
[ Keyboard layout slection v
Selectkeyboard layout and variant Leave unchanged

Figura 3-40: Aggiunta di un altro layout di tastiera Sinistra: XfceDestra : KDE.

Ecco le operazioni di configurazione che si possono eseguire per localizzare MX Linux

dopo l'installazione. Per cambiare la tastiera:

Xfce

* Fare clic su Menu Start > Impostazioni > Tastiera, scheda Layout.

* Deselezionare "Usa le impostazioni predefinite del sistema", quindi fare clic
sul pulsante +Aggiungi in basso e selezionare le tastiere desiderate.


https://mxlinux.org/wiki/system/boot-parameters

» Uscire, quindi fare clic su Keyboard Switcher (bandiera) nell'area di
notifica per selezionare la tastiera attiva.

KDE/Plasma

* Fare clic su Menu Start > Impostazioni > Impostazioni di sistema > Hardware >
Scheda Tastiera> Layout

» Selezionate "Configura layout" al centro della finestra di dialogo, quindi fate clic su +Aggiungi
e selezionare la tastiera o le tastiere desiderate.

» Uscire, quindi fare clic su Keyboard Switcher (bandiera) nell'area di
notifica per selezionare la tastiera attiva.

Ottenere 1 language pack per le principali applicazioni: fare clic sul menu Start >
System > MX Package Installer, fornire la password di root, quindi fare clic su
Language per trovare e installare 1 language pack per le applicazioni utilizzate.

* L'impostazione del cinese semplificato pinyin € un po' pit complicata, vedere qui.

Modificare le impostazioni dell'ora: (Xfce) fare clic su Menu Start > Sistema > MX
Data e ora, (KDE: fare clic con il pulsante destro del mouse sull'ora nel pannello >
Regola data e ora) e selezionare le preferenze. Se si utilizza I'orologio digitale Data e
ora, fare clic con il pulsante destro del mouse > Proprieta per scegliere 12h/24h e altre
impostazioni locali.

Per far si che il correttore ortografico utilizzi la propria lingua: installare il pacchetto
aspell o myspell per la propria lingua (ad esempio, myspell-es).

Ottenere informazioni meteo locali.

* Xfce: fare clic con il pulsante destro del mouse su Pannello > Pannello >
Aggiungi nuovi elementi > Aggiornamento meteo. Fare clic con il pulsante
destro del mouse > Proprieta e impostare il locale che si desidera visualizzare
(in base all'indirizzo IP).

» KDE: Fare clic con il tasto destro del mouse sul desktop o sul pannello, a
seconda di dove apparira il widget, e quindi su Aggiungi widget. Cercare
Meteo e aggiungere il widget

Per la localizzazione di Firefox, Thunderbird o LibreOffice, utilizzare il programma di
installazione dei pacchetti MX >

Lingua per installare il pacchetto appropriato per la lingua di interesse.

Potreste aver bisogno o voler cambiare le informazioni sulla localizzazione (lingua
predefinita, ecc.) disponibili per il sistema. Per farlo, aprire un terminale, diventare


https://mxlinux.org/wiki/other/chinese-simplified-input

root e digitare: dpkg-reconfigure locales



* Verra visualizzato un elenco con tutte le localita che si possono scorrere
utilizzando 1 tasti freccia su e giu.

» Attivate e disattivate cid che volete (o non volete), usando la barra spaziatrice
per far apparire (o scomparire) l'asterisco davanti al locale.

* Al termine, fare clic su OK per passare alla schermata successiva.

» Usare le frecce per selezionare la lingua predefinita che si desidera
utilizzare. Per gli utenti statunitensi, ad esempio, la lingua predefinita sara
en_US.UTF-8.

* Fare clic su OK per salvare e uscire.

ALTRO: Documentazione di Ubuntu

onfiguration

Configuring locales
Many packages in Debian use locales to display text in the correct
language for the user. You can choose a default locale for the system
from the generated locales.

This will select the default language for the entire system. If this
system is a multi-user system where not all users are able to speak the
default language, they will experience difficulties.

Default locale for the system environment:

en_GB.UTF-8 T
en_IE.UTF-8 @
en_NZ.UTF-8 1
en_US -

5 1

<Cancel>

Figura 3-41: Impostazione della lingua predefinita per il sistema installato.

3.7.3 Ulteriori note

+ E possibile cambiare temporaneamente la lingua per una particolare applicazione
immettendo questo codice in un terminale (in questo esempio, per passare allo
spagnolo):

LC AlLL=es ES.UTF8 <comando da lanciare>
Questo funziona per la maggior parte delle applicazioni gia localizzate.

» Se durante l'installazione ¢ stata selezionata una lingua sbagliata, ¢ possibile cambiarla
una volta sul desktop installato, utilizzando MX Locales per correggerla. E anche
possibile aprire un terminale e inserire questo comando:

sudo update-locale LANG=en GB.utf8

Ovviamente ¢ necessario cambiare la lingua in quella che si desidera utilizzare.


https://help.ubuntu.com/community/Locale

* Puo accadere che una singola applicazione non abbia una traduzione nella vostra lingua;
a meno che non si tratti di un'applicazione MX, non possiamo fare nulla al riguardo,
quindi dovreste inviare un messaggio allo sviluppatore.

* Alcuni file del desktop utilizzati per creare il menu Start potrebbero essere privi di un
commento nella vostra lingua, anche se l'applicazione stessa ha una traduzione in quella
lingua; vi preghiamo di comunicarcelo con un post nel sottoforum Traduzione che
fornisca la traduzione corretta.

3.8 Personalizzazione

I moderni desktop Linux, come Xfce e KDE/Plasma, rendono molto semplice
modificare le funzioni di base e 'aspetto della configurazione dell'utente.

* Ma soprattutto, ricordate: Il clic destro ¢ vostro amico!

* Un grande controllo ¢ disponibile attraverso le impostazioni di (Xfce) Tutte le
impostazioni e (KDE/Plasma) Impostazioni, Impostazioni di sistema (icone del
pannello).

* Le modifiche apportate dall'utente vengono memorizzate in file di
configurazione nella directory: ~/.config/. Questi possono essere interrogati in
un terminale, vedere il Wiki MX/antiX.

* La maggior parte dei file di configurazione a livello di

sistema si trova in /etc/skel/ o /etc/xdg/ PIU: Suggerimenti e

trucchi per Xfce (PDF)

3.8.1 Tematizzazione predefinita

La tematizzazione predefinita ¢ controllata da una serie di elementi personalizzati.
Xfce

» La schermata di accesso puo essere modificata con Tutte le impostazioni > Impostazioni di LightDM
GTK+ Greeter.

* Desktop:
* Sfondo: Tutte le impostazioni > Desktop/ oppure fare clic con il pulsante

destro del mouse sul desktop > Impostazioni desktop. Quando si seleziona
da un'altra posizione, tenere presente che dopo aver utilizzato la voce


https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff#List%20configuration%20settings
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf

"Altro" ¢ necessario navigare fino alla cartella desiderata, quindi fare clic su
"Apri"; solo a questo punto ¢ possibile selezionare un file particolare in
quella posizione.

Tutte le impostazioni > Aspetto. Imposta i temi e le icone GTK.
Impostazioni raggruppate in MX Tweak - Temi.



* Tutte le impostazioni > Gestione finestre. Imposta 1 temi dei bordi delle finestre.

KDE/Plasma

* Schermata di accesso (modificare con Impostazioni di sistema > Avvio e
spegnimento, quindi scegliere Schermata di accesso, configurazione SDDM)

* Brezza

* Desktop:

» Sfondo: Fare clic con il tasto destro del mouse sul desktop e
selezionare "Configura desktop e sfondo".

» Aspetto: Fare clic su Menu principale > Impostazioni > Impostazioni di sistema > Aspetto.
1. Temi globali - combinazioni di set di temi in bundle
2. Stile plasma - Imposta il tema degli oggetti del desktop al plasma.
1. Stile dell'applicazione - Configurare gli elementi dell'applicazione

2. Decorazioni della finestra - Stili dei pulsanti di
minimizzazione, massimizzazione € chiusura

3. E inoltre possibile configurare colori, caratteri, icone e cursori.
* Impostazioni del menu dell'applicazione

1. Fare clic con il tasto destro del mouse sull'icona del menu per ottenere
le opzioni di configurazione. Il pannello predefinito ¢ quello
dell'applicazione standard



3.8.3 Pannelli
3.8.3.1 Pannello Xfce
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Figura 3-42: Schermata delle preferenze per la personalizzazione dei pannelli.

MX Linux viene fornito di default con la barra delle applicazioni

Docklike (plugin xfce4-docklike-) che sostituisce i1 pulsanti delle finest
Xfce utilizzati nelle precedenti versioni di MX. Questa barra delle

applicazioni leggera, moderna e minimalista per Xfce offre le stesse S
Properties

funzionalita dei pulsanti delle finestre di Xfce, ma anche funzioni piu -

n n
avanzate di "dock". Move

Remove
Per visualizzare le proprieta della barra delle applicazioni simile a

Panel

quella del dock: Ctrl + clic destro su qualsiasi icona. Oppure: MX
Tweak > scheda Pannello, fare clic sul pulsante "Opzioni" sotto
Docklike.

I pulsanti della finestra possono essere ripristinati facendo clic con

il pulsante destro del i to > P llo >
11 pulSant€ destro dcl mouse su uno spazio vuoto anncllo Figura 3.43- La barra delle

applicazioni simile a un dock
con icone e menu
contestuale.

Aggiungi nuovi elementi.

Trucchi per la personalizzazione dei pannelli:

* Per spostare il pannello, sbloccarlo facendo clic con il pulsante destro del mouse su un pannello >


https://mxlinux.org/wiki/docklike-taskbar/
https://mxlinux.org/wiki/docklike-taskbar/

Pannello > Preferenze pannello.

» Utilizzare MX Tweak per modificare la posizione del pannello: verticale o
orizzontale, superiore o inferiore.



* Per cambiare la modalita di visualizzazione all'interno dell'impostazione
Pannello, selezionare dal menu a discesa: Orizzontale, Verticale o Deskbar.

* Per nascondere automaticamente il pannello, scegliere dal menu a discesa: Mai,
Sempre o Intelligentemente (nasconde il pannello quando una finestra si
sovrappone ad esso).

* Per installare nuovi elementi del pannello, fare clic con il pulsante destro del mouse
su uno spazio vuoto nel pannello > Pannello > Aggiungi nuovi elementi. Sono
disponibili 3 scelte:

* Selezionate una delle voci dell'elenco principale che appare.

* Se ci0 che si desidera non ¢ presente, selezionare Launcher. Una volta
inserito, fare clic con il pulsante destro del mouse > Proprieta, fare clic sul
segno piu e selezionare un elemento dall'elenco visualizzato.

* Se si desidera aggiungere un elemento non presente in nessuno dei due
elenchi, selezionare 1'icona dell'elemento vuoto sotto il segno piu e
compilare la finestra di dialogo visualizzata.

» Le nuove icone vengono visualizzate nella parte inferiore del Pannello verticale;
per spostarle, fare clic con il tasto destro del mouse > Sposta

* Per modificare l'aspetto, 1'orientamento e cosi via, fare clic con il pulsante
destro del mouse sul pannello > Pannello > Preferenze pannello.

» Fare clic con il tasto destro del mouse sul plugin dell'orologio "Date Time" per
modificare il formato del layout, della data o dell'ora. Per un formato orario
personalizzato ¢ necessario utilizzare i codici "strftime" (consultare questa pagina o
aprire un terminale e digitare man strftime).

* Creare una doppia fila di icone nell'area di notifica facendo clic con il pulsante destro
del mouse > Proprieta e diminuendo la dimensione massima delle icone fino a
modificarla.

» Aggiungete o eliminate un pannello in Preferenze pannello, facendo clic sul pulsante
piu 0 meno a destra del menu a discesa del pannello superiore.

* L'installazione del pannello orizzontale con un solo clic ¢ disponibile da MX Tweak (Sezione 3.2).

ALTRO: Documenti di Xfce4: Pannello.

3.8.3.2 Pannello KDE/Plasma


http://en.cppreference.com/w/c/chrono/strftime
http://docs.xfce.org/xfce/xfce4-panel/start
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Figura 3-44: Schermata delle preferenze per la personalizzazione dei pannelli.



Trucchi per la personalizzazione dei pannelli:

* Per spostare il pannello, fare clic con il pulsante destro del mouse sul pannello e
poi su Modifica pannello. Passare il mouse su "Bordo schermo" e spostarlo nella
posizione desiderata.

» Utilizzate MX Tweak per modificare la posizione del pannello: verticale (sinistra),
superiore o inferiore. Oppure utilizzate il metodo precedente per trascinare su
qualsiasi bordo dello schermo.

* Per cambiare la modalita di visualizzazione all'interno del pannello, una volta aperta
la finestra di dialogo Modifica pannello, scegliere Altre opzioni Allineamento
pannello > sinistra, centro o destra.

* Per nascondere automaticamente il pannello, una volta aperta la finestra di dialogo
Modifica pannello, fare clic su "Altre impostazioni" e selezionare "Nascondi
automaticamente".

 Installare nuovi elementi del pannello facendo clic sul pannello >Aggiungi
widget. Dalla finestra di dialogo ¢ possibile selezionare il widget desiderato da
aggiungere.

* Creare una doppia fila di icone nell'area di notifica utilizzando la finestra di dialogo
Configura pannello e selezionando Altezza per modificare l'altezza del pannello.
Quindi, utilizzando MX-Tweak
> scheda Plasma e impostare le dimensioni delle icone della barra delle applicazioni
piti grandi o pill piccole, come desiderato, per creare I'effetto doppia fila. E anche
possibile far si che le icone della barra delle applicazioni scalino automaticamente con
l'altezza del pannello facendo clic con il pulsante destro del mouse sulla freccia verso
l'alto della barra, Configura barra delle applicazioni e abilitando la scala con l'altezza
del pannello.

* Per mostrare tutte le applicazioni aperte, fare clic su Tweak MX, scheda
Plasma e attivare "Mostra finestre da tutti gli spazi di lavoro nel pannello".

3.8.4 Desktop

:]ﬂ VIDEQ: Personalizzazione del desktop
jﬂ VIDEO: Cose da fare dopo l'installazione di

MX Linux



https://www.youtube.com/watch?v=QWVd1-8xpYI
https://youtu.be/aESEb8lTvz4
https://youtu.be/aESEb8lTvz4

Il desktop predefinito (alias sfondo, background) puo essere modificato in vari modi:
» Fare clic con il tasto destro del mouse su qualsiasi immagine > Imposta come sfondo

» Se volete che gli sfondi siano disponibili per tutti gli utenti, diventate root e metteteli nella cartella
cartella /usr/share/backgrounds;



* Se si desidera ripristinare lo sfondo predefinito, questo si trova in
/ust/share/backgrounds/. Ci sono anche dei link simbolici ai set di sfondi MX in
/usr/share/wallpapers per facilitare I'uso di KDE.

Sono disponibili molte altre opzioni di personalizzazione.
* Per cambiare il tema:

» Xfce - Aspetto. Il tema predefinito ¢ un MX mx-comfort (chiaro e scuro) che
ha bordi piu grandi e specifica l'aspetto del menu Whisker. Assicuratevi di
selezionare un tema per le icone che si veda bene, soprattutto nella versione
scura.

« KDE/Plasma - Tema globale - Il tema MX ¢ quello predefinito. E inoltre
possibile impostare singoli elementi del tema in Stile Plasma, Stile
applicazione, Colori, Caratteri, Icone e cursori.

* Se necessario, per rendere 1 bordi sottili piu facili da afferrare:

» Xfce - Utilizzate uno dei temi del gestore di finestre con "bordi spessi" o
consultate la Wiki MX/antiX.

* KDE/Plasma - In Stile applicazione > Decorazioni finestra, impostate la
"Dimensione del bordo" desiderata dal menu a discesa.

» Xfce - Aggiunta di icone standard come Cestino o Casa al desktop nella scheda
Desktop, Icone.

* E possibile personalizzare il comportamento delle finestre, come la commutazione, 1'affiancamento e lo
zoom.

* Xfce - Tweaks del gestore di finestre.

* Il passaggio da una finestra all'altra tramite Alt+Tab puo essere
personalizzato per utilizzare un elenco compatto al posto delle icone
tradizionali.

» Il passaggio da una finestra all'altra tramite Alt+Tab puo anche essere
impostato in modo da mostrare le anteprime al posto delle icone o di un
elenco, ma richiede l'attivazione del compositore, che alcuni computer
piu vecchi potrebbero avere difficolta a supportare. Per attivarlo,
deselezionare prima Ciclo su un elenco nella scheda "Ciclo", quindi
fare clic sulla scheda "Compositore" e selezionare 'Mostra 'anteprima
delle finestre al posto delle icone' durante il ciclo.


https://mxlinux.org/wiki/xfce/changing-border-size-with-xfce4-window-manager/
https://en.wikipedia.org/wiki/Compositing_window_manager

L'affiancamento delle finestre puo essere effettuato trascinando una
finestra in un angolo e rilasciandola...

Se il compositing ¢ attivato, lo zoom della finestra ¢ disponibile
utilizzando la combinazione Alt + Rotella del mouse.



* KDE/Plasma - Impostazioni di sistema

E possibile affiancare le finestre trascinando una finestra in un angolo
e rilasciandola in quel punto.

» La configurazione di una serie di controlli dei tasti e del mouse pud
essere impostata come desiderato tramite la finestra di dialogo
Spazio di lavoro > Comportamento della finestra.

* La configurazione dell'Alt-tab, compreso il tema, puo essere
eseguita nella finestra di dialogo Task Switcher.

* Carta da parati

» Xfce - Utilizzare le impostazioni del desktop per scegliere gli sfondi. Per
selezionare uno sfondo diverso per ogni area di lavoro, andare su Sfondo e
deselezionare I'opzione "Applica a tutte le aree di lavoro". Quindi selezionare uno
sfondo e ripetere la procedura per ogni area di lavoro trascinando la finestra di
dialogo nell'area di lavoro successiva e selezionando un altro sfondo.

» KDE/plasma: fare clic con il pulsante destro del mouse sul desktop e
selezionare "Configura desktop e sfondo".

Desktop Folder Settings — Plasma

Wallpaper
Background  Merus  lons
Layout: | Folder View
Wallpaper tor my deskiop ‘
Wallpaper Typa: | Image | % Gol New Plugins,

| Positioning: | Scaled and Cropped

Plasm_inDarkled UHD-5 A NO LOGO BLIS

Folder: |8 backgrourds Style: | Sinetched -
Color: | Selid color - N « Apply to all workspaces
aurera-borealiz-northermn-ig... Desert Blue with Plasma Loge
Chanige the baclngraind
+ Add Image... | ¥ Get New Wallpapers...
HHelp W Close ~ Ok * Cangel

Figura 3-45: La casella non selezionata consente di avere sfondi diversi per ogni area di
lavoro A sinistra: Xfce, a destra: KDE.



Conky

Conky consente di visualizzare quasi tutti i tipi di informazioni sul desktop:

Sia Conky Manager che MX Conky sono installati di default.

Quando si fa clic su MX Conky, viene visualizzata una finestra di dialogo che indica se sono
disponibili aggiornamenti.

Fare clic sul menu Start > Accessori per trovare Conky Manager. MX Conky fa
parte di MX Tools.

Per impostazione predefinita, ¢ incluso un set di Conky che funziona subito. E
possibile importare altri set utilizzando l'icona dell'ingranaggio all'estremita destra
della barra dei menu di Conky Manager.

Evidenziate ogni conchiglia e premete Anteprima, se necessario, per vederne l'aspetto.

Selezionare la casella per selezionare il Conky che si desidera utilizzare. Verra installato
automaticamente.

I file di configurazione sono memorizzati nella cartella ~/.conky/ nei singoli file di
tema; possono essere modificati evidenziando il Conky nell'elenco e facendo clic
sull'icona di modifica (matita).

« >

Source:

——
=/.conky/MX-CowonPink/MX-Cowon_pink_roboto
¥ | ~/.conky/MX-CowonTangram/MX-Cowon_Tangram

~/.conky/MX-Deadbeef/db.conky
=/.conky/MX-Elementary/MX-Elementary_sys
~f.conky/MX-Emays/MX-emays
~1.conky/MX-Flair/System _flair_Updated
~/.conky/MX-FluxKeys/fluxkeys.conf
~f.conky/MX-Futuriste/conky-futuriste-&
~/.conky/MX-Gotham/MX-Gotham_mx17
~/.conky/MX-Hermoso/MX-Hermaoso
~/.conky/MX-KoO/MX-Full

Conky Manager v2.7

> B 3 /S B C I e E »* g O

Browse: (ILGES] Themes| | Filter mw

AL G R e e ey

Use the keyboard arrow keys to brot
Aenime FRETEA b bk Ete

Figura 3-46: La schermata principale di Conky Manager mostra uno dei conkies disponibili.

AIUTO: Wiki tecnica MX/antiX

ALTRO: Pagina iniziale di Conky



https://mxlinux.org/wiki/help-files/help-mx-conky
http://conky.sourceforge.net/index.html

Terminale a scomparsa

:]ﬂ VIDEQ: Personalizzazione del terminale a discesa

MX Linux viene fornito con un terminale a discesa molto pratico attivato con F4. Se si desidera
disabilitarla: Xfce - Menu Start > Tutte le impostazioni > Tastiera, scheda Scorciatoie

applicazioni.
KDE/plasma - Impostazioni di sistema > Avvio e spegnimento > Avvio e spegnimento
eliminare Yakuake.

I terminali a discesa sono molto configurabili.

Xfce - cliccate con il tasto destro del mouse sulla finestra del terminale e selezionate Preferenze.

KDE/plasma - cliccate con il tasto destro del mouse nella finestra del terminale e scegliete Crea nuovo
profilo.

3.8.5 Touchpad

Xfce - Le opzioni generali per il touchpad di un computer portatile si trovano facendo clic su
Impostazioni > Mouse e touchpad. I sistemi piu sensibili alle interferenze del touchpad
dispongono di un paio di opzioni:

» Utilizzare MX-Tweak, scheda Altro per modificare il driver del touchpad.

* Installare touchpad-indicator per vedere il controllo fine del comportamento... Fare
clic con il tasto destro del mouse sull'icona nell'area di notifica per impostare opzioni
importanti come l'avvio automatico.

KDE/Plasma - le opzioni del touchpad si trovano in Impostazioni di sistema > Hardware >
Dispositivi di input. Esiste anche un widget per il touchpad che puo essere aggiunto al pannello
(tasto destro del mouse sul pannello > aggiungi widget).

Le modifiche dettagliate possono essere apportate manualmente modificando il file 20-synaptics.conf sotto la
voce

/etc/X11/xorg.conf.d (il file € solo "synaptics.conf su MX-19).

3.8.6 Custiodia del menu di avvio

3.8.6.1 Menu Xfce ("Whisker")


https://www.youtube.com/watch?v=_X4tVjO8uzo

q VIDEO: Personalizzazione del menu Whisker



https://www.youtube.com/watch?v=QWVd1-8xpYI

:]ﬂ VIDEOQO: Divertimento con il menu Whisker

MX Linux Xfce utilizza per impostazione predefinita il menu Whisker, anche se un menu
classico puo essere facilmente installato facendo clic con il pulsante destro del mouse su un
pannello > Pannello > Aggiungi nuovi elementi > Menu Applicazioni. Whisker Menu ¢ molto

flessibile.

» Fare clic con il tasto destro del mouse sull'icona del menu > Proprieta per impostare le preferenze, ad
esempio,

» Spostare la colonna delle categorie accanto al pannello.
* Cambiare la posizione della casella di ricerca dall'alto verso il basso.
* Decidete quali pulsanti di azione volete mostrare.

« E facile aggiungere i preferiti: fare clic con il pulsante destro del mouse su qualsiasi voce di menu >
Aggiungi ai preferiti.

» E sufficiente trascinare e rilasciare i Preferiti per disporli come si desidera. Fare
clic con il tasto destro del mouse su qualsiasi voce per ordinarla o rimuoverla.

I contenuti dei menu possono essere modificati in Xfce utilizzando Menu > Accessori >
Editor di menu (menulibre). In KDE si accede all'editor di menu facendo clic con il tasto
destro del mouse sull'icona del menu e scegliendo Modifica applicazioni.

ALTRO: Caratteristiche del menu di Whisker

Modifica dei menu di Xfce

Le singole voci di menu possono essere modificate in vari modi (i file "desktop" delle voci di
menu si trovano in /usr/share/applications/ € possono essere modificati anche direttamente

come root).
* MenuLibre

* Facendo clic con il tasto destro del mouse su una voce del menu Whisker o del
Finder delle applicazioni, ¢ possibile modificarla in base alle esigenze dell'utente. 11
menu contestuale contiene Modifica e Nascondi (quest'ultimo puod essere molto
utile). Selezionando Modifica si apre una schermata in cui € possibile modificare

nome, commento, comando e icona.


https://www.youtube.com/watch?v=bgPn68jMqd0
http://gottcode.org/xfce4-whiskermenu-plugin/

Edit Launcher 4 = 0 X

Name: FeatherPad ‘

Comment: ‘Lighmreight Qt text editor |

Command: ‘featherpad %U | B

Working Directory: ‘ ‘ @

Icon: ’y‘

Options: Use startup notification

Run in terminal

EHelp ‘ I Cancel H [@ save

Figura 3-47: Schermata di modifica delle voci di menu.

3.8.6.2 KDE/Plasma ("kicker')

MX Linux KDE/Plasma utilizza il menu Application Launcher per impostazione predefinita,
anche se le alternative sono facilmente installabili facendo clic con il pulsante destro del mouse
sull'icona del menu e scegliendo "Mostra alternative alternative". Le applicazioni "preferite"
sono visualizzate come icone a sinistra del menu.

» Fare clic con il tasto destro del mouse sull'icona del menu > Configura menu applicazione per
impostare le preferenze, ad esempio,

Mostra le applicazioni come solo nome o come combinazione di nome e descrizione.
» (Cambiare la posizione dei risultati della ricerca.

* Mostra gli elementi recenti o usati spesso.

* Appiattire i livelli secondari dei menu.

« E facile aggiungere i preferiti: fare clic con il pulsante destro del mouse su qualsiasi voce di menu >
Mostra nei preferiti.

« E sufficiente trascinare e rilasciare i Preferiti per disporli come si desidera. Fare
clic eon il tasto destro del mouse su qualsiasi voce per ordinarla. Per rimuovere dai
Preferiti, fare clic con il tasto destro del mouse sull'icona, quindi su Mostra nei
Preferiti e deselezionare il Desktop o I'Attivita appropriata.

Modifica dei menu di KDE

Le voci di menu possono essere modificate facendo clic con il pulsante destro del mouse su



una voce del menu ed ¢ possibile modificare un launcher su base specifica per 1'utente. I file
"desktop" delle voci di menu si trovano in /usr/share/applications/ € possono essere
modificati anche direttamente come root.



Properties for Help.desktop — Plasma 7? ~ ~ e

General Permissions = Application Details
Mame: | MX User Manual
Description: | MX User Manual
Comment: | Orientation and information
Command: | mx-manual I Browse...
Work path: |

Supported file types:

Mimetype ~ | Description

Add... Remove Advanced Options

v OK @& Cancel

Figura 3-48: Schermata di modifica delle voci di menu (Plasma).
3.8.7 Accesso Greeter

L'utente ha a disposizione una serie di strumenti per personalizzare il Login Greeter. Le ISO di
Xfce utilizzano Lightdm Greeter, mentre le ISO di KDE/Plasma utilizzano SDDM.

Lightdm

LightDM GTK+ Greeter: settings

Appearance Panel Window paosition Misc.

Theme Adwaita-dark |+]
Icons Papirus | ot ‘
Font | sans Regular 11 |

» Additional font options

Background® (or use multihead setu; for individual monitors)
* Image |(None) ™
Color |-|

Use user wallpaper if available

User image

Default user image e‘

| CReload | xClose | = [Msave
Figura 3-49: l'applicazione di configurazione di Lightdm.




* Fare clic sul menu Start > Impostazioni > Tutte le impostazioni > Impostazioni
LightDM GTK+ Greeter per regolare la posizione, lo sfondo, il carattere, ecc.

» L'Autologin puo essere (in)attivato da MX User Manager, scheda Opzioni.

* Alcune proprieta della casella di accesso predefinita sono impostate nel codice
del tema selezionato. Cambiare tema per avere una maggiore scelta.

* Si puo fare in modo che l'assistente al login mostri un'immagine come segue:
* Menu Start > Impostazioni > Informazioni su di me (foto segnaletica)
* Compilare i dettagli che si desidera aggiungere.
» Fare clic sull'icona, navigare fino all'immagine che si desidera utilizzare.
* Chiudere
* Manuale

* Creare o selezionare un'immagine e utilizzare nomacs o un altro editor di
foto per ridimensionarla a circa 96x96 pixel.

» Salvate I'immagine nella vostra cartella home come .face (assicuratevi di
includere il punto e di non aggiungere alcuna estensione come jpg o png).

* Fare clic su Tutte le impostazioni > Impostazioni del Greeter GTK+ di
LightDM, scheda Aspetto: attivare l'interruttore dell'immagine utente.

* Qualunque sia il modo scelto, fate il logout e vedrete I'immagine accanto alla
casella di accesso; apparira anche nel menu Whisker una volta effettuato il

login.

eTnings

Login Screen (SDDM)
vou will be asked to authenticate before saving

* Help | |5 Defaules

Figura 3-50: l'applicazione di configurazione SDDM.



* Le impostazioni SDDM si trovano tutte nelle Impostazioni di sistema di Plasma
desktop. Un collegamento per le Impostazioni di sistema si trova nel pannello
predefinito di MX, oppure ¢ possibile cercarlo nel menu Applicazioni. Nelle
Impostazioni, andare su Avvio e Spegnimento
>> Schermata di accesso (SDDM).

* La pagina delle impostazioni per SDDM consente di:
m selezionare tra diversi temi se ne avete installato piu di uno;
m scegliere di personalizzare uno sfondo per il tema selezionato;
m rimuovere (cio¢ eliminare) un tema installato; e

m per ottenere/installare nuovi temi direttamente dal KDE Store online o da un file
sul proprio disco/supporto di memoria (vedi sotto)

* ¢ richiesta la password di root - poiché il desktop manager ¢ un programma di
sistema, qualsiasi modifica apportata ad esso o alla sua configurazione influisce sui
file della partizione root; per questo motivo verra richiesta la password di root.

» selezione dello sfondo - ¢ possibile cambiare lo sfondo del tema SDDM
selezionato. Alcuni temi sono dotati di un'immagine di sfondo predefinita che
verra visualizzata se non si apporta alcuna modifica. Anche questa operazione
richiede la password di root.

* Inuovi temi di SDDM si trovano nel KDE Store. E anche possibile sfogliare i temi
direttamente dalla pagina delle impostazioni di sistema di SDDM.

* In Impostazioni di sistema > Avvio e spegnimento > Schermata di accesso (SDDM)),
selezionare Nuova schermata di accesso nella parte inferiore della finestra.

* Per installare un tema:

m da un file zip scaricato, fare clic sul pulsante "Installa da file" nella pagina delle
impostazioni di sistema per SDDM, quindi selezionare il file zip desiderato dal
selezionatore di file che si apre.

m  Nel browser dei temi SDDM incorporato nelle Impostazioni di sistema, €
sufficiente fare clic sul pulsante "Installa" del tema selezionato.

NOTA: alcuni temi presenti nel KDE Store potrebbero essere incompatibili. MX 23 utilizza
Plasma versione 5.27.5, che ¢& la versione stabile disponibile per Debian, Bookworm. E quindi
possibile che alcuni dei temi SDDM piu recenti, costruiti per utilizzare le ultime caratteristiche
di Plasma, non funzionino con I'SSDM di Plasma 5.27. Fortunatamente SDDM ¢ dotato di una
schermata di accesso di ripiego in modo che se un tema applicato non funziona, ¢ possibile
accedere nuovamente al desktop e da li passare a un altro tema SDDM. Fate delle prove; alcuni
temi molto nuovi funzionano mentre altri no.


https://store.kde.org/browse/cat/101/order/latest

3.8.8 Bootloader

I1 bootloader (GRUB) di un MX Linux installato puod essere modificato con le opzioni pit
comuni facendo clic sul menu Start > MX Tools > MX Boot Options (vedere Sezione 3.2). Per
altre funzioni, installare Grub Customizer. Questo strumento deve essere usato con cautela, ma

consente agli utenti di configurare le impostazioni di Grub, come la configurazione dell'elenco
delle voci di avvio, i nomi delle partizioni, il colore delle voci di menu, ecc. Dettagli qui.

3.8.9 Suoni del sistema e degli eventi

Xfce

I segnali acustici del computer sono silenziati per impostazione predefinita nelle righe
"blacklist" del file /etc/modprobe.d/pc- speaker.conf. Commentare (# all'inizio) queste righe
come root se si desidera ripristinarle.

I suoni degli eventi possono essere attivati a livello di sistema facendo clic su Menu Start >
Impostazioni > Aspetto, scheda Altro: selezionare Abilita suoni eventi e, se lo si desidera,
Abilita suoni di feedback input. Possono essere gestiti con MX System Sounds (Sezione 3.2). Se
non si iniziano a sentire piccoli suoni quando si chiude una finestra o si effettua il logout, ad
esempio, provare a eseguire le seguenti operazioni:

e Uscire e rientrare.

e Fare clic sul menu Start > Multimedia > PulseAudio Volume Control, scheda
Riproduzione, e regolare il livello come necessario (iniziare con 100%).

* Fare clic sul menu di avvio, digitare "!alsamixer" (senza dimenticare il punto
esclamativo). Apparira una finestra di terminale con un singolo controllo audio
(Pulseaudio Master).

* Usare F6 per selezionare la scheda audio, quindi regolare i canali che
appaiono a volumi piu alti.

* Cercate canali come "Surround", "PCM", "Altoparlanti",
"Master Surround", "Master Mono" o "Master". I canali disponibili
dipendono dall'hardware in uso.

Per impostazione predefinita vengono forniti tre file audio: Borealis, Freedesktop e Fresh and
Clean. Tutti si trovano in /usr/share/sounds. E possibile trovarne altri nei repo o con una ricerca
sul web.

KDE


https://answers.launchpad.net/grub-customizer/%2Bfaq/1355

Per impostare i suoni del sistema, fate clic su Impostazioni di sistema > Notifiche >
Impostazioni dell'applicazione > Spazio di lavoro Plasma > Configura eventi.



3.8.10 Applicazioni predefinite
Generale

Le applicazioni predefinite da utilizzare per le operazioni generali si impostano facendo clic sul menu
Applicazione

> Impostazioni > Applicazioni predefinite (Xfce) o Impostazioni di sistema >
Applicazioni > Applicazioni predefinite (KDE/Plasma). E possibile impostare quattro
preferenze (Xfce: schede separate per Internet e Utilita).

* Browser web

* Lettore di posta

* Gestore di file

* Emulatore di terminale

* Mappa (KDE)

* Dialer (KDE)

Applicazioni particolari

Molte impostazioni predefinite per tipi di file specifici sono impostate durante l'installazione di
un'applicazione. Spesso, pero, esistono pit opzioni per un determinato tipo di file e 1'utente
desidera determinare quale applicazione debba avviare il file, ad esempio il lettore musicale per
aprire un file *.mp3.

L'applicazione Applicazioni predefinite di Xfce ha una terza scheda, "Altri", in cui € possibile
impostare questi tipi di MIME utilizzando una comoda tabella di ricerca per trovare il tipo,
quindi facendo doppio clic sullo spazio Applicazioni predefinite per impostare 'applicazione
desiderata.

Metodo generale

* Fare clic con il tasto destro del mouse su qualsiasi esempio del tipo di file che interessa
» Effettuare una delle seguenti selezioni:

* Apri con <applicazione elencata>. Questo aprira il file con l'applicazione
selezionata per questa particolare istanza, ma non influira sull'applicazione
predefinita.

* Apri con un'altra applicazione. Scorrere 1'elenco per evidenziare quello
desiderato (compreso "Usa un comando personalizzato"), quindi selezionare Apri.
La casella in basso "Usa come predefinito per questo tipo di file" ¢ deselezionata
per impostazione predefinita, quindi selezionatela se volete che la vostra selezione
diventi la nuova applicazione predefinita che viene avviata quando fate clic su



qualsiasi file di quel particolare tipo. Mantenete la casella deselezionata per un
utilizzo una tantum.
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ﬁ Feh £ Downloads -
t = E .| Open with KWrite
" GMU Image Manipulation Program /_ Root &
T Trash Te Open With b || Kate
Gwenview
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Figura 3-51: Modifica dell'applicazione predefinita Sinistra: Thunar Destra: Dolphin: Dolphin.

3.8.11 Conti limitati

Per alcuni scopi, pud essere auspicabile bloccare un'applicazione o un sistema per proteggerlo
dagli utenti. Ad esempio, i computer di una scuola o di un luogo pubblico di uso generale, dove
¢ necessario chiudere il file system, il desktop e 1'accesso a Internet. Sono disponibili diverse
opzioni.

* Alcuni componenti di Xfce che supportano la modalita kiosk. I dettagli nel Wiki di Xfce.

* KDE ha una modalita amministrativa, consultate il sito KDE Userbase.

* Verificate se il browser che utilizzate dispone di una modalita kiosk.
» Ladistro dedicata ai chioschi Porteus.

Altro: La guida di Alan D. Moore (un po' datata).



https://wiki.xfce.org/howto/kiosk_mode
https://userbase.kde.org/KDE_System_Administration
http://porteus-kiosk.org/index.html
http://www.alandmoore.com/blog/2011/11/05/creating-a-kiosk-with-linux-and-x11-2011-edition/

4 Uso di base

4.1 Internet

41.1 Browser web

* MX Linux viene fornito con il popolare browser Firefox installato, che dispone di
un'ampia serie di componenti aggiuntivi per aumentare 1'esperienza dell'utente.

Pagina iniziale di Firefox

Componenti aggiuntivi di Firefox

* Gli aggiornamenti di Firefox vengono forniti attraverso i repo di MX Linux e sono
solitamente disponibili per gli utenti entro 24 ore dal rilascio. Per il download
diretto, vedere la Sezione 5.5.5.

* [ file di localizzazione per Firefox possono essere installati facilmente con MX Package Installer.

* Firefox dispone di un servizio di sincronizzazione che facilita il trasferimento di
segnalibri, cookie, ecc. da un'installazione esistente di Firefox.

 Altri browser sono disponibili per il download e l'installazione tramite MX Package

Installer. Consultate il Wiki MX/antiX per suggerimenti e trucchi di configurazione.

41.2 Email

* Thunderbird ¢ installato di default in MX Linux. Questo popolare client di posta
elettronica si integra bene con Google Calendar e Google Contacts. Le versioni pit
recenti disponibili possono essere trovate con il programma di installazione dei
pacchetti MX > MX Test Repo.

+ [ file di localizzazione per Thunderbird possono essere installati facilmente con MX Package Installer.

* Per informazioni sui collegamenti che non aprono piu il browser, consultare il Wiki MX/antiX.

* Altri client di posta elettronica leggeri sono disponibili nel programma di installazione dei pacchetti
MX.

41.3 Chat

* HexChat. Questo programma di chat IRC ¢ installato di default in MX Linux e
facilita lo scambio di messaggi di testo per l'utente.


https://www.mozilla.org/
https://addons.mozilla.org/en-US/firefox/
https://mxlinux.org/wiki/applications/
https://www.mozilla.org/thunderbird/
https://mxlinux.org/wiki/applications/thunderbird/

Pagina iniziale di HexChat



https://hexchat.github.io/

* Pidgin. Questo client di messaggistica istantanea grafico e modulare ¢ in grado di
utilizzare piu reti contemporaneamente. Installatore di pacchetti MX.

Pagina iniziale di Pidgin

Video chat

» Zoom. Questo popolarissimo programma di chat video ¢ multipiattaforma e puo
essere installato senza problemi su MX Linux utilizzando il programma di
installazione dei pacchetti MX > Messaggistica. Si integra automaticamente con
PulseAudio, che ¢ installato di default.

* Gmail ha una funzione di conversazione integrata, ora chiamata Duo. Vedere la sezione 4.10.6

* Skype. Un popolare programma proprietario per la messaggistica istantanea e la chat
vocale e video.

Pagina iniziale di Skype

Risoluzione dei problemi

* Se la voce non viene captata nemmeno dopo aver utilizzato gli strumenti
dell'applicazione, provate a fare cosi:

* Accedere all'applicazione di video chat, fare clic su Opzioni e
andare alla scheda Dispositivi audio.

* Fare clic sul pulsante per avviare una chiamata di prova. Mentre la
chiamata ¢ in corso, aprire PulseAudio Volume Control e andare alla
scheda Registrazione.

* Mentre ¢ in corso la chiamata di prova, cambiare il microfono di
Skype con quello della webcam.

4.2 Multimedia

Qui di seguito sono elencate alcune delle numerose applicazioni multimediali disponibili in
MX Linux. Esistono anche applicazioni professionali avanzate, che possono essere trovate
attraverso ricerche mirate in Synaptic.


http://pidgin.im/
https://zoom.us/
https://duo.google.com/
https://www.skype.com/en/

4.2.1 Musica
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Figura 4-1: Riproduzione di una traccia CD con Clementine

¢ @iocatori

* Clementine. Un moderno lettore musicale e un organizzatore di librerie in
grado di riprodurre qualsiasi sorgente, da un CD a un servizio cloud.
Installato per impostazione predefinita.

Clementine home page

* Audacious. Un lettore e gestore musicale completo. MX Package Installer.

Home page di Audacious

* DeaDBeeF. Un lettore leggero con un ingombro di memoria ridotto, un
robusto insieme di funzioni di base e un'attenzione particolare alla
riproduzione musicale. Installatore di pacchetti MX.

DeaDBeeF home page

* Ripper ed editor

* Asunder. Un ripper e codificatore di CD audio grafico che puo essere usato
per salvare tracce da CD audio. Installato per impostazione predefinita.

Home page di Asunder

* EasyTAG. Una semplice applicazione per visualizzare e modificare i tag nei file audio.

Pagina iniziale di EasyTAG



https://www.clementine-player.org/
http://audacious-media-player.org/
http://deadbeef.sourceforge.net/
http://littlesvr.ca/asunder/
https://wiki.gnome.org/Apps/EasyTAG

4.2.2 Video

AGGIORNAMENTO: Netflix su Linux a 32 bit

* Giocatori
* VLC. Riproduce un'ampia gamma di formati video e audio, DVD, VCD,
podcast e flussi multimediali da varie fonti di rete. Installato per impostazione

predefinita.

Pagina iniziale di VLC

» Il browser YouTube per SM Player ¢ installato di default.

Home page di SMplaver

» Netflix. La funzionalita desktop di streaming di Netflix ¢ disponibile per
Firefox e Google Chrome.

Pagina iniziale di Netflix

Figura 4-2: Esecuzione di Netflix sul desktop in Google Chrome

* Ripper ed editor

* HandBrake. Un ripper video facile da usare, veloce e semplice. Installatore
di pacchetti MX.

Pagina iniziale di HandBrake



https://www.youtube.com/watch?v=fY_PqMJ5kG4
http://www.videolan.org/vlc/
http://smplayer.sourceforge.net/
https://www.netflix.com/us/
https://handbrake.fr/

* DeVeDe. Questa utility converte automaticamente il materiale in formati
compatibili con gli standard dei CD audio e dei DVD video.

Pagina iniziale di DeVeDe

* DVDStyler. Un'altra buona utility di authoring. MX Package Installer.

Pagina iniziale di DVDStyler

* OpenShot. Un editor video semplice da usare e ricco di funzioni. Installatore di pacchetti MX.

Pagina iniziale di OpenShot

4.2.3 Foto

File Edit Adjustments View Panels Tools Sync 7

:f. @ B |NoAspectRatio || ® = | l;)[o.00° [ Guides o (@ >

Figura 4-3: Utilizzo dello strumento di ritaglio in Nomacs

* Nomacs. Un visualizzatore di immagini veloce e potente, installato di default.

Pagina iniziale di Nomacs

* Mirage. Questa veloce applicazione ¢ facile da usare e consente di visualizzare e
modificare le foto digitali. Installatore di pacchetti MX.

Pagina del progetto Mirage



http://www.rastersoft.com/programas/devede.html
http://www.dvdstyler.org/en/
http://www.openshot.org/
https://nomacs.org/
http://sourceforge.net/projects/mirageiv.berlios/

Fotoxx. Questa veloce applicazione consente di modificare facilmente le foto e di
gestire le collezioni, soddisfacendo le esigenze dei fotografi piu seri. Installatore di
pacchetti MX > MX Test Repo.

Pagina iniziale di Fotoxx

GIMP. Il principale pacchetto di manipolazione delle immagini per Linux. L'aiuto
(gimp-help) deve essere installato separatamente ed ¢ disponibile in molte lingue. Il
pacchetto di base ¢ installato di default, quello completo ¢ disponibile nel programma
di installazione dei pacchetti MX.

Pagina iniziale di GIMP

gThumb. un visualizzatore e browser di immagini degli sviluppatori di GNOME che
include anche uno strumento di importazione per trasferire le foto dalle macchine
fotografiche. Predefinito in MX-21.

Wiki gThumb

LazPaint, un editor di immagini leggero multipiattaforma con livelli raster e
vettoriali. Predefinito in MX-21.

Documentazione di LazPaint

Gwenview, il visualizzatore di immagini del progetto KDE

1261642 -unsplash jpg - 4288x2848 - 23% — Gwenview

Figura 4-4: Gwenview


http://www.kornelix.net/fotoxx/fotoxx.html
http://www.gimp.org/
http://gthumb.sourceforge.net/features.html
https://wiki.freepascal.org/LazPaint

4.2.4 Screencasting

@ SimplescreenRecorder E
Profile

| (none) < | mew
Video input

@ Record the entire screen | Screen 1: 1920x1080 at 0.0 s

(O Record a fixed rectangle
O Follow the cursor

() Record OpenGL (experimental)

Left: 0 Top: 0

width: | 1920 Height: | 1080

Frame rate: | 30 |:|

[] Scale video
Scaled width: | 1920 Scaled height: | 1080
Record cursar
Audio input
Record audio

Backend: | ALSA ol
Source: | [hw10,0] Webcam C170: USB Audio ¢|| Refresh |
| 4 Back | | » Continue |

Figura 4-5: Schermata principale di SimpleScreenRecorder

* ScreenRecorder semplice. Un programma semplice ma potente per registrare
programmi e giochi. Installatore di pacchetti MX.

SimpleScreenRecorder pagina iniziale

* RecordMyDesktop. Cattura i dati audio-video di una sessione desktop di
Linux. Installatore di pacchetti MX.

Pagina iniziale di RecordMyDesktop.

4.2.5 Illlustrazioni

» mtPaint. Un'applicazione di facile apprendimento per creare pixel art e manipolare
foto digitali.

Pagina iniziale di mtPaint

» LibreOffice Draw. Con questa applicazione ¢ possibile creare e modificare
diagrammi, disegni e immagini.

LO Draw home page

* Inkscape. Questo editor di illustrazioni ha tutto cio che serve per creare computer art
di qualita professionale. Installatore di pacchetti MX.


http://www.maartenbaert.be/simplescreenrecorder/
http://recordmydesktop.sourceforge.net/about.php
http://mtpaint.sourceforge.net/
http://www.libreoffice.org/discover/draw/

Pagina iniziale di Inkscape

4.3.1 Suite per ufficio

4.3.1.1 Sul desktop

LibreOffice

MX Linux ¢ dotato di un'ottima suite per ufficio gratuita chiamata LibreOffice, che ¢

l'equivalente di Linux e quasi un sostituto di Microsoft Office® [ suite & disponibile nel menu
Applicazioni > Ufficio > LibreOffice. LibreOffice supporta i formati di file .docx, .xlsx e
.pptx di Microsoft Office 2007 e successivi.

L/ Remote Files
L) Recent Files -

Ej Templates .
Create:

Writer Document
Calc Spreadsheet
Impress Presentation
Draw Drawing

Math Formula

Base Database

Extensions

Figura 4-6: Cruscotto principale in LibreOffice 6

* Per impostazione predefinita, viene installata I'ultima versione disponibile nei repo predefiniti.

e FElaboratore di testi: LibreOffice Writer. Un elaboratore di testi avanzato
compatibile con i file .doc e .docx.

* Foglio elettronico: LibreOffice Calc. Un foglio di calcolo avanzato
compatibile con i file .xIs e .xIsx.

* Presentazione: LibreOffice Impress. Presentazioni, compatibili con 1
file .ppt e .pptx.

* Disegnare: LibreOffice Draw. Utilizzato per creare grafici e diagrammi.

* Matematica: LibreOffice Math. Utilizzato per le equazioni matematiche.


https://inkscape.org/en/

* Base: LibreOffice Base. Utilizzato per creare e manipolare database. Se si
utilizza questa applicazione per creare o utilizzare database nel formato
nativo di LibreOffice, ¢ necessario installare anche libreoffice-sdbc-hsqldb e
libreoffice-base-driver corrispondenti alla versione.

* Gli utenti possono ottenere versioni piu recenti con diversi metodi:

* Scaricate direttamente da LibreOffice. Per i dettagli, consultare il Wiki MX/antiX.

* Scaricare da MX Package Installer, scheda Backports.
* Scaricare il flatpak (MX Package Installer) o l'appimage.
LINK

* Pagina iniziale di LibreOffice.

e Wiki MX/antiX.

Sono disponibili anche altre suite desktop.

. Softmaker Free Office -- MX Package Installer: Applicazioni piu diffuse

. Calligra Suite (parte del progetto KDE) -- Installatore di pacchetti MX: Repo di prova
4.3.1.2 Nel cloud
Google

Google Docs e Office Suite (quest'ultima richiede un abbonamento) offrono eccellenti

applicazioni online che includono tre componenti standard per l'ufficio: Docs, Sheets e Slides.
E facile condividere i file e le opzioni di esportazione sono molto utili.

Microsoft

I prodotti Microsoft non sono FOSS, eppure molti utenti hanno bisogno o vogliono avere
accesso a questi prodotti, soprattutto in contesti aziendali, istituzionali e di altro tipo.
Sebbene le applicazioni della suite Microsoft Office non possano essere installate in modo
nativo su Linux, Office365 (servizio a pagamento) o On-line Office (gratuito) di Microsoft
sono solo normali pagine web che funzionano bene in qualsiasi browser moderno su MX
Linux. I dettagli nel Wiki MX/antiX.

Altre opzioni

* OnlyOffice (servizio a pagamento per le aziende)


https://mxlinux.org/wiki/applications/libreoffice/
https://www.libreoffice.org/download/appimage/
https://www.libreoffice.org/
https://mxlinux.org/wiki/applications/libreoffice
https://www.freeoffice.com/
https://www.calligra.org/
https://www.google.com/docs/about/
https://www.office.com/
https://products.office.com/en-us/office-online/documents-spreadsheets-presentations-office-online
https://mxlinux.org/wiki/applications/microsoft-office/
https://www.onlyoffice.com/

4.3.2 Finanze dell'ufficio

« GnuCash. Software finanziario per l'ufficio. E facile da imparare e consente di tenere
traccia di conti bancari, azioni, entrate e uscite. Puo importare dati in formato QIF,
QFX e altri formati e supporta la contabilita a doppia entrata. Installatore del
pacchetto MX. Il pacchetto Guida (gnucash-docs) deve essere installato

separatamente.

e Pagina iniziale di GnuCash

*Unsaved Book - Accounts - GnuCash

File Edit View Actions Business Reports Tools Windows Help

k3 i i i

Save Close Edit New Delete

@@ Accounts
Account Name - | Description Total -
» i Assets Assets £0.00
» fm Equity Equity £0.00
b fm Expenses Expenses £0.00
b fm Income Income £0.00
» fm Liabilities Liabilities £0.00

£, Grand Total: MNet Assets: £0.00 Profits: £0.00 -

Figura 4-7: Nuovo conto in GnuCash

4.3.3 PDF

* QPDFview. Un visualizzatore veloce e leggero che include una serie di strumenti di
base. Installato per impostazione predefinita.

QpdfView home page

* Okular, il lettore di PDF e documenti del progetto

KDE Documentazione di Okular

* Adobe Reader per Linux offre maggiori funzionalita (come i commenti o la
compilazione di moduli). MX Package Installer (sotto Office).

Pagina iniziale di Adobe Reader



http://gnucash.org/
https://launchpad.net/qpdfview
https://okular.kde.org/
http://www.adobe.com/products/reader.html

* PDFShuffler semplifica il riordino, 1'eliminazione e I'aggiunta di pagine PDF. Installato
per impostazione predefinita.

PDFShuffler pagina iniziale

* gscan2pdf ¢ un metodo pratico per la scansione di documenti in PDF, oltre a
soddisfare le esigenze generali di scansione. Installatore di pacchetti MX
(MX/antix Wiki).

gscan2pdf home page

* SimpleScan ¢ un software di scansione minimale che funziona molto bene per le
attivita quotidiane. Installato di default su MX-21.

Home page di SimpleScan

* Per altre funzioni (ad esempio, la creazione di un modulo PDF), vedere MX/antiX Wiki.

4.3.4 Pubblicazione desktop

* Scribus. Impaginazione professionale che produce risultati pronti per la stampa.
Disponibile tramite MX Package Installer.

Pagina iniziale di Scribus

4.3.5 Tracciamento dei tempi del progetto

* Orologio a timbro Kapow. Un'applicazione semplice ma ricca di funzioni per registrare i tempi dei
progetti.

Pagina iniziale di Kapow

Project Session Settings Help

00:00:00

[Tasl | | start

Project Timer |Show all v|
Foundry Date Start Stop Task Hours
11/28/17 10:34 AM 10:55 AM 0.3

11/28/17 2:17PM 2:47 PM 0.5

11/28/17 3:35PM 4:10 PM 0.6

Total 1.7



http://pdfshuffler.sourceforge.net/
https://mxlinux.org/wiki/applications/gscan2pdf
http://gscan2pdf.sourceforge.net/
https://gitlab.gnome.org/GNOME/simple-scan
https://mxlinux.org/wiki/applications/pdf
https://www.scribus.net/
https://gottcode.org/kapow/

Figura 4.8 Kapow impostato per tracciare il lavoro su un progetto



* Altre opzioni

4.3.6 Video meeting e desktop remoto

* AnyDesk. Consente un facile accesso remoto. MX Package Installer, oltre ad altre opzioni.

* TeamViewer. Applicazione multipiattaforma per il supporto remoto e i meeting online.
Gratuita per uso privato. Installatore di pacchetti MX.

Pagina iniziale di TeamViewer

4.4 Casa

4.4.1 Finanze

* HomeBank. Gestione semplice della contabilita, del bilancio e delle finanze personali.

HomeBank pagina iniziale

* Grisbi ¢ molto utile per la casa. Pud importare file QIF/QFX e ha un'interfaccia
intuitiva. Forse ¢ piu adatto alle banche al di fuori degli Stati Uniti.

Home page di Grisbi

4.4.2 Centro multimediale

* Plex Mediaserver. Consente di riunire tutti i media e di visualizzarli in un unico luogo.
Installatore di pacchetti MX.

Pagina iniziale di Plex

* Kodi Entertainment Center (ex XBMC) consente agli utenti di riprodurre e
visualizzare video, musica, podcast e file multimediali da supporti di archiviazione
locali e di rete. Installatore di pacchetti MX.

Pagina iniziale di Kodi

4.4.3 Organizzazione

» Note. Questo pratico plugin per Xfce (xfce4-notes-plugin) consente di creare e
organizzare note adesive per il desktop.

Pagina iniziale delle note

* KDE Pim Application, una suite di applicazioni per la gestione delle informazioni personali.


https://www.linuxlinks.com/timetracking/
https://anydesk.com/en
https://www.teamviewer.us/
http://homebank.free.fr/en/
http://www.grisbi.org/
https://www.plex.tv/
http://kodi.tv/
http://goodies.xfce.org/projects/panel-plugins/xfce4-notes-plugin

https://community.kde.org/KDE PIM

* Osmo. Una bella applicazione compatta che include calendario, attivita, contatti e note.

Pagina iniziale di Osmo

Figura 4-9: 1l gestore di informazioni personali Osmo
4.5 Sicurezza

451 Firewall

* Gufw. Un'utilita di configurazione del firewall personale che facilita la
configurazione del firewall da parte dell'utente. Installato per impostazione
predefinita.

Gufw home page

Wikipedia: Firewall personale

4.5.2 Antivirus

* ClamAV. Utile per impedire che gli utenti di Linux passino inconsapevolmente e-
mail e altri documenti infetti da virus a utenti Windows suscettibili.

Pagina iniziale di ClamAV

4.5.3 AntiRootkit

 chkrootkit. Questa applicazione analizza i sistemi alla ricerca di rootkit,
backdoor, sniffer ed exploit noti e sconosciuti.

chkrootkit home page



https://community.kde.org/KDE_PIM
http://clayo.org/osmo/
http://gufw.org/
http://en.wikipedia.org/wiki/Personal_firewall
https://sourceforge.net/projects/clamav/
http://www.chkrootkit.org/

4.5.4 Protezione con password

» Password e chiavi. Un gestore di password e chiavi installato di default. Dettagli
sull'uso nel Wiki MX/antiX.

Aiuto per password e chiavi

» KeePassX. Un gestore di password o una cassaforte che aiuta a gestire le password in
modo sicuro. Installatore di pacchetti MX.

Pagina iniziale di KeePassX

4.5.5 Accesso al web

» La maggior parte dei browser moderni dispone di componenti aggiuntivi che consentono di filtrare
facilmente il web.

» FoxFilter ¢ un esempio consolidato che si installa su Firefox, Chrome e Opera.

FoxFilter Preferences

General| & Web Sites | website

Use the setting below to enable or disable FoxFilter as needed.
©* [FoxFliter Enabled

( Enable/Disable Add-ons and Other Security Features

etting below to temporarily enable the use of the Tools/Addons

I Enable Tools/Addons feature

Enable config viewing (‘about:config’ and

" chromezsigiobalicontent/config.xut’

[ More Infe, Tips and Tricks

For more info, tips and tricks, visit the author's site at
http://inspiredeffect.com/FoxFilter

X cancel | ¢Psave ‘

Figura 4-10: La scheda preferenze di FoxFilter
4.6 Accessibilita
Esistono diverse utility open-source per gli utenti di MX Linux con disabilita.
* Tastiera su schermo. Onboard ¢ installata di default e Florence ¢ presente nei repo.
» Xfce. Fare clic su Menu applicazioni > Impostazioni > Accessibilita e selezionare
Abilita tecnologie assistive. Modificare le opzioni disponibili in base alle proprie

esigenze.

Documentazione di Xfce4: Accessibilita

» KDE gestisce un'ampia raccolta di aiuti all'accessibilita.

Applicazioni per l'accessibilitda di KDE



https://mxlinux.org/wiki/applications/passwords-and-keys
https://help.gnome.org/users/seahorse/stable/
http://www.keepassx.org/
http://docs.xfce.org/xfce/xfce4-settings/accessibility
https://userbase.kde.org/Applications/Accessibility

* Debian. Molti altri strumenti sono disponibili all'interno di Debian stessa.



Wiki Debian

4.77 Sistema

4.7.1 Privilegi di root

Esistono due comandi comuni per ottenere i privilegi di root (alias amministratore, superutente)
necessari per apportare modifiche al sistema (ad esempio, installare software) utilizzando un
terminale.

* su: richiede la password di root e concede 1 privilegi per l'intera sessione di terminale
* sudo: richiede la password dell'utente e concede 1 privilegi per un breve periodo di tempo.

In altre parole, su consente di cambiare utente in modo da essere effettivamente connessi come
root, mentre sudo consente di eseguire comandi nel proprio account utente con privilegi di root.
Inoltre, su utilizza I'ambiente (configurazione specifica dell'utente) dell'utente root, mentre sudo
consente di apportare modifiche a livello di root ma mantiene I'ambiente dell'utente che esegue
il comando. A partire da MX-21, MX Linux utilizza per impostazione predefinita sudo, che i
membri del forum generalmente raccomandano.

L'utente puo decidere se utilizzare "Root" o "User" nella scheda "Other" di MX Tweak.

ALTRO: fare clic su Menu applicazioni > inserire "#su" o "#sudo" (senza le virgolette) nello
spazio di ricerca e tornare indietro per vedere le pagine man dettagliate.

Esecuzione di un'applicazione root

Alcune applicazioni che si trovano nel menu delle applicazioni richiedono all'utente i privilegi di
root: gparted, lightdm gtk+ greeter, ecc. A seconda di come ¢ scritto il comando di avvio, la
finestra di dialogo che si apre pud mostrare che l'accesso di root sara memorizzato (impostazione
predefinita) per tutta la durata della sessione (cio¢ fino al logout).

Authentication is required to run the GParted
% Partition Editor

An application is attempting to perform an action that
requires privileges. Authentication as the super user is
required to perform this action.

Password for root: H ‘

» Details

@ Cancel Authenticate

Figura 4-11: Finestra di dialogo quando viene utilizzato il comando pkexec senza memorizzare la password


https://wiki.debian.org/accessibility

di root



4.7.2 Ottenere le specifiche hardware

 Fare clic su Menu Applicazioni > Sistema > Profilatore di sistema e
Benchmark per ottenere una bella visualizzazione grafica che include i risultati di
vari test.

 Fare clic su Menu Applicazioni > Strumenti MX > Informazioni rapide sul
sistema. Il risultato viene automaticamente copiato negli appunti e puo essere
incollato in un post del forum completo di tag di codice.

Per le altre caratteristiche di inxi, si veda la sezione 6.5.

4.7.3 Creare collegamenti simbolici

Un collegamento simbolico (anche soft link o symlink) ¢ un tipo speciale di file che punta a un
altro file o cartella, come un collegamento in Windows o un alias in Macintosh. Un
collegamento simbolico non contiene dati reali (come un collegamento fisso), ma punta
semplicemente a un'altra posizione nel sistema.

Esistono due modi per creare un collegamento simbolico: File Manager o la riga di comando.
* Thunar

» Navigare verso il file o la cartella (destinazione del collegamento) a cui si
vuole puntare da un'altra posizione o con un altro nome.

* Cliccando con il tasto destro del mouse su cio che si vuole collegare > Crea
collegamento simbolico, viene creato un collegamento simbolico nel punto
in cui ci si trova attualmente.

» Fate clic con il tasto destro del mouse sul nuovo collegamento simbolico > Taglia

» Spostarsi nel punto in cui si desidera inserire il collegamento, fare clic con
il pulsante destro del mouse su un'area aperta> Incolla. Se lo si desidera,
modificare il nome del collegamento.

* delfino/KDE-plasma
* Usare Crea nuovo > Collegamento di base a file o directory

* Linea di comando: Aprire un terminale e digitare:

ln -s FileOrCartella di destinazione NomeCollegamento

* Ad esempio, per creare un collegamento simbolico tra un file chiamato
"pippo" nella cartella Download e la cartella Documenti, si deve immettere



questo comando:

In -s ~/Downloads/foo ~/Documents/foo



4.7.4 Trovare file e cartelle

INTERFACCIA GRAFICA

Figura 4-12: Schermata di ricerca di Catfish alla ricerca di "MX-" nella cartella Download

Catfish ¢ installato di default in MX Linux Xfce e pud essere lanciato dal Menu
Applicazioni > Accessori, o semplicemente iniziando a digitare "search" nel campo di
ricerca in alto. E anche integrato in Thunar, in modo che I'utente possa fare clic con il tasto
destro del mouse su una cartella > Trova file qui.

Pagina iniziale del pesce gatto

Gli utenti di KDE/plasma possono accedere alla finestra di dialogo Trova integrata nella barra degli strumenti
del file manager di Dolphin.
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Figura 4-13: risultati della ricerca Dolphin Find

Nei repo sono disponibili altri software di ricerca piu avanzati, come recoll.


http://www.twotoasts.de/index.php/catfish/
https://www.lesbonscomptes.com/recoll/

CLI

Esistono alcuni comandi molto utili da utilizzare in un terminale.

* locate. Per ogni modello dato, locate cerca uno o piu database di nomi di file e
visualizza quelli che contengono il modello. Ad esempio, digitando:

individuare firefox

restituira un elenco estremamente lungo con tutti i file che hanno la parola "firefox" nel
nome o nel percorso. Questo comando ¢ simile a find ed ¢ meglio utilizzarlo quando si
conosce il nome esatto del file.

Individuare gli esempi

* whereis. Un altro strumento a riga di comando, installato per impostazione
predefinita. Per ogni schema dato, whereis cerca in uno o piu database di nomi di file
e visualizza i nomi di file che contengono lo schema, ma ignora i percorsi, per cui
l'elenco di ritorno ¢ molto piu breve. Ad esempio, digitando:
dove si trova firefox
restituira un elenco molto piu breve, simile a questo:
firefox: /usr/bin/firefox /etc/firefox /usr/lib/firefox
/usr/bin/X11/firefox /usr/share/firefox

/usr/share/man/manl/firefox.1l.gz

Esempi di Whereis

* che: Probabilmente lo strumento pit comodo di tutti, questo comando cerca di
identificare I'eseguibile. Ad esempio, digitando:

quale firefox
restituisce un singolo elemento:

/usr/bin/firefox

Quali esempi

4.7.5 Uccidere i programmi in fuga

* Desktop

1. Premere Ctrl-Alt-Esc per trasformare il cursore in una "x". Fare clic su
qualsiasi schermata aperta per eliminarla, fare clic con il pulsante destro del
mouse per annullarla. Fate attenzione a non fare clic sul desktop, altrimenti la
sessione si interrompera bruscamente.

2. Xfce - Task Manager: Menu Applicazioni > Preferiti, oppure fare clic su
Menu Applicazioni > Sistema > Task Manager. Selezionare il processo
desiderato e fare clic con il pulsante destro del mouse per arrestarlo,


http://www.tecmint.com/35-practical-examples-of-linux-find-command/
http://www.thegeekstuff.com/2012/03/locate-command-examples/
http://www.cyberciti.biz/faq/unix-linux-whereis-command-examples-to-locate-binary/
http://www.thegeekstuff.com/2013/04/linux-which-whatis-whereis/

terminarlo o eliminarlo.



1. KDE/plasma - Menu Applicazioni > Preferiti, oppure fare clic su Menu
Applicazioni > Sistema > Monitoraggio del sistema.

3. E disponibile anche uno strumento tradizionale: fare clic su Menu
Applicazioni > Sistema > Htop, che visualizza un terminale con tutti i
processi in esecuzione. Individuare il programma che si desidera arrestare,
evidenziarlo, premere F9 e quindi Return.

* Terminale: Premere Ctrl-C, che di solito interrompe un programma/comando
avviato in una sessione di terminale.

» Se le soluzioni di cui sopra non funzionano, provate questi metodi piu estremi
(elencati in ordine crescente di gravita).

1. Riavviare X. Premere Ctrl-Alt-Bksp per eliminare tutti i processi di
sessione, tornando alla schermata di accesso. Tutto il lavoro non salvato
andra perso.

2. Utilizzare il tasto magico SysRq (REISUB). Tenere premuto il tasto Alt (a
volte funziona solo il tasto Alt sinistro) e il tasto SysRq (che puo anche essere
etichettato come Print Screen o PrtScrn) con un'altra mano, quindi premere
lentamente, senza rilasciare Alt-SysRq, i tasti R-E-I-S-U-B uno dopo ['altro.
Tenete premuto ogni tasto della sequenza REISUB per circa 1 o 2 secondi
prima di passare al tasto successivo; il sistema dovrebbe spegnersi
correttamente e riavviarsi. Lo scopo di questa chiave magica ¢ quello di
passare attraverso diverse fasi che consentono al sistema di uscire in sicurezza
da un guasto di qualche tipo, e spesso sono sufficienti solo le prime due lettere.
Ecco cosa succede quando si passa attraverso le lettere:

* R - cambia la modalita della tastiera. Si dice che "cambia la tastiera
dalla modalita raw, quella usata da programmi come X11 e svgalib, alla
modalita XLATE" (da Wikipedia), ma non ¢ certo che questo abbia un
effetto rilevante.

* E -termina con grazia tutti i programmi in esecuzione. Invia il
segnale SIGTERM a tutti 1 processi, eccetto init, chiedendo loro di
terminare con grazia, dando loro la possibilita di riordinare e liberare le
risorse, salvare 1 dati, ecc...

+ I - Uccide forzatamente tutti i programmi in esecuzione. E simile a
E, ma invia il segnale SIGKILL a tutti i processi tranne che a init,

uccidendoli immediatamente e forzatamente.


https://en.wikipedia.org/wiki/Magic_SysRq_key

¢ S -sincronizza tutti i dischi e scarica le loro cache. Tutti 1 dischi sono
normalmente dotati di una cache di scrittura, una porzione di RAM in cui
il sistema memorizza i dati che desidera salvare.



sul dispositivo, per velocizzare 1'accesso. La sincronizzazione indica al
sistema di svuotare queste cache ora e di eseguire tutte le scritture
rimanenti. In questo modo non si perdono 1 dati gia memorizzati nella
cache ma non ancora scritti e si evita di lasciare il file system in uno stato
incoerente.

* U - smonta tutti i dischi e li rimonta in sola lettura. Anche in questo
caso si tratta di un'operazione poco spettacolare, che semplicemente rende
tutti 1 dischi montati di sola lettura per impedire qualsiasi ulteriore
scrittura (parziale).

* B -riavvia il sistema. Questa operazione riavvia il sistema.

Tuttavia, non esegue uno spegnimento pulito, ma un reset duro.

Wikipedia: REISUB

3. Se non funziona nient'altro, tenere premuto il pulsante di accensione del
computer per circa 10 secondi finché non si spegne.

System Monitor
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richb 05,072 133,476 K Plasma settingsd 3114 386MIB 0%
richb 48,164% 98,148 K fdeskiop 3177 751 M8 1%
richb 19 38,736 K 98,004 K fconfd 3000 SEMIE 0%
richb 19,820 72,044 K dconfd 3002 s6MiB 0%
richb 19,330k 66,588 K fce-superkey 3301 22MiB 0%
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richb 7,336 K 30,860 K (@xfces 32819 461 MiB 1%
polkit-kde. richb 6,620k 37.172K xdced-power-manager 3287 27.2MiB 0%
pulseaudio richb 6,020k 21,148 K xfced-panel 3148 304Mi8 1%
kglobalac... richb 564K 33,236 K fces-notifyd 3192 250MiB 0%
richb 5136K 38,356 K xfced-clipman 3225 44.1MiB 0%
richb 5028k 40,572 K xdg-permission-store 17549 66MIB 0%
richb 5.020K 18,336 K xdg-document-portal 17345 83MiB 0%
richb 4256 K 34,648 K xdg-deskiop-portal-gtk 17570 297 MiB 0%
richb 212K 24,876 K xdg-desktop-portal 17533 11.1MiB 0%
,,,,, PP 22 c1aw mwrapper-2.0 3168 500MiE 0%
cPU: 2% Memory: 550.4 Mi8 / 14.7 GiB_ Swap: 08 /2.0 GiE starting task  Changing task [l Terminating task

Figura 4-14: Task Manager, pronto ad uccidere un processo. IN ALTO: KDE/plasma BASSO: Xfce
4.7.6 Prestazioni di tracciamento
Generale

» INTERFACCIA GRAFICA

 Fate clic su Menu Applicazioni > Sistema > Profilatore di sistema e
Benchmark, dove ¢ possibile non solo visualizzare numerose specifiche, ma
anche eseguire test sulle prestazioni.

* Molti conky mostrano le prestazioni del sistema; utilizzare Conky Manager
per visualizzarli in anteprima in base alle proprie esigenze e preferenze.

Vedere la Sezione 3.8.3.

* Plugin Xfce. Xfce 4.12 offre una serie di plugin per il monitoraggio del


https://en.wikipedia.org/wiki/Magic_SysRq_key

sistema che possono essere inseriti nel pannello, tra cui Battery Monitor,
CPU Frequency Monitor, CPU Graph, Disk Performance Monitor, Free
Space Checker,



Network Monitor, Sensor plugin, System Load Monitor e Wavelan. Possono
essere tutti installati con il metapacchetto xfce4-goodies. KDE/plasma ha un
insieme simile di pannelli e widget per il desktop.

Xfced4 Goodies pagina iniziale

 CLI

* Im-sensors. Questo pacchetto di monitoraggio della salute dell'hardware ¢
installato di default in MX Linux. Aprite un terminale, diventate root e

inserite:
sensori-rilevazione

Fare clic su Ritorno per rispondere affermativamente a tutte le domande. Al
termine, sara possibile ottenere informazioni dettagliate sulle letture dei sensori
disponibili sul sistema aprendo un terminale e digitando: sensors.

Lm-sensors home page

Batteria

Il livello della batteria ¢ monitorato dal plugin Power Manager del pannello. Un plugin
dedicato al pannello, chiamato Battery Monitor, ¢ disponibile anche facendo clic con il
pulsante destro del mouse su Pannello > Pannello > Aggiungi nuovi elementi ... In KDE ¢
installato di default un widget per il pannello Battery Monitor.

4.7.7 Programmare le attivita
 INTERFACCIA GRAFICA
* MX Job Scheduler, vedere 3.2.11.

* Attivita pianificate (gnome-schedule). Un modo molto pratico per
programmare le attivita di sistema senza dover modificare direttamente i file di
sistema. Home page di Gnome-schedule.

* KDE ha un Task Scheduler con capacita simili.

Task Scheduler — System Settings

< Startup and Shutdown Task Scheduler

@ Login Screen (SDDM) Show the following Cron: ® Personal Cron O System Cron

& PR % Scheduled Tasks

% Background Services Scheduling  Command ~ Status  Description  Scheduling Details B New Task...
(@ Desktop Session

[ splash Screen .

= Environment Variables

Variable ~ Value  Status  Comment B New Variable...

£ Highlight Changed Settings m  Defaults


http://goodies.xfce.org/projects/panel-plugins/start
https://wiki.archlinux.org/index.php/Lm_sensors
http://gnome-schedule.sourceforge.net/
https://userbase.kde.org/System_Settings/Task_Scheduler

Figura 4-15: Schermata principale del Task Scheduler di KDE



 CLI

* E possibile modificare crontab, un file di testo con un elenco di comandi da
eseguire a orari specifici.

Panoramica di Crontab

Generatore di crontab facile

4.7.8 Tempo corretto

La corretta impostazione dell'ora viene normalmente effettuata all'avvio di Live o durante
l'installazione. Se I'ora dell'orologio ¢ sempre sbagliata, ci sono 4 possibili problemi:

* fuso orario sbagliato

» selezione errata dell'ora UTC rispetto a quella locale
* Orologio del BIOS impostato in modo errato

* deriva del tempo

Questi problemi si risolvono facilmente utilizzando 1'applicazione Data e ora appropriata; per le
tecniche da riga di comando, consultare il Wiki MX/antiX.

4.7.9 Mostra blocco tasti

Su molti portatili non c'€ un indicatore luminoso per l'attivazione dei tasti CapsLock o
NumlLock, il che puo essere molto fastidioso. Per risolvere questo problema con un notificatore
sullo schermo, installare indicator-keylock dai repo.

4.8 Buone pratiche

4.8.1 Backup

La pratica piu importante ¢ quella di eseguire regolarmente il backup dei dati e dei file di

configurazione, un processo che ¢ facile in MX Linux. Si raccomanda vivamente di eseguire il

backup su un'unita diversa da quella in cui si trovano i dati! L'utente medio trovera comodo uno
dei seguenti strumenti grafici.


https://mxlinux.org/wiki/system/crontab/
http://crontab-generator.org/
https://mxlinux.org/wiki/system/time-settings
https://wiki.archlinux.org/index.php/Backup_programs
https://wiki.archlinux.org/index.php/Backup_programs
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Figura 4-16: Schermata principale di Lucky Backup

* gRsync, un frontend grafico per rsync.

Panoramica di gRsync

* LuckyBackup. Un programma semplice per eseguire il backup e la sincronizzazione dei file. Installato
per impostazione predefinita.

Manuale di LuckyBackup

* Déja Dup. Uno strumento di backup semplice ma molto efficace.

Déja Dup home page

* BackInTime. Un'applicazione ben collaudata disponibile da MX Package Installer >
MX Test Repo (preinstallata su MX KDE).

» Servizio cloud. Esistono molti servizi cloud che possono essere utilizzati per il
backup o la sincronizzazione dei dati. DropBox e Google Drive sono
probabilmente i pit noti, ma ne esistono molti altri.

Clonazione. Crea un'immagine completa del disco rigido.

¢ Clonezilla. Scaricare Clonezilla Live dalla pagina iniziale di Clonezilla e
riavviarlo.

* Timeshift. Backup/ripristino dell'intero sistema; nei repo. La home page
di Timeshift include una panoramica dettagliata e le istruzioni per l'uso.

» Salvare il sistema in una ISO live (Sezione 6.6.3).


https://en.wikipedia.org/wiki/Rsync
https://www.dedoimedo.com/computers/grsync.html
http://luckybackup.sourceforge.net/manual.html
https://launchpad.net/deja-dup
http://clonezilla.org/
http://clonezilla.org/
https://github.com/teejee2008/timeshift
https://github.com/teejee2008/timeshift

e Strumenti CLI. Si veda la discussione nel Wiki di Arch: Clonazione

* Comandi CLI per eseguire i backup (rsync, rdiff, cp, dd, tar, ecc.).

Dati

Assicuratevi di eseguire il backup dei dati, compresi documenti, grafica, musica e posta. Per
impostazione predefinita, la maggior parte di questi dati ¢ memorizzata nella directory /home; si
consiglia, se possibile, di avere una partizione dati separata, meglio se in una posizione esterna.

File di configurazione

Ecco un elenco di elementi da considerare per il backup.
* /home. Contiene la maggior parte dei file di configurazione personali.

* /root. Conserva le modifiche apportate come root.

/etc/X11/xorg.conf. Il file di configurazione di X, se esiste.

I file di GRUB?2 /etc/grub.d/ e /etc/default/grub.

Elenco dei pacchetti di programmi installati

E anche una buona idea salvare nella directory /home o nel cloud (Dropbox, Google Drive,
ecc.) un file contenente I'elenco dei programmi installati con Synaptic, apt-get o Gdebi. Se in
futuro sara necessario reinstallare, sara possibile recuperare i nomi dei file per la reinstallazione.

Uno strumento utile per elencare i pacchetti installati dall'installazione iniziale del sistema si
trova facendo clic con il tasto destro del mouse sull'icona MX Updater nell'area di notifica >
Cronologia apt. Apparira un elenco dei programmi installati tramite il sistema apt, che potrete
copiare e incollare in un documento per conservarlo e consultarlo.

E possibile creare un inventario di tutti i pacchetti installati sul sistema dopo l'installazione
copiando questo lungo comando ed eseguendolo in un terminale:

dpkg -I | awk '/~ [i|h]i/{ print $2 }' | grep -v -e "lib[0-q\|s-z] -e "libr[ 0-d\f-z] -e ~libre[0-n|p-z] -e -dev$ -e -dev: - e
linux-image -e linux-headers | awk '{print $1" installed"}' | column -t > apps_installed.txt

Questo creera un file di testo nella vostra home directory chiamato "apps_installed.txt" che
contiene tutti i nomi dei pacchetti.

Per reinstallare TUTTI i pacchetti in una volta sola: assicurarsi che tutti i repository necessari
siano abilitati, quindi eseguire questi comandi uno alla volta:
sSu

dpkg \SpecialChar nobreakdash\SpecialChar nobreakdashset-selections <
apps_installed. txt


https://wiki.archlinux.org/index.php/disk_cloning

apt-get update

apt-get dselect-upgrade

NOTA: questo non dovrebbe essere tentato tra versioni di MX basate su versioni Debian
diverse (ad esempio, da MX-14.4 a MX-15 o MX-16).

Nei repo ¢ presente uno strumento aptik che puod essere utile se usato con cautela. E stato
sviluppato per Ubuntu, ma permette di risparmiare molta fatica anche in MX Linux, soprattutto
per quanto riguarda i file di impostazione che tendono a essere trascurati.

4.8.2 Manutenzione del disco

Quando un sistema invecchia, spesso accumula dati non piu utilizzati e riempie gradualmente il
disco. Questi problemi possono essere risolti utilizzando periodicamente MX Cleanup.

Vediamo un esempio. Quando il suo computer stava rallentando, un utente ha controllato lo
spazio libero sul disco usando inxi -D ed ¢ rimasto sorpreso nel vedere che il disco era pieno al
96%. Facendo clic sul pulsante Esegui 1'analizzatore dell'uso del disco in MX Cleanup si €
ottenuta una buona analisi grafica e facendo clic sui grandi segmenti rossi si € scoperto che la
cache era piena.

B |<| ULTRA le| - a x
Could not scan some of the folders contained in "/"
Permission denied | Close
Folder Size Contents Modified
- (- / 20.6 GB 290696 items 5 days
» var 9.4 GB 39009 items 1 year
»[E Jusr 9.1 GB 229953 items 3 months
»[Jopt 1.5GB 12696 items  Today
y(—Jiib 481.2MB 6147 items 2 months
» [ Jboot 90.3 MB 322 items 2 months
[ shin 18.8MB 196 items 1 month
» [ Jetc 224MB  2221items  Today
[ 10.9MB  139items 1month
» [ I media 24.6 kB 7items  4days
lost+found 8 months
root 3 months k}
[ Jmnt 4.1kB 1item 8 months
[ Jlib64 4.1kB 1 item 5 months
& B |

Figura 4-17. L'analizzatore dell'uso del disco mostra una directory principale quasi piena.

Dopo la pulizia con MX User Manager, la percentuale ¢ scesa a circa il 63% e la lentezza ¢
scomparsa.


https://mxlinux.org/wiki/other/application-migration-aptik

B |« ULTRA ¢ - o x
Could not scan some of the folders contained in "/"
Permission denied | Close
Folder Size Contents Modified
~ () / 12.6 GB 288361 items 5 days
» (MW ] usr 9.1 GB 229953 items 5 days
»([ Jopt 1.5GB 12696 items  Today
» [ Jvar 14GB 36674 items 1year
»[_Jlib 481.2 MB 6147 items 2 months
» ) boot 90.3MB 322 items 2 months
("I sbin 18.8 MB 196 items 1 month
y [ Jete 224 MB 222litems  Today
—Jbin 10.9 MB 139 items 1 month
» [ ) media 24.6 kB 7items 4 days
lost+found 8 months
root 3 months
" )mnt 4.1 kB 1 item 8 months
[ iib64 4.1kB 1 item 5 months

Figura 4-18. I risultati dell'eliminazione della cache rappresentati da Disk Usage Analyzer

Deframmentazione

Gli utenti che provengono da Windows potrebbero chiedersi se sia necessario deframmentare
periodicamente l'unita. La deframmentazione non ¢ probabilmente necessaria sul file system ext4
predefinito di MX, ma se € quasi pieno e non ha un'area contigua abbastanza grande per allocare
il file, si finisce per avere una frammentazione. Se necessario, € possibile controllare lo stato con
questo comando:

sudo eddefrag -c /

Dopo pochi secondi verra visualizzato un punteggio e una semplice indicazione sulla necessita
o meno di deframmentare il sistema.

4.8.3 Controllo degli errori

Molti messaggi di errore vengono scritti nel file appropriato in /var/lIog/ e riguardano

problemi di applicazioni, eventi, servizi e sistema. Alcuni importanti includono:
*  /var/log/boot
*  Nar/log/dmesg
*  Nar/log/kern.log
*  Nvar/log/messaggi
*  Nvar/log/Xorg.0.log

Non sono sempre facili da leggere, ma spesso vale la pena guardarli se si sospetta un problema.
E possibile consultarli in un terminale utilizzando il comando cat seguito dalla posizione del
log che si desidera visualizzare.

4.9 Giochi

Sfogliando I'ampio elenco di giochi disponibili attraverso Synaptic (fare clic su Sezioni >
Giochi in fondo al pannello di sinistra) o seguendo i1 collegamenti riportati di seguito, si
troveranno molti altri titoli per il vostro divertimento.



I1 seguente elenco contiene alcuni esempi per stuzzicare l'appetito.

4.9.1 Giochi di avventura e sparatutto

* Chromium B.S.U.: Uno sparatutto spaziale veloce, in stile arcade e a scorrimento
dall'alto. Installato per impostazione predefinita.

Pagina iniziale di Chromium B.S.U.

* Beneath A Steel Sky: Un thriller fantascientifico ambientato in un cupo futuro post-

apocalittico. Home page di Beneath a Steel Sky

* Kq: un gioco di ruolo per console, simile a Final Fantasy.

Pagina iniziale di Kqg

* Marte. "Uno sparatutto ridicolo". Proteggi il pianeta dai tuoi vicini

gelosi! Pagina iniziale di Marte
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Figura 4-19: Navi da guerra nemiche all'attacco in Chromium B.S.U.
4.9.2 Giochi arcade
* Defendguin: Un clone di Defender, in cui la vostra missione ¢ difendere i piccoli

pinguini. Pagina iniziale di Defendguin

* Bolla congelata: Le bolle colorate sono congelate nella parte superiore dello schermo di
gioco. Mentre la pressa di ghiaccio scende, € necessario far scoppiare gruppi di bolle
congelate prima che la pressa raggiunga il tiratore.

Pagina iniziale di Frozen Bubble

* Planet Penguin Racer: un divertente gioco di corse con il vostro pinguino preferito.

¢ Pagina iniziale di Tuxracer

* Ri-li: Un gioco di treni giocattolo.


http://chromium-bsu.sourceforge.net/
https://en.wikipedia.org/wiki/Beneath_a_Steel_Sky
http://kqlives.sourceforge.net/
http://mars-game.sourceforge.net/?page_id=972
http://www.newbreedsoftware.com/defendguin
http://www.frozen-bubble.org/
http://tuxracer.sourceforge.net/

Ri-li home page

* Supertux: Un classico gioco 2D a scorrimento laterale con salto e corsa in uno stile
simile a quello dei giochi originali di SuperMario.

Pagina iniziale di Supertux

* Supertuxkart: Una versione molto migliorata di

tuxkart. Pagina iniziale di Supertuxcart
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Figura 4-20: 1l treno Ri-li deve girare presto

4.9.3 Giochi da tavolo

* Giochi Gottcode: tra quelli disponibili, Peg-E (gioco solitario Peg) ¢ installato di default.

Pagina iniziale di Gottcode

* Mine (gnomine): Un gioco di mine per 1 giocatore.

Pagina iniziale delle miniere

* Do'SSi Zo'la: L'obiettivo del gioco base Isola ¢ bloccare l'avversario distruggendo le
caselle che lo circondano.

Pagina iniziale di Do'SSi Zo'la

* Gnuchess: Un gioco di scacchi.


http://ri-li.sourceforge.net/
http://supertux.lethargik.org/
http://supertuxkart.sourceforge.net/
http://gottcode.org/
https://wiki.gnome.org/Apps/Mines
http://dossizola.sourceforge.net/

Gnuchess home page
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Figura 4-21: Momento di alta tensione nelle miniere.
4.9.4 Giochi di carte
Ecco alcuni divertenti giochi di carte disponibili nei repo.
* Pysolfc: Oltre 1.000 giochi di solitario da un'unica applicazione.

Pysolfc home page

4.9.5 Divertimento sul desktop

» Xpenguins. | pinguini camminano sullo schermo. Puo essere personalizzato
con altri personaggi come Lemmings e Pooh Bear (€ necessario consentire
l'esecuzione dei programmi nella finestra principale).

Pagina iniziale di Xpenguins

* Oneko. Un gatto (neko) segue il cursore (il mouse) sullo schermo. Puo essere
personalizzato con un cane o un altro animale.

Wikipedia: Neko



http://www.gnu.org/software/chess
http://pysolfc.sourceforge.net/
http://xpenguins.seul.org/
https://en.wikipedia.org/wiki/Neko_(software)

* Algodoo. Questo gioco gratuito presenta un sandbox di fisica in 2D in cui € possibile
giocare con la fisica come mai prima d'ora. La sinergia giocosa tra scienza e arte ¢
inedita e rende il gioco tanto educativo quanto divertente.

Pagina iniziale di Algodoo

» Xteddy. Mette un simpatico orsacchiotto sul desktop. In alternativa, ¢ possibile aggiungere la propria
immagine.

Xteddy homepage

* Tuxpaint. Un programma di disegno per bambini di tutte le eta.

Pagina iniziale di Tuxpaint

Tam Faire

White!

Figura 4-22: Genio in erba al lavoro in Tuxpaint

4.9.6 1 bambini

* Dal programma di installazione dei pacchetti MX sono disponibili tre pacchetti di
giochi e applicazioni didattiche.

* Inoltre, Scratch ¢ un linguaggio di programmazione gratuito € una comunita online

dove ¢ possibile creare storie interattive, giochi e animazioni. Installatore di pacchetti
MX.


http://www.algodoo.com/
http://staffwww.itn.liu.se/~stegu/xteddy/index.html
http://www.tuxpaint.org/
https://scratch.mit.edu/

snap blocks together to
make your sprite dance

change Whil | affact by m

play drum m for m beats

change Whirl | effact by
play drum ELRg for m beats

Orange control block

switch to costume cassy-dancing-1 Ejﬁj::’;f;hspug;]vs:w’
play drum ER4 for (RFD) boate Ciaty e avioouh:
turn G () dearees mchon
play i, m for beats Ezn;:ee:zfand see what

turn b m degrees
play drum (TR for (FI) beats

swntch to costume Céssy-dancing-2

play drum for (1) beats

Figura 4-23: Schermata di codifica per Dance Party con Scratch
4.9.7 Giochi di tattica e strategia

* Freeciv: Un clone di Sid Meyer's Civilization© (versione I), un gioco di strategia
multigiocatore a turni, in cui ogni giocatore diventa il leader di una civilta dell'eta della
pietra, cercando di ottenere l'ascendente con il progredire delle epoche.

Pagina iniziale di Freeciv

* Lbreakout2: LBreakout2 ¢ un gioco arcade in stile breakout in cui si usa la racchetta per
puntare una palla contro i mattoni fino a distruggerli tutti. Molti livelli e sorprese.
Installato di default.

Lgames home page

* Lincity: Un clone dell'originale Simcity. Dovete costruire e mantenere una citta e
soddisfare i suoi abitanti in modo che la popolazione cresca.

Pagina iniziale di Lincity

* Battle for Wesnoth: Un apprezzato gioco di strategia a turni a tema fantasy. Costruite il
vostro esercito e combattete per riconquistare il trono.

Pagina iniziale di Battle for Wesnoth



http://www.freeciv.org/
http://lgames.sourceforge.net/
http://lincity.sourceforge.net/
http://www.wesnoth.org/

Figura 4-24: Tentativo di sfondare il primo muro in Lbreakout
4.9.8 Giochi per Windows

Un certo numero di giochi Windows puo essere giocato in MX Linux utilizzando un emulatore
Windows come Cedega o DOSBox, o alcuni possono anche essere eseguiti sotto Wine: vedere la
Sezione 6.1.

4.9.9 Servizi di gioco

$ Sins of a Solar Empire: Rebellion

You have 1 Friend who plays Sins of a Solar Empire: Rebellion

VIEW ALL FRIENDS WHO PLAY THIS GAME

VIEW ALL ACHIEVEMENTS

Figura 4-25: Peccati di un Impero Solare: Rebellion su Steam con Proton
Esistono diverse raccolte e servizi per gli utenti che desiderano giocare su MX Linux. Due dei

piu noti sono facilmente installabili con MX Package Installer.

* PlayOnLinux. Un frontend grafico per Wine (Sezione 6.1) che consente agli utenti
Linux di installare e utilizzare facilmente numerosi giochi e applicazioni progettati
per funzionare con Microsoft® Windows®.

Homepage di PlayOnLinux.



https://www.playonlinux.com/en/

» Steam. Una piattaforma proprietaria di distribuzione digitale per I'acquisto e la
riproduzione di videogiochi che prevede l'installazione e 1'aggiornamento automatico dei
giochi. Include Proton, una distribuzione modificata di Wine.

Homepage di Steam

4.10 Strumenti di Google

4.10.1 Gmail

Gmail puo essere facilmente configurato in Thunderbird seguendo le istruzioni. Inoltre, ¢
possibile accedervi facilmente con qualsiasi browser.

4.10.2 Contatti di Google
I contatti di Google possono essere collegati a Thunderbird utilizzando il componente
aggiuntivo gContactSync.

4.10.3 Geal

Gcal puo essere impostato in una scheda di Thunderbird con i componenti aggiuntivi Lightning e

Google Calendar Tab. Pagina iniziale del calendario Lightning

4.10.4 Compiti

I task possono essere inclusi in Thunderbird selezionando la voce Tasks del calendario.

4.10.5 Google Earth

Il metodo piu semplice per installare Google Earth ¢ utilizzare MX Package Installer, dove si
trova nella sezione "Misc".

Esiste anche un metodo manuale che puo essere utile in alcune installazioni.
* Installare googleearth.package dai repo o direttamente dal repo di Google.

* Aprire un terminale e digitare:
pacchetto make-googleearth

* Una volta terminato, diventare root ¢ digitare:
dpkg -i googleearth*.deb

* Sullo schermo apparira un messaggio di errore relativo a problemi di dipendenza.
Correggetelo inserendo quest'ultimo comando (sempre come root):


https://store.steampowered.com/
http://www.pirules.org/addons/gcontactsync/
https://www.mozilla.org/en-US/projects/calendar/
https://www.google.co.uk/earth/download/gep/agree.html

apt-get -f installare

Ora finalmente Google Earth apparira nel Menu applicazioni > Internet.

410.6 Google Talk

Esiste un plugin per il browser chiamato google-talkplugin, disponibile nei repo di Google,

che consente di effettuare una chiamata vocale o video dal proprio account Gmail a un altro
utente Gmail. E stato sostituito da Google Duo, che puo essere eseguito direttamente da
Gmail aperto in un browser.

4.10.7 Google Drive

Esistono comodi strumenti che consentono l'accesso locale al vostro account GDrive.

* Una semplice applicazione gratuita chiamata Odrive si installa e funziona bene.

» L'applicazione proprietaria multipiattaforma Insync consente la sincronizzazione e
l'installazione selettiva su piu computer.

4.11 Bug, problemi e richieste

I bug sono errori in un programma o sistema informatico che producono risultati errati o
comportamenti anomali. Le "richieste" o "miglioramenti" sono aggiunte richieste dagli utenti,
sia come nuove applicazioni che come nuove funzionalitd per applicazioni esistenti. MX
Linux tratta queste richieste nel modo seguente:

* I bug vengono gestiti tramite il Bug Tracker di MX e antiX Linux.

* Le richieste possono essere fatte con un post nel Forum Bugs e Richieste, facendo

attenzione a fornire informazioni sull'hardware, sul sistema e altri dettagli.

* Gli sviluppatori e i membri della comunita risponderanno a questi messaggi con
domande, suggerimenti, ecc.

Bugzilla - Main Page

| IS0 (7] | Reports [N

Welcome to Bugzilla

s ey

File aBug Search Open a New Account Documentation

Enter a bug # or some search terms Quick Search



https://tools.google.com/dlpage/hangoutplugin
https://duo.google.com/
https://www.omgubuntu.co.uk/2019/02/odrive-google-drive-linux-client
https://www.insynchq.com/google-drive-linux
http://bugs.mxlinux.org/
https://us-bz3.devzing.com/mx_antix/
https://forum.mxlinux.org/viewforum.php?f=97

Figura 4-26: dashboard del bug manager



5 Gestione del software

5.1 Introduzione

5.1.1 Metodi

MX Linux offre due metodi complementari di gestione del software:
*  MX Package Installer (MXPI) per l'installazione/rimozione con un solo clic delle
applicazioni piu diffuse, nonché di quelle presenti in Debian Stable, MX Test Repo,

Debian Backports e nel repo Flatpaks. Vedere Sezione 3.2.11.

* Synaptic Package Manager, uno strumento grafico completo per tutta una serie di
azioni con i pacchetti Debian.

MXPI presenta una serie di vantaggi rispetto a Synaptic:
+  E molto piu veloce!

» Lascheda Applicazioni piu diffuse ¢ limitata ai pacchetti utilizzati piu di frequente, per
cui tutto ¢ facile da trovare.

» Installa correttamente alcuni pacchetti che altrimenti sono complicati da eseguire
correttamente (ad esempio, Wine).

* Include altre fonti oltre a Debian Stable in un'unica applicazione:
= Lanostra MX Test Repo con pacchetti piu recenti rispetto a quelli che Synaptic ha di default.
= Backport Debian.
= Flatpak, non disponibile in Synaptic.
Synaptic ha i suoi vantaggi:
* Dispone di un gran numero di filtri avanzati, come le sezioni (categorie), lo stato, ecc.
* Offre informazioni dettagliate su determinati pacchetti.

+  E molto facile aggiungere nuovi repository di software.



Questa sezione 5 si concentra su Synaptic, che ¢ il metodo consigliato ai principianti per gestire
1 pacchetti software al di 1a delle capacita di MX Package Installer. Verranno inoltre esaminati
altri metodi disponibili e che possono essere necessari in determinate situazioni.

5.1.2 Pacchetti

Le operazioni software in MX sono eseguite dietro le quinte attraverso il sistema Advanced
Package Tool (APT). Il software viene fornito sotto forma di pacchetto: un insieme discreto di

dati non eseguibili che include istruzioni per l'installazione da parte del gestore di pacchetti. I
pacchetti sono memorizzati su server chiamati repository (repo) e possono essere consultati,
scaricati e installati tramite uno speciale software client chiamato package manager.

La maggior parte dei pacchetti ha una o piu dipendenze, cio¢ uno o piu pacchetti che devono
essere installati per poter funzionare. Il sistema APT ¢ progettato per gestire automaticamente
le dipendenze; in altre parole, quando si tenta di installare un pacchetto le cui dipendenze non
sono gia installate, il gestore di pacchetti APT contrassegnera automaticamente anche tali
dipendenze per l'installazione. Puo succedere che queste dipendenze non possano essere
soddisfatte, impedendo 1'installazione di un pacchetto; segnalate questi problemi sul forum.

5.2 Depositi

I repository APT sono molto piu che semplici siti web con software scaricabile. I pacchetti sui
siti dei repository sono organizzati e indicizzati in modo speciale per essere consultati
attraverso un gestore di pacchetti, piuttosto che direttamente.

ATTENZIONE: non aggiungere altri repository alla cieca a MX Linux! Questo vale

in particolare per Debian Sid o per un PPA, che molto probabilmente rompera la vostra
installazione in modo irreparabile.

5.2.1 Repository standard

MX Linux ¢ dotato di una serie di repo abilitati che offrono sicurezza e possibilita di scelta. Se si
¢ alle prime armi con MX Linux (e soprattutto se si € alle prime armi con Linux), si raccomanda
di attenersi inizialmente ai repo predefiniti. Per ragioni di sicurezza, questi repo sono firmati
digitalmente, il che significa che 1 pacchetti sono autenticati con una chiave di crittografia per
assicurarne l'autenticita. Se si installano pacchetti da repository non Debian senza la chiave, si
otterra un avviso che non ¢ stato possibile autenticarli. Per eliminare questo avviso e assicurarsi
che le installazioni siano sicure, ¢ necessario installare le chiavi mancanti usando MX Fix GPG
keys.

L'aggiunta, l'attivazione/disattivazione, la rimozione e la modifica dei repository sono piu facili da
realizzare attraverso Synaptic, ma possono anche essere modificati a mano editando i file in
/etc/apt/ in un terminale root. In Synaptic, fare clic su Impostazioni > repo, quindi fare clic sul
pulsante Nuovo e aggiungere le informazioni. Le informazioni sui repo sono spesso fornite come
una singola riga, come questa:


https://en.wikipedia.org/wiki/APT_(Debian)
https://en.wikipedia.org/wiki/APT_(Debian)

deb http://mxrepo.com/mx/testrepo/ test di allungamento


http://mxrepo.com/mx/testrepo/

Fate attenzione alla posizione degli spazi, che separano le informazioni in quattro parti da

inserire in righe separate in Synaptic.

Enabled | Type | URI Di

L] deb nitp://security.debian.org/ st

[]  deb-src httpu/ftp.us.deblan.org/debian/ st ‘ Up ‘

(] deb http://deb.debian.org/debian/ st

% deb http://mxrepo.com/mx/repo/ st ‘ - ‘

Lown
| http://mxrepo.com/mx/testrepo/
% deb https://repo.skype.com/deb/ stq
| Binary (deb) b |

URL: | http://mxrepo.com/mx/testrepo/ ‘
Distribution: | stretch ‘
Section(s): |test ‘
| New H Delete ‘ ‘ Cancel H OK ‘

Figura 5-1: Repository, con il repo di test MX evidenziato

Alcuni depositi hanno etichette speciali:

* contrib, che dipendono o sono accessori a pacchetti non liberi.

* non liberi, che non soddisfano le linee guida Debian per il software libero (DFSG).
» sicurezza, che contengono solo aggiornamenti relativi alla sicurezza.

* backport, che contengono pacchetti di versioni piu recenti di Debian che sono stati
compilati a ritroso per Debian Stable (la versione con cui ¢ stato costruito MX) per

mantenere il sistema operativo aggiornato.
* MX, che contengono i pacchetti speciali che rendono MX cio che ¢.

L'elenco attuale dei repository MX standard ¢ conservato nella Wiki MX/antiX.

5.2.2 Repository della comunita

MX Linux ha i propri Repository comunitari con pacchetti che i nostri pacchettizzatori creano e
mantengono. Questi pacchetti sono distinti dai pacchetti MX ufficiali provenienti da Debian

Stable e contengono pacchetti provenienti da altre fonti:

* Backport Debian, da test o addirittura sperimentali


https://en.wikipedia.org/wiki/Debian_Free_Software_Guidelines
https://mxlinux.org/wiki/system/repos-mx-linux

» Lanostra distro sorella antiX
* Progetti indipendenti
*  Ospiti open-source come GitHub

I Repository della Comunita sono fondamentali per MX Linux, poiché consentono a un sistema
operativo basato su Debian Stable di rimanere al passo con gli sviluppi software piu importanti.

Oltre al repo MX Main, il repo MX Test ha lo scopo di ottenere il feedback degli utenti prima
che 1 nuovi pacchetti vengano spostati nel Main. Il modo piu semplice di installare da MX Test
¢ con I'MX Package Installer (Sezione 3.2), che gestisce automaticamente molti passaggi.

Per saperne di piu su cid che ¢ disponibile, su chi sono i confezionatori e su come partecipare,
consultate il sito MX Community Packaging Project.

5.2.3 Repository dedicati

Oltre ai repository generali come Debian, MX e Community, esiste anche un certo numero di
repository dedicati associati a una singola applicazione. Quando si aggiunge uno di questi,
direttamente o tramite Synaptic, si ricevono gli aggiornamenti. Alcuni sono precaricati ma non
abilitati, altri li aggiungerete voi stessi.

Ecco un esempio comune (VirtualBox):
deb https://download.virtualbox.org/virtualbox/debian/stable contrib
I nuovi utenti che provengono da Ubuntu o da uno dei suoi derivati spesso chiedono

informazioni sui repository PPA; Ubuntu si discosta dalla Debian standard, quindi tali
repository devono essere trattati con cautela. Consultare il Wiki MX/antiX.

5.2.4 Repository di sviluppo

Esiste un'ultima categoria di repository per acquisire la versione piu recente (e quindi meno
stabile) di un'applicazione. Questo avviene attraverso un sistema di controllo di versione come
Git, che puo essere consultato dall'utente finale per rimanere aggiornato sullo sviluppo. Una
copia del codice sorgente dell'applicazione puo essere scaricata in una directory su un computer
locale. I repository software sono un metodo comodo per gestire 1 progetti utilizzando Git, e MX
Linux mantiene la maggior parte del suo codice nel proprio repo GitHub.

Altro: Wikipedia: Repository di software

5.2.5 Specchi

I repository MX Linux, sia per i pacchetti che per le ISO, sono "mirrorati" su server in diversi
siti nel mondo; lo stesso vale per i repository Debian. Questi siti di mirroring forniscono piu
fonti di


https://antixlinux.com/
https://en.wikipedia.org/wiki/GitHub
https://mxlinux.org/community-repos/
https://mxlinux.org/wiki/system/add-ppa-repository
https://github.com/MX-Linux
http://en.wikipedia.org/wiki/Software_repository

e funzionano per ridurre i tempi di download, migliorare 1'affidabilita e fornire una certa
resilienza in caso di guasto del server. Durante l'installazione, il mirror piu probabile viene
selezionato automaticamente in base alla posizione e alla lingua. Ma 1'utente puo avere motivi
per preferirne un altro:

* In alcuni casi, l'assegnazione automatica al momento dell'installazione puo essere errata.

* L'utente puo cambiare la residenza

* Potrebbe essere disponibile un nuovo specchio molto piu vicino, piu veloce o piu affidabile.
* Un mirror esistente pud modificare il proprio URL

* Lo specchio utilizzato potrebbe diventare inaffidabile o andare offline.

MX Repo Manager (Sezione 3.2) semplifica il cambio di mirror, consentendo di scegliere quello
piu adatto alle proprie esigenze. Assicuratevi di prendere nota del pulsante che seleziona il
mirror piu veloce per la vostra posizione.

5.3 Sinaptico

La seguente sezione cerca di fornire una panoramica aggiornata sull'uso di Synaptic. Si noti che
¢ richiesta la password di root e, naturalmente, ¢ necessario essere connessi a Internet.

5.3.1 Installazione e rimozione dei pacchetti

Installazione

Ecco i passi fondamentali per 1'installazione del software in Synaptic:

 Fate clic sul menu Start > Sistema > Synaptic Package Manager, fornendo
la password di root se richiesto.

* Premete il pulsante Ricarica. Questo pulsante fa si che Synaptic contatti i server dei
repository online e scarichi un nuovo file di indice con informazioni sui pacchetti
disponibili, sulle loro versioni e sugli altri pacchetti necessari per la loro
installazione. Se viene visualizzato un messaggio che indica che alcuni repository
non sono stati contattati, attendere un minuto e riprovare.

» Se si conosce gia il nome del pacchetto che si sta cercando, basta fare clic nel riquadro
a destra e iniziare a digitare; Synaptic effettuera una ricerca incrementale durante la
digitazione.

* Se non conoscete il nome del pacchetto, usate la casella di ricerca nell'angolo in alto
a destra per trovare il software in base al nome o a parole chiave. Questo ¢ uno dei
maggiori vantaggi di Synaptic rispetto ad altri metodi.



* In alternativa, utilizzare uno dei pulsanti di filtro nell'angolo in basso a sinistra:

* Le sezioni forniscono sottoaree come Editori, Giochi e divertimenti, Utilita,
ecc. Nel riquadro inferiore ¢ presente una descrizione di ogni pacchetto e si
possono utilizzare le schede per scoprire ulteriori informazioni.

* Lo stato raggruppa i pacchetti in base alla loro situazione di installazione.
* Origin mostrera i pacchetti di un repository specifico.
[ filtri personalizzati offrono diverse opzioni di filtro

* Risultati della ricerca mostra un elenco di ricerche precedenti per la
sessione di Synaptic in cui ci si trova.

» Fate clic sulla casella vuota all'estremita sinistra del pacchetto desiderato e
selezionate Segna per l'installazione nella schermata a comparsa. Se il pacchetto ha
delle dipendenze, ne riceverete notifica e anche queste verranno automaticamente
contrassegnate per l'installazione. Potete anche fare doppio clic sul pacchetto se ¢
l'unico che state installando.

* Alcuni pacchetti hanno anche dei pacchetti "Consigliati" e "Suggeriti" che possono
essere visualizzati facendo clic con il tasto destro del mouse sul nome del
pacchetto. Si tratta di pacchetti aggiuntivi che aggiungono funzionalita al pacchetto
selezionato e che ¢ bene consultare.

» Fare clic su Applica per avviare l'installazione. Potete tranquillamente ignorare
qualsiasi messaggio di avviso: "Si sta per installare un software che non puo
essere autenticato!".

» Potrebbero esserci ulteriori passaggi: seguite le indicazioni che vi vengono fornite
fino al completamento dell'installazione.



Figura 5-2: Controllo dei pacchetti consigliati durante l'installazione dei pacchetti.



Rimozione

La rimozione del software dal sistema con Synaptic sembra semplice come l'installazione, ma

c'€ molto di piu di quello che si vede:

Per rimuovere un pacchetto, ¢ sufficiente fare clic sulla stessa casella dell'installazione
e selezionare Segna per la rimozione o Segna per la rimozione completa.

* La rimozione disinstalla il software, ma lascia i file di configurazione del
sistema nel caso in cui si vogliano mantenere le impostazioni.

* La Rimozione completa rimuove il software e anche i file di configurazione
del sistema (epurazione). I file di configurazione personali relativi al pacchetto
non verranno rimossi. Verificate anche la presenza di altri resti di file di
configurazione nella categoria Non installato di Synaptic (configurazione
residua).

Se ci sono altri programmi che dipendono dal pacchetto che viene rimosso, anche
questi pacchetti dovranno essere rimossi. Questo accade solitamente quando si
rimuovono librerie software, servizi o applicazioni a riga di comando che fungono
da back-end per altre applicazioni. Assicuratevi di leggere attentamente il riepilogo
fornito da Synaptic prima di fare clic su OK.

La rimozione di applicazioni di grandi dimensioni composte da molti pacchetti puo
comportare delle complicazioni. Spesso questi pacchetti vengono installati usando un
meta-pacchetto, che ¢ un pacchetto vuoto che dipende semplicemente da tutti 1
pacchetti necessari per 1'applicazione. Il modo migliore per rimuovere un pacchetto
complicato come questo ¢ ispezionare l'elenco delle dipendenze del meta-pacchetto e
rimuovere 1 pacchetti elencati. Fate attenzione, pero, a non disinstallare una
dipendenza di un'altra applicazione che volete mantenere!

E possibile che la categoria di stato Rimuovibile automaticamente inizi ad accumulare
pacchetti. Questi sono stati installati da altri pacchetti e non sono piu necessari, quindi
si puo fare clic su questa categoria di stato, evidenziare tutti i pacchetti nel riquadro di
destra e quindi fare clic con il pulsante destro del mouse per rimuoverli. Assicuratevi

di esaminare attentamente 1'elenco quando appare la casella di verifica, perché a volte

potreste scoprire che le dipendenze elencate per la rimozione includono pacchetti che
in realta volete mantenere. Se non si € sicuri, si puo usare apt -s autoremove per fare
una prova simulata (= I'opzione -s).



Figura 5-3: Preparazione per lo svuotamento dei pacchetti rimovibili.
5.3.2 Aggiornamento e declassamento

Synaptic consente di mantenere aggiornato il sistema in modo rapido e pratico.

Aggiornamento

A meno che non si utilizzi un metodo manuale in Synaptic o un terminale, 'aggiornamento viene
di solito attivato da un cambiamento nell'icona di MX Updater nell'area di notifica (default: la
casella vuota diventa verde). Ci sono due modi per procedere quando appare questa freccia.

» Fare clic con il tasto sinistro del mouse sull'icona. Questo ¢ il metodo piu veloce
perché non ¢ necessario attendere il caricamento del software, 1'esecuzione, ecc. Viene
visualizzata una finestra di terminale con i pacchetti da aggiornare; esaminateli
attentamente, quindi fate clic su OK per completare il processo.

» Fare clic con il tasto destro del mouse sull'icona per utilizzare Synaptic.

 Fate clic sull'icona Contrassegna tutti gli aggiornamenti sotto la barra dei
menu per selezionare tutti i pacchetti disponibili per 1'aggiornamento,
oppure fate clic sul collegamento Installato (aggiornabile) nel pannello di
sinistra per esaminare i pacchetti o per selezionare gli aggiornamenti
singolarmente.

» Fare clic su Applica per iniziare l'aggiornamento, ignorando il messaggio
di avvertimento. All'inizio del processo di installazione, ¢ possibile
osservare i dettagli in un terminale all'interno di Synaptic.

* Con alcuni aggiornamenti di pacchetti, potrebbe essere richiesto di confermare una
finestra di dialogo, di inserire informazioni di configurazione o di decidere se
sovrascrivere o meno un file di configurazione modificato. Prestate attenzione e
seguite le richieste fino al completamento dell'aggiornamento.

Declassamento

A volte si puo desiderare di eseguire il downgrade di un'applicazione a una versione



precedente, ad esempio a causa di problemi sorti con quella nuova. Questo ¢ facile da fare con
Synaptic:



1. Aprire Synaptic, fornire la password di root e fare clic su Reload.

2. Fate clic su Installato nel pannello a sinistra, quindi trovate ed evidenziate il
pacchetto che volete declassare nel pannello a destra.

3. Nella barra dei menu, fate clic su Pacchetto > Forza versione...

4. Selezionare una delle versioni disponibili nell'elenco a discesa. Potrebbero non
esserci opzioni disponibili.

5. Fare clic su Forza versione, quindi installare nel modo consueto.

6. Per evitare che la versione inferiore venga immediatamente aggiornata di nuovo, ¢ necessario
bloccarla.

Figura 5-4: Utilizzo di Forza versione per eseguire il downgrade di un pacchetto
Appuntatura

A volte si puo desiderare di bloccare un'applicazione a una versione specifica per evitare che
venga aggiornata e che si verifichino problemi con quelle piu recenti. E facile da fare:

1. Aprire Synaptic, fornire la password di root e fare clic su Reload.

2. Fate clic su Installato nel pannello a sinistra, quindi trovate ed evidenziate il
pacchetto che desiderate appuntare nel pannello a destra.

3. Nella barra dei menu, fare clic su Pacchetto > Blocca versione...
4. Synaptic evidenziera il pacchetto in rosso e aggiungera un'icona di blocco alla prima colonna.

5. Per sbloccare, evidenziate nuovamente il pacchetto e fate clic su Pacchetto > Blocca
versione (che avra un segno di spunta).



6. Sinoti che il pinning tramite Synaptic non impedisce I'aggiornamento del
pacchetto quando si usa la riga di comando.

5.4 Risoluzione dei problemi

Synaptic ¢ molto affidabile, ma a volte pud capitare di ricevere un messaggio di errore. Una
trattazione completa di questi messaggi si trova nella Wiki MX/antiX, quindi in questa sede ci

limiteremo a citare un paio dei piu comuni.

* Viene visualizzato un messaggio che indica che alcuni repo non sono riusciti a
scaricare le informazioni del repository. Di solito si tratta di un evento transitorio ed
¢ sufficiente attendere e ricaricare; oppure si pud usare MX Repo Manger per
cambiare repository.

* Se l'installazione di un pacchetto mostra che il software che si desidera conservare
verra rimosso, fare clic su Annulla per annullare 1'operazione.

* Puo accadere che con un nuovo repository si veda un messaggio di errore dopo il
ricaricamento che dice qualcosa come: W: Errore GPG: [URL di qualche repository]
Release: Non ¢ stato possibile verificare le seguenti firme. Questo messaggio appare
perché apt include l'autenticazione dei pacchetti per migliorare la sicurezza e la chiave
non ¢ presente. Per risolvere il problema, fare clic sul menu Start > Sistema > MX
Correggi chiavi GPG e seguire le istruzioni. Se non viene trovata alcuna chiave,
chiedere nel forum.

* Occasionalmente, i pacchetti non si installano perché i loro script di installazione
falliscono uno o piu controlli di sicurezza; per esempio, un pacchetto potrebbe tentare
di sovrascrivere un file che fa parte di un altro pacchetto o richiedere il downgrade di
un altro pacchetto a causa delle dipendenze. Se un'installazione o un aggiornamento si
blocca su uno di questi errori, si parla di pacchetto "rotto". Per risolvere il problema,
fate clic sulla voce Pacchetti rotti nel pannello di sinistra. Evidenziate il pacchetto e
provate a risolvere il problema facendo clic su Modifica > Correggi pacchetti rotti. Se
non si riesce a risolvere il problema, fate clic con il tasto destro del mouse sul
pacchetto per deselezionarlo o disinstallarlo.

* Durante l'installazione o la disinstallazione, a volte appaiono messaggi importanti
sul processo:

 Disinstallare? Occasionalmente, i conflitti nelle dipendenze dei pacchetti
possono indurre il sistema APT a disinstallare un gran numero di pacchetti
importanti per installarne altri. Questo € raro con la configurazione
predefinita, ma diventa sempre piu probabile con I'aggiunta di repo non
supportati. Fate MOLTA ATTENZIONE quando l'installazione di un
pacchetto richiede la rimozione di altri! Se un gran numero di pacchetti deve
essere rimosso, si consiglia di studiare un altro metodo di installazione di


https://mxlinux.org/wiki/applications-system/synaptic-errors

questa applicazione.



* Mantenere? Durante 1'aggiornamento, a volte si viene informati che ¢
disponibile un nuovo file di configurazione per un certo pacchetto e viene
chiesto se si vuole installare la nuova versione o mantenere quella attuale.

* Se il pacchetto in questione proviene da un repository MX, si
raccomanda di "installare la versione del manutentore".

* Altrimenti, rispondere "mantenere la versione attuale" (N), che ¢
anche la scelta predefinita.

5.5 Altri metodi

5.5.1 Attitudine

Aptitude ¢ un gestore di pacchetti che puo essere usato al posto di apt o Synaptic. E disponibile
nei repo ed ¢ particolarmente utile quando si presentano problemi di dipendenza. Puo essere
eseguito come CLI diretta o come GUI primitiva.

Figura 5-5: Schermata iniziale di Aptitude (GUI), che mostra il risolutore di dipendenze.

Per maggiori dettagli su questa opzione, consultare il Wiki MX/antiX.

5.5.2 Pacchetti Deb

I pacchetti software installati tramite Synaptic (e APT dietro di esso) sono in un formato
chiamato deb (abbreviazione di Debian, la distribuzione Linux che ha ideato APT). E possibile
installare manualmente 1 pacchetti deb scaricati utilizzando lo strumento grafico Gdebi o lo
strumento a riga di comando dpkg. Si tratta di strumenti semplici per installare pacchetti deb
locali. NOTA: se le dipendenze non possono essere soddisfatte, si ricevera un avviso e il
programma si fermera.


https://mxlinux.org/wiki/applications-system/aptitude

Figura 5-6: Gdebi pronto per l'installazione.
Installazione di file *.deb con Gdebi

1. Navigare fino al pacchetto deb che si desidera installare (in genere nella cartella
Download) e fare clic su di esso. Gdebi aprira la finestra di dialogo per
l'installazione.

2. Fare clic su Installa.
3. Quando viene richiesto, inserire la password di root.
4. Gdebi tentera di installare il pacchetto e ne riportera i risultati.

Installazione di file *.deb con dpkg

1. Navigare nella cartella contenente il pacchetto deb che si desidera installare.

2. Fare clic con il tasto destro del mouse su uno spazio vuoto per aprire un terminale e
diventare root. In alternativa, fate clic sulla freccia per salire di livello e fate clic con
il pulsante destro del mouse sulla cartella con il pacchetto deb > Apri Thunar qui.

3. Installate il pacchetto con il comando (sostituendo ovviamente il nome reale del pacchetto):

dpkg -i packagename.deb

4. Se si installano piu pacchetti contemporaneamente nella stessa directory (ad
esempio se si installa manualmente Libreoffice), si puo fare tutto in una volta
usando:

dpkg -i *.deb

NOTA: In un comando di shell, I'asterisco € un carattere jolly nell'argomento. In questo
caso, il programma applichera il comando a qualsiasi file il cui nome finisca con .deb.



5. Se le dipendenze necessarie non sono gia installate sul sistema, si otterranno errori di
dipendenze non soddisfatte, poiché dpkg non se ne occupa automaticamente. Per
correggere questi errori e terminare 'installazione, eseguire questo codice per forzare
l'installazione:

apt -f installare

6. apt cerchera di correggere la situazione installando le dipendenze necessarie (se sono
disponibili nei repo) o rimuovendo 1 file .deb (se le dipendenze non possono essere
installate).

NOTA: il comando utilizzato al punto 5 riflette la modifica del nome precedente.
apt-get.

5.5.3 Pacchetti autonomi

Lanciatori e appimages

Appimages, flatpaks e snaps sono pacchetti autonomi che non hanno bisogno di essere installati

nel senso usuale del termine. Si tenga presente che questi pacchetti non sono stati testati da
Debian o0 MX Linux, quindi potrebbero non funzionare come previsto.

* Appimages: ¢ sufficiente scaricarle, spostarle in /opt (consigliato) e renderle
eseguibili con un clic destro > Permessi.

* Flatpaks: utilizzare MXPI per ottenere le applicazioni da flathub.

* Snaps. Inaffidabile su MX Linux, a meno che l'utente non abbia avviato systemd. La
soluzione e i dettagli sono riportati nel riferimento Wiki qui sotto.

Uno dei grandi vantaggi dei pacchetti autocontenuti ¢ che qualsiasi software aggiuntivo di
cui hanno bisogno ¢ incluso e quindi non avra un impatto negativo sul software gia
installato. Questo li rende anche molto piu grandi dei tradizionali pacchetti installati.

AIUTO: la Wiki MX/antiX

5.5.4 Metodi CLI

E ugualmente possibile usare la riga di comando per installare, rimuovere, aggiornare, cambiare
repository e in generale per gestire i pacchetti. Invece di lanciare Synaptic per eseguire
operazioni comuni.

Tabella 5: Comandi comuni per la gestione dei pacchetti

Comando Azione



https://www.youtube.com/watch?v=RIvEMLWnkAU&t=3s
http://appimage.org/
https://en.wikipedia.org/wiki/Flatpak
https://snapcraft.io/
https://flathub.org/
https://mxlinux.org/wiki/system/self-contained-packages

apt install packagename Installare un determinato pacchetto




apt rimuove il nome del Rimuovere un determinato pacchetto
pacchetto
apt purge packagename Rimuovere completamente un pacchetto (ma non la
configurazione/dati in /home)
apt autoremove Sgombero dei pacchi rimasti dopo un trasloco
aggiornamento apt Aggiornare 1'elenco dei pacchetti dai repo
aggiornamento apt Installare tutti gli aggiornamenti disponibili
apt dist-upgrade Gestire in modo intelligente la modifica delle dipendenze con le
nuove versioni dei pacchetti

5.5.5 Altri metodi di installazione

Prima o poi alcuni software che si desidera installare non saranno disponibili nei repo e
potrebbe essere necessario utilizzare altri metodi di installazione. Questi metodi includono:

* Blob. A volte cio che si desidera non ¢ un pacchetto installabile, ma un "blob" o una
raccolta precompilata, non ".deb", di dati binari memorizzati come un'unica entita,
soprattutto se di origine chiusa. Tali blob si trovano tipicamente nella directory /opt.
Esempi comuni sono Firefox, Thunderbird e LibreOffice. Ad esempio, per installare
la versione piu recente di LibreOffice:

* Ricerca sul web "libreoffice download ultima versione".
Fare clic su:
https://www.libreoffice.org/download/download/

* Selezionare la versione desiderata, il sistema operativo (ad esempio, Linux
x64) e il formato del pacchetto (deb).

* Cliccate sul pulsante di download; poiché lo uso sempre, faccio sempre
una piccola donazione.

* Una volta completato il download, andate nella cartella Download e fate
clic con 1l tasto destro del mouse sull'archivio LibreOffice xxx > Estrai qui

* Fare clic sulla cartella estratta, quindi fare clic con il pulsante destro del
mouse sulla cartella DEBS > Apri terminale qui

* Inserire questo codice
sudo dpkg -i *.deb
* Ora ¢ installato e disponibile nella categoria Office del menu.

* Probabilmente si vorra rimuovere la versione precedente, cosa che si puo fare
usando Synaptic per selezionare e rimuovere libreoffice-core, che portera con
sé 1l resto. Assicuratevi di non rimuovere la nuova versione!


http://www.libreoffice.org/download/download/

* Create un launcher aprendo il menu Start e facendo clic con il pulsante
destro del mouse sulla voce LibreOffice semplice > Aggiungi al
pannello (oppure: Aggiungi al desktop).

* Pacchetti RPM: Alcune distribuzioni di Linux utilizzano il sistema di pacchetti RPM.
I pacchetti RPM sono simili ai pacchetti deb sotto molti aspetti ed esiste un
programma a riga di comando disponibile da MX Linux per convertire i pacchetti
RPM in deb, chiamato alien. Non viene installato con MX Linux, ma ¢ disponibile
nei repo predefiniti. Dopo averlo installato sul vostro sistema, potete usarlo per
installare un pacchetto rpm con questo comando (come root): alien -i
packagename.rpm. In questo modo verra inserito un file deb con lo stesso nome
nella posizione del file rpm, che si potra poi installare come descritto sopra. Per
informazioni piu dettagliate su alien, consultare la versione Internet della sua pagina
man nella sezione Link in fondo a questa pagina.

* Codice sorgente: Qualsiasi programma open-source puo essere compilato dal codice
sorgente originale del programmatore, se non c¢'¢ altra possibilita. In circostanze ideali,
si tratta di un'operazione piuttosto semplice, ma a volte si pud incorrere in errori che
richiedono maggiore abilita per essere risolti. I sorgenti sono solitamente distribuiti
come tarball (file tar.gz o tar.bz2). La soluzione migliore ¢ di solito quella di fare una
richiesta di pacchetti sul forum, ma si veda la sezione Collegamenti per un tutorial
sulla compilazione dei programmi.

* Varie: Molti sviluppatori di software confezionano il software in modo personalizzato,
di solito distribuito come tarball o file zip. Possono contenere script di installazione,
file binari pronti per I'esecuzione o programmi di installazione binari simili ai
programmi setup.exe di Windows. In Linux, il programma di installazione termina
spesso con .bin. Google Earth, ad esempio, viene spesso distribuito in questo modo. In
caso di dubbio, consultare le istruzioni di installazione fornite con il software.

5.5.6 Collegamenti

e Wiki MX/antiX: Errori sinaptici

*  Wiki MX/antiX: Installazione del software

e Wiki MX/antiX: Compilazione

* (Gdebi

e (Gl strumenti di gestione dei pacchetti Debian

» Strumenti di gestione dei pacchetti Debian

e Guida APT Debian



https://mxlinux.org/wiki/applications-system/synaptic-errors
https://mxlinux.org/wiki/system/installing-software
https://mxlinux.org/wiki/system/compiling
https://launchpad.net/gdebi
http://www.debian.org/doc/FAQ/ch-pkgtools.en.html
https://www.debian.org/doc/manuals/apt-guide/ch2.en.html

e Guida APT Debian



https://www.debian.org/doc/manuals/apt-guide/ch2.en.html

e Wikipedia: Alieno



https://en.wikipedia.org/wiki/Alien_(software)

6 Uso avanzato

6.1 Programmi Windows sotto MX Linux

Esiste un certo numero di applicazioni, sia open-source che commerciali, che permettono di
eseguire le applicazioni Windows sotto MX Linux. (Quando ¢ coinvolta solo una particolare
applicazione, si parla di wrapper, ad esempio NDISwrapper). Si tratta di emulatori, cio¢
replicano le funzioni di Windows su una piattaforma Linux. Molte applicazioni MS Office,
giochi e altri programmi possono essere eseguiti con un emulatore con vari gradi di successo che
vanno dalla velocita e funzionalita quasi nativa alle prestazioni di base.

6.1.1 Open-source

Wine ¢ il principale emulatore open-source di Windows per MX Linux. E una sorta di livello di
compatibilita per l'esecuzione di programmi Windows, ma non richiede Microsoft Windows
per eseguire le applicazioni. E meglio installarlo tramite MX Package Installer (sotto Misc); se

si installa con Synaptic, selezionare "winehq-staging" per ottenere tutti i pacchetti wine-staging.
Le versioni di Wine vengono rapidamente impacchettate dai membri del Community
Repository e rese disponibili agli utenti, con l'ultima versione proveniente dal repo di test.

NOTA: Per poter eseguire Wine durante l'esecuzione di Live, ¢ necessario utilizzare la
persistenza della casa (Sezione 6.6.3).

¢ Home page del vino

* Wiki MX/antiX: Vino

DOSBox crea un ambiente simile al DOS per I'esecuzione di programmi basati su MS-DOS, in
particolare giochi per computer.

« DOSBox homepage

*  Wiki DOSBox

DOSEMU ¢ un software disponibile nei repo che permette di avviare il DOS in una macchina
virtuale, rendendo possibile l'esecuzione di Windows 3.1, Word Perfect per DOS, DOOM, ecc.

¢ Pagina iniziale di DOSEMU

*  Wiki MX/antiX: DOSEMU



https://en.wikipedia.org/wiki/NDISwrapper
https://wine-staging.com/
http://www.winehq.org/
https://mxlinux.org/wiki/system/wine
http://dosbox.sourceforge.net/
http://dosbox.sourceforge.net/wiki
http://www.dosemu.org/
https://mxlinux.org/wiki/system/dosemu

Figura 6-1: Photoshop 5.5 in esecuzione sotto Wine
6.1.2 Commerciale

CrossOver Office consente di installare molte applicazioni di produttivita, plugin e giochi
Windows in Linux, senza bisogno di una licenza del sistema operativo Microsoft. Supporta
particolarmente bene Microsoft Word, Excel e PowerPoint (fino al 2003).

¢ Pagina iniziale di CrossOver Linux

e Wikipedia: Crossover

¢ Compatibilita delle applicazioni

Collegamenti

¢  Wikipedia: Emulatore

¢  Emulatori DOS

6.2 Macchine virtuali

Le applicazioni per macchine virtuali sono una classe di programmi che simulano un computer
virtuale in memoria, consentendo di eseguire qualsiasi sistema operativo sulla macchina. E utile
per effettuare test, eseguire applicazioni non native e dare agli utenti la sensazione di avere una
macchina propria. Molti utenti di MX Linux utilizzano il software della macchina virtuale per
eseguire Microsoft Windows "in una finestra", in modo da poter accedere senza problemi al
software scritto per Windows sul proprio desktop. Viene anche utilizzato per i test per evitare
l'installazione.


http://www.codeweavers.com/products/cxoffice
http://en.wikipedia.org/wiki/CrossOver
http://www.codeweavers.com/compatibility/browse/rank
http://en.wikipedia.org/wiki/Emulator
https://mxlinux.org/wiki/system/dosemu/

6.2.1 Impostazione

Virtual Box: impostare una cartella condivisa (14.4)

Esistono numerose applicazioni software per macchine virtuali per Linux, sia open-source che
proprietarie. MX rende particolarmente facile 1'uso di VirtualBox (VB), per cui ci
concentreremo su di esso. Per i dettagli e gli sviluppi piu recenti, vedere la sezione Link qui
sotto. Ecco una panoramica dei passi fondamentali per configurare ed eseguire VirtualBox:

+ Installazione. E preferibile farlo tramite il programma di installazione dei pacchetti
MX, dove VB appare nella sezione Misc. In questo modo si abilita il repository VB, si
scarica e si installa 1'ultima versione di VB. Il repository rimarra abilitato, consentendo
gli aggiornamenti automatici tramite MX Updater.

* 64 bit. Per eseguire un guest a 64 bit, VB richiede il supporto della virtualizzazione
hardware, le cui impostazioni (se esistono) si trovano nel BIOS. I dettagli nel manuale
di VB.

* Riavviare. E buona norma lasciare che VB si configuri completamente riavviando dopo l'installazione.

* Post-installazione. Verificare che 1'utente appartenga al gruppo vboxusers. Aprite MX
User Manager > scheda Group Membership. Selezionate il vostro nome utente e
assicuratevi che 'vboxusers' nell'elenco dei gruppi sia spuntato. Confermare e uscire.

* Pacchetto estensioni. Se si installa VB dal programma di installazione dei pacchetti
MX, I'Extension Pack sara incluso automaticamente. Altrimenti, ¢ necessario scaricarlo
e installarlo dal sito web di Oracle (vedere Collegamenti). Una volta scaricato il file, ¢
necessario navigare al suo interno con Thunar e fare clic sull'icona del file. L'Extension
Pack aprira VB e si installera automaticamente.

* Posizione. I file della macchina virtuale sono memorizzati per impostazione predefinita
nella cartella /home. Possono essere piuttosto grandi e, se si dispone di una partizione
dati separata, si pud prendere in considerazione 1'idea di creare li la cartella predefinita.
Andare su File > Preferenze > scheda Generale e modificare la posizione della cartella.


https://www.youtube.com/watch?v=adpalUl4LqI
https://www.virtualbox.org/wiki/VirtualBox
https://www.virtualbox.org/manual/ch03.html#intro-64bitguests
https://www.virtualbox.org/manual/ch03.html#intro-64bitguests

Figura 6-2: Windows 2000 in esecuzione in VirtualBox

6.2.2 Utilizzo

Creare una macchina virtuale. Per creare una macchina virtuale, avviare VB e fare clic
sull'icona Nuovo nella barra degli strumenti. E necessario un CD di Windows o una ISO
di Linux (solo a 32 bit). Seguite la procedura guidata, accettando tutte le impostazioni
suggerite, a meno che non sappiate fare di meglio - potete sempre modificarle in seguito.
Se la vostra ISO ha il PAE, fate clic sulla scheda Sistema > Opzioni e abilitatelo.
Potrebbe essere necessario aumentare la memoria allocata al Guest oltre il valore minimo
predefinito, lasciando comunque una quantita di memoria sufficiente per il sistema
operativo Host. Per gli Ospiti Windows, si consiglia di creare un HD virtuale piu grande
di quello predefinito di 10 GB: ¢ possibile aumentare le dimensioni in un secondo
momento, ma non ¢ una procedura semplice. Selezionare un'unita host o un file disco
CD/DVD virtuale

Selezionare un punto di montaggio. Una volta configurata la macchina, ¢ possibile
selezionare il punto di montaggio come unita host o come file disco CD/DVD virtuale
(ISO). Fare clic su Impostazioni > Archiviazione e si aprira una finestra di dialogo in
cui si vedra al centro una struttura di archiviazione con un controller IDE e un controller
SATA sotto di esso. Facendo clic sull'icona dell'unita CD/DVD nella struttura di
memorizzazione, si vedra apparire l'icona dell'unita CD/DVD nella sezione Attributi sul
lato destro della finestra. Facendo clic sull'icona dell'unita CD/DVD nella sezione
Attributi, si apre un menu a discesa in cui ¢ possibile assegnare 1'unita host o un file di
disco CD/DVD virtuale (ISO) da montare sull'unita CD/DVD. (E possibile selezionare
un file ISO diverso facendo clic su Scegli un file disco CD/DVD virtuale e navigando
fino al file). Eseguire la macchina. Il dispositivo selezionato (ISO o CD/DVD) verra
montato all'avvio della macchina virtuale e il sistema operativo potra essere installato.

GuestAdditions. Una volta installato il sistema operativo guest, assicurarsi di installare



VB GuestAdditions avviando il sistema operativo guest, quindi fare clic su Dispositivi >
Inserisci GuestAdditions e puntare verso la ISO che verra individuata automaticamente.
In questo modo ¢ possibile abilitare la condivisione di file tra Guest e Host e regolare la
visualizzazione in vari modi per adattarla alle esigenze del sistema.



il vostro ambiente e le vostre abitudini. Se l'applicazione non ¢ in grado di individuarla,
potrebbe essere necessario installare il pacchetto virtualbox-guest-additions (viene
fatto automaticamente se si utilizza Package Installer).

Spostamento. Il modo piu sicuro per spostare o modificare le impostazioni di una
macchina virtuale esistente ¢ clonarla: fare clic con il pulsante destro del mouse sul
nome di una macchina esistente > Clona e compilare le informazioni. Per utilizzare il
nuovo clone, creare una nuova macchina virtuale e nella procedura guidata, quando si
seleziona il disco rigido, scegliere "Usa il disco rigido esistente" e selezionare il nuovo
clone.

File *.vdi.

Documentazione. La documentazione dettagliata di VB ¢ disponibile attraverso la
Guida nella barra dei menu o in formato PDF dal sito web.

File Machine Help
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Graphics Controller: VMSVGA
Remote Desktop Server: Disabled
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Storage

Controller: IDE
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Controller: SATA
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Figura 6-3: Schermata delle impostazioni per MX-19.1 in VirtualBox

Collegamenti

Wikipedia: Macchina virtuale

Wikipedia: Confronto tra software per macchine virtuali

Pagina iniziale di VirtualBox

Pacchetto di estensioni per VirtualBox
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6.3 Gestori di finestre alternativi

Figura 6-4: MATE in esecuzione su MX-15 Linux, con il browser YouTube aperto

Un window manager (originariamente WIMP: Window, Icon, Menu, and Pointing device) in
Linux ¢ essenzialmente il componente che controlla I'aspetto delle interfacce grafiche e fornisce

1 mezzi con cui l'utente puo interagire con esse.

Le tre versioni di MX Linux utilizzano Xfce, KDE o Fluxbox per definizione. Ma per gli utenti
esistono altre possibilita. MX Linux semplifica l'installazione di molte alternative popolari
attraverso 'MX Package Installer, come descritto di seguito.

* Budgie Desktop, un desktop semplice ed elegante che utilizza GTK+.

¢ Budgie Desktop

*  Compiz, un WM OpenGL con compositing.

e QGestore di finestre Compix

* Gnome Base, un display manager e un desktop basato su GTK+ che fornisce un
ambiente desktop ultraleggero.

e Gnome Ultra (GOULD), un ambiente desktop ultraleggero

» KDES Standard, un ambiente molto ampio e potente adattato all'ambiente MX
Linux. Vedere il Wiki MX/antiX.

e Pagina iniziale di KDE
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* LXDE ¢ un ambiente desktop veloce e leggero i cui componenti possono essere
installati separatamente.

* Pagina iniziale di LXDE

* MATE ¢ la continuazione di GNOME 2 e offre un ambiente desktop intuitivo e
attraente.

e Pagina iniziale di MATE

* IceWM ¢ un ambiente desktop all-in-one molto leggero e un gestore di finestre
impilabili.

e Pagina iniziale di IceWM

Una volta installato, ¢ possibile scegliere il gestore di finestre desiderato dal pulsante Sessione
nell'angolo in alto a destra della barra superiore della schermata di accesso predefinita; accedere
come si farebbe normalmente. Se si sostituisce il gestore di accesso con un altro dai repo,
assicurarsi di averne sempre almeno uno disponibile al riavvio.

ALTRO: Wikipedia: Gestori di finestre X

6.4 Linea di comando

Sebbene MX offra una serie completa di strumenti grafici per l'installazione, la configurazione e
l'utilizzo del sistema, la riga di comando (chiamata anche console, terminale, BASH o shell) ¢
ancora uno strumento utile e talvolta indispensabile. Ecco alcuni usi comuni:

* Avviare un'applicazione GUI per vedere 'output degli errori.
* Velocizzare le attivita di amministrazione del sistema.

» Configurare o installare applicazioni software avanzate.

* Eseguire piu attivita in modo rapido e semplice.

* Risoluzione dei problemi dei dispositivi hardware.

Il programma predefinito per eseguire un terminale in una finestra del desktop MX ¢ XFCE
Terminal, che si trova nel menu Start > Sistema > Xfce Terminal (emulatore di terminale).
Alcuni comandi sono riconosciuti solo dal superutente (root), mentre altri possono variare I'output
a seconda dell'utente.

Per ottenere 1 permessi temporanei di root, utilizzare uno dei metodi descritti nella Sezione
4.7.1. Per riconoscere quando Xfce Terminal ¢ in esecuzione con i privilegi di root, basta
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guardare la riga del prompt



proprio prima dello spazio in cui si digita. Invece di un $, si vedra un #; inoltre, il nome
dell'utente cambia in root scritto in rosso.

NOTA: se si tenta di eseguire come utente normale un comando che richiede i privilegi di root,
come iwconfig, ¢ possibile che venga visualizzato un messaggio di errore che indica che il
comando non ¢ stato trovato, che venga visualizzata una casella di messaggio che indica che il
programma deve essere eseguito come root o che semplicemente ci si ritrovi di nuovo al prompt
senza alcun messaggio.

Figura 6-5: L'utente ora ha privilegi amministrativi (root)
6.4.1 Primi passi

* Per ulteriori informazioni sull'utilizzo del Terminale Xfce per risolvere i problemi del
sistema, consultare 1'argomento Risoluzione dei problemi alla fine di questa sezione.
Inoltre, ¢ consigliabile eseguire backup dei file su cui si sta lavorando come utente root
con i comandi cp ¢ mv (vedere sotto).

* Anche se i comandi del terminale possono essere piuttosto complessi, la comprensione
della riga di comando ¢ solo una questione di mettere insieme cose semplici. Per vedere
quanto puo essere facile, aprite il Terminale Xfce e provate alcuni comandi di base.
Tutto questo avra piu senso se lo farete come esercitazione piuttosto che leggerlo.
Cominciamo con un comando semplice: Is, che elenca il contenuto di una directory. Il
comando di base elenca il contenuto della directory in cui ci si trova:

1s

+ E un comando utile, ma si tratta solo di alcune brevi colonne di nomi stampati sullo
schermo. Supponiamo di volere piu informazioni sui file di questa directory. Possiamo
aggiungere uno switch al comando per far si che stampi piu informazioni. Uno switch ¢
un modificatore che si aggiunge a un comando per cambiarne il comportamento. In
questo caso, il comando desiderato ¢:



1s -1



* Come potete vedere sul vostro schermo se state seguendo, questo interruttore fornisce
informazioni piu dettagliate (in particolare sui permessi) sui file di qualsiasi directory.

* Naturalmente, potremmo voler vedere il contenuto di un'altra directory (senza andarci
prima). Per farlo, aggiungiamo un argomento al comando, specificando il file che
vogliamo esaminare. Un argomento ¢ un valore o un riferimento che aggiungiamo a un
comando per indirizzarne il funzionamento. Se si aggiunge l'argomento /usr/bin/, si pud
elencare il contenuto di quella directory, anziché di quella in cui ci troviamo attualmente.

ls -1 /usr/bin

* Ci sono molti file in /usr/bin/! Sarebbe bello poter filtrare questo output in modo da
elencare solo le voci che contengono, per esempio, la parola "fire". E possibile farlo
inviando I'output del comando /Is/ a un altro comando, grep. La pipe, o carattere | ,
viene utilizzata per inviare 1'output di un comando all'input di un altro. Il comando grep
cerca lo schema che gli viene fornito e restituisce tutte le corrispondenze, quindi il
piping dell'output del comando precedente filtra I'output.

ls -1 /usr/bin | grep fire

* Infine, supponiamo di voler salvare questi risultati in un file di testo da utilizzare in un
secondo momento. Quando si impartiscono dei comandi, l'output viene solitamente
indirizzato al display della console; ma ¢ possibile reindirizzare questo output da qualche
altra parte, ad esempio in un file, usando il simbolo > (redirect) per istruire il computer a
fare un elenco dettagliato di tutti i file che contengono la parola "fuoco" in una
particolare directory (per impostazione predefinita la directory Home) e a creare un file
di testo contenente tale elenco, in questo caso chiamato "FilesOfFire".

1s -1 /usr/bin | grep fire > FilesOfFire.txt

* Come si puo vedere, la riga di comando puo essere utilizzata per eseguire operazioni
complesse in modo molto semplice, combinando semplici comandi in modi diversi.

6.4.2 Comandi comuni
Navigazione nel filesystem

Tabella 6: Comandi di navigazione del filesystem

Comando Commento

cd /usr/share Cambia la directory corrente nel percorso indicato: "/usr/share". Senza
argomenti, cd
porta alla propria home directory.

pwd Stampa il percorso della directory di lavoro corrente

Is Elenca il contenuto della directory corrente. Utilizzare I'opzione -a per mostrare
anche 1 file nascosti e 1'opzione -1 per mostrare i dettagli di tutti i file. Spesso
viene combinato con altri termini: Isusb elenca tutti 1 dispositivi usb, Ismod tutti
1 moduli, ecc.

Gestione dei file



Tabella 7: Comandi di gestione dei file



Comando Commento
cp sourcefile Copia un file in un altro nome di file o in un'altra posizione.
destinationfile Utilizzare 1'opzione -R ("ricorsivo") per copiare intere
directory.
mv sourcefile Sposta un file o una directory da una posizione a un'altra. Si usa anche per
destinationfile rinominare file o directory e per fare un backup: per esempio, prima di
modificare un file critico come xorg.conf si puod usare questo comando
per spostarlo in qualcosa come xorg.conf bak.
rm nome Cancellare un file. Usate I'opzione -R per cancellare una directory e
file 'opzione -f ("force") se non volete che vi venga chiesto di confermare
ogni cancellazione.
cat file.txt Stampa il contenuto di un file sullo schermo. Da utilizzare solo per i file
di testo.
grep Trova una determinata stringa di caratteri in un determinato pezzo di testo
e stampa l'intera riga in cui si trova. Di solito si usa con una pipe, ad
esempio cat somefile.txt I grep
/somestring/ visualizzera la riga di somefile.txt che contiene
somestring. Per trovare una scheda usb di rete, ad esempio, si puod
digitare: Isusb | grep -i Network. Il comando grep ¢ sensibile alle
maiuscole e alle minuscole per impostazione predefinita, quindi l'uso
dell'opzione -i lo rende insensibile alle maiuscole e alle minuscole.
dd Copia qualsiasi cosa bit per bit, quindi puo essere usato per directory,
partizioni e intere unita. La sintassi di base ¢ dd if=<qualche file>
of=<qualche altro file>
Simboli

Tabella 8: Simboli

Comando

Commento

| Simbolo di pipe utilizzato per inviare l'output di un comando all'input di un altro.

Alcune tastiere mostrano invece due brevi barre verticali

> I1 simbolo di reindirizzamento, utilizzato per inviare l'output di un comando in un
file di un dispositivo. Il raddoppio del simbolo di reindirizzamento fa si che 1'output
di un comando venga aggiunto a un file esistente, anziché sostituirlo.

& L'aggiunta dell'ampersand alla fine di un comando (con uno spazio prima) ne
determina l'esecuzione in background, in modo da non dover attendere il
completamento del comando per impartire il comando successivo. Il doppio punto
indica che il secondo comando deve essere eseguito solo se il primo ha avuto

SUCCESSO0.

Risoluzione dei problemi

Per la maggior parte dei nuovi utenti di Linux, la riga di comando viene utilizzata principalmente

come strumento di risoluzione dei problemi. I comandi del terminale forniscono informazioni

rapide e dettagliate che possono essere facilmente incollate in un post di un forum, in una casella

di ricerca o in un'e-mail quando si cerca aiuto sul web. Si raccomanda vivamente di tenere

queste informazioni a portata di mano quando si chiede aiuto. La possibilita di fare riferimento

alla propria configurazione hardware specifica non solo velocizzera il processo di ricerca di

aiuto, ma consentira agli altri di offrire soluzioni piu accurate. Ecco alcuni comandi comuni per
la risoluzione dei problemi (vedere anche la Sezione 3.4.4). Alcuni di essi potrebbero non fornire




informazioni o fornirne di meno se non si € connessi come root.

Tabella 9: Comandi per la risoluzione dei problemi

Comando Commento

Ispci Mostra un rapido riepilogo dei dispositivi hardware interni rilevati. Se un
dispositivo viene visualizzato come




/unknown/, di solito si tratta di un problema di driver. L'opzione -v consente di
visualizzare informazioni piu dettagliate.

Isusb Elenca i dispositivi USB collegati.

dmesg Mostra il registro di sistema per la sessione corrente (cio¢ dall'ultimo avvio).

L'output ¢ piuttosto lungo e di solito viene passato attraverso grep, less (simile a

most) o tail (per vedere cosa ¢ successo piu di recente). Per esempio, per trovare
potenziali errori relativi all'hardware di rete, provate dmesg I grep -i net.

top Fornisce un elenco in tempo reale dei processi in esecuzione e varie statistiche su di
essi. E disponibile anche dal menu Start come Htop insieme a una bella versione
grafica di Task Manager.

Accesso alla documentazione dei comandi

* Molti comandi stampano un semplice messaggio di "informazioni sull'uso" quando si utilizza il comando
--help o -h. Puo essere utile per ricordare rapidamente la sintassi di un comando. Ad
esempio: cp --help

* Per informazioni piu dettagliate sull'uso di un comando, consultare la pagina man del
comando stesso. Per impostazione predefinita, le pagine man vengono visualizzate nel
less pager del terminale, il che significa che viene visualizzata solo una schermata del
file alla volta. Tenete a mente questi trucchi per navigare nella schermata risultante:

» La barra spaziatrice (o il tasto PageDown) fa avanzare la schermata.
» La lettera b (o tasto PageUp) sposta lo schermo all'indietro.

» Lalettera q chiude il documento di aiuto.

Alias

E possibile creare un alias (nome di comando personale) per qualsiasi comando, breve o lungo,
che si desidera; ¢ piu facile farlo con lo strumento MX Bash Config. I dettagli nel Wiki
MX/antiX.

6.4.3 Collegamenti

¢ Quida per 1 principianti di BASH

¢ Nozioni di base della riga di comando

6.5 Script

Uno script ¢ un semplice file di testo che puo essere scritto direttamente da una tastiera e
consiste in una serie logicamente sequenziata di comandi del sistema operativo. I comandi
vengono gestiti uno alla volta da un interprete di comandi che a sua volta richiede servizi al
sistema operativo. L'interprete di comandi predefinito in MX Linux ¢ Bash. [ comandi devono
essere comprensibili per
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Bash e gli elenchi di comandi sono stati creati per la programmazione. Uno script di shell ¢ la
controparte Linux dei programmi batch nel mondo Windows.

Gli script sono utilizzati in tutto il sistema operativo Linux e nelle applicazioni che vi girano
come metodo economico per eseguire piu comandi in modo semplice da creare e modificare.
Durante 1'avvio, ad esempio, molti script vengono invocati per avviare processi specifici come la
stampa, la rete, ecc. Gli script vengono utilizzati anche per i1 processi automatizzati,
I'amministrazione del sistema, le estensioni delle applicazioni, i controlli degli utenti, ecc. Infine,
gli utenti di ogni tipo possono utilizzare gli script per i propri scopi.

6.5.1 Un semplice script

Eseguiamo uno script molto semplice (e famoso) per ottenere 1'idea di base.

1. Aprire l'editor di testo (Menu Start > Accessori) e digitare:

#!/bin/bash
clear
eco Buongiorno, mondo!

2. Salvate il file nella vostra home directory con il nome SimpleScript.sh

3. Fare clic con il pulsante destro del mouse sul nome del file, selezionare
Proprieta e selezionare "Consenti I'esecuzione di questo file come programma"
nella scheda Autorizzazioni.

4. Aprite un terminale e digitate:
sh /home/<username>/SimpleScript.sh

5. Sullo schermo apparira la riga "Good morning, world!". Questo semplice script non fa
molto, ma stabilisce il principio che un semplice file di testo puo essere usato per inviare
comandi per controllare il comportamento del sistema.

NOTA: Tutti gli script si aprono con uno shebang come all'inizio della prima riga: si tratta di
una combinazione di un segno di hash (#), un punto esclamativo e il percorso dell'interprete dei
comandi. In questo caso, l'interprete ¢ Bash e si trova nella posizione standard per le
applicazioni utente.

6.5.2 Uno script utile

Vediamo uno script utile per 1'utente comune che riduce tutte le operazioni di backup di piu
gruppi di file in un'unica pressione di tasti. Lo script sottostante si basa su uno script di sistema
chiamato rdiff-backup, che deve essere installato dai repo per funzionare. Copia una directory
in un'altra, mantenendo una registrazione delle differenze in una speciale sottodirectory, in
modo da poter recuperare 1 file persi tempo fa (per inciso, rdiff-backup si basa a sua volta su uno
script chiamato diff).

In questo esempio, un utente chiamato "newbie" vuole impostare uno script per eseguire il
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backup di documenti, musica, posta e immagini dalla directory /home a un'unita esterna.



1 #!/bin/bash
2 #
3 # Questo script Rdiff-Backup esegue 11 backup su un secondo disco rigido
4 # Deve essere eseguito come root per montare il secondo disco
rigido 5

6 # Per ripristinare i file, eseguire il comando: cp -a /mnt/sdal/username /home
7 # Per ripristinare, ma non sovrascrivere:

8 # cp -a -1 \SpecialChar nobreakdash\SpecialChar nobreakdash "reply=no
/mnt/sdal/username /home

9

10 # Montare i dispositivi

esterni 11

12 montare /dev/sdbl

13 montare /dev/sdb2

14 montare /dev/sdb3

15

16 # Eseguire il backup

17

18 rdiff-backup /home/newbie/Documents /mnt/sdb2/Documents

19 rdiff-backup /home/newbie/Music /mnt/sdbl/Music

20 rdiff-backup /home/newbie/Mail /mnt/sdb2/Mail

21 rdiff-backup /home/newbie/Pictures /mnt/sdb3/Pictures

22

23 # Smontare i dispositivi

esterni 24

25 umount /dev/sdbl

26 umount /dev/sdb2

27 umount /dev/sdb3

Vediamo ora i componenti di questo script:

* Righe 2-8: davanti a queste righe ¢ stato posto un segno di hash o di numero
(chiamato "commentarle") per indicare a Bash che non fanno parte della sequenza
di comandi da eseguire. Il loro scopo ¢ quello di fornire a chiunque guardi questo
script informazioni sull'origine, il creatore, lo scopo ¢ la licenza dello script
(metadati).

* Riga 10: 1 buoni script separano i comandi in sezioni procedurali chiaramente
etichettate, anche nelle righe 16 e 22.

* Linee 12-14: i tre dispositivi da utilizzare per il backup devono essere montati in modo
da essere disponibili per il sistema.

* Righe 18-21: qui si dice a bash di usare lo script di sistema rdiff-backup per
confrontare le directory originali (sorgenti) con quelle di backup (destinazioni),
copiare le differenze trovate e registrare le modifiche.

* Linee 25-27: una volta terminato il lavoro di backup, le unita esterne vengono
smontate dal sistema.

Chiunque volesse utilizzare uno script di questo tipo dovrebbe eseguire alcuni passaggi di esecuzione:

1. Copiare l'intero script.



2. Fare clic con il tasto destro del mouse sul desktop e selezionare Crea nuovo > File di testo...

3. Date al file un nome che abbia senso (senza spazi, perd) e aggiungete 1'estensione "sh"
in modo da riconoscere che si tratta di uno script. Per questo esempio, si potrebbe
scegliere Backup DocsMusicMailPictures.sh

4. Aprite il nuovo file di testo e incollate lo script.

5. Modificare i nomi, le posizioni e cosi via in base al sistema in uso. Nell'esempio
precedente, € possibile che le directory di cui eseguire il backup abbiano nomi e/o
posizioni diverse e che i dispositivi in cui devono essere archiviate siano diversi.

6. Salvate lo script in un luogo in cui sia possibile trovarlo facilmente quando ne avete
bisogno, ad esempio creando una nuova cartella /home/scripts.

7. Fate clic con il pulsante destro del mouse sullo script, selezionate Proprieta, fate clic
sulla scheda Autorizzazioni, selezionate la casella E eseguibile ¢ fate clic su OK.

8. Quando si ¢ pronti per il backup, aprire un terminale e digitare:
sh /home/scripts/Backup DocsMusicMailPictures.sh

SUGGERIMENTO: utilizzare il tasto tabulazione per completare automaticamente il nome del file
dopo aver digitato le prime lettere.

Collegamenti

¢ Quida per i principianti di Bash

e Esercitazione di scripting di shell per Linux

¢ Elenco dei comandi Linux

6.5.3 Tipi di script speciali

Alcuni script richiedono un software speciale (linguaggio di scripting) per essere eseguiti, invece

di essere semplicemente lanciati in Bash. I pit comuni per gli utenti abituali sono gli script
Python, che assumono la forma *.py.

Per eseguirli, ¢ necessario chiamare python per eseguire 1'esecuzione fornendo il percorso
corretto. Se si scarica sul desktop uno script python chiamato "tryme.py", per esempio, si puo
fare una delle tre cose seguenti:

= Basta fare clic su di esso. MX Linux ha un piccolo programma chiamato Py-
Loader che lo lancera utilizzando Python.

= Aprite un terminale e digitate:
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python ~/Desktop/tryme.py

= In alternativa, si puo aprire un terminale all'interno della cartella stessa, nel qual
caso si deve digitare:

python ./tryme.py
I linguaggi di scripting sono molto avanzati e non rientrano nell'ambito di questo manuale.
6.5.4 Script utente preinstallati

I seguenti script consentono agli utenti di mantenere l'installazione di MX Linux aggiornata e
funzionante come una rolling release.

smxi

Quando viene eseguito, smxi permette agli utenti di installare un nuovo kernel, installare i driver
grafici ATI e Nvidia, eseguire apt-get upgrade o apt-get dist-upgrade in modo sicuro e molto
altro ancora! Scritto da un programmatore noto come "h2", lo script ¢ praticamente
autoesplicativo, ma per le opzioni di utilizzo, eseguire smxi -h.

Per la maggior parte delle funzioni, smxi deve essere eseguito al di fuori del sistema a finestre X (cio¢ non dal
desktop).

* Dal desktop:
* Premere Ctrl-Alt-FI per accedere al prompt del terminale.
* Accedere come root ("root" e password)

* Eseguire il comando:
smx1

* All'avvio:
* Digitare e nel menu di GRUB per poterlo modificare.

» Aggiungete "3" alla fine della riga del kernel nella voce di menu di GRUB per
MX Linux, subito dopo la parola "quiet".

Il sistema si avvia direttamente alla console.
* Accedere come "root" (senza virgolette) e fornire la password appropriata.

* Eseguire il comando:

smxi


http://smxi.org/

La prima volta che viene eseguito, smxi pone una serie di domande, tra cui le opzioni di
sistema che si desidera eseguire. Sono consigliate le seguenti opzioni:

¢ continua-senza-modifiche
e apt-get
» apt-get dist-upgrade

Dopo che smxi ha completato le sue operazioni, chiedera se si desidera riavviare il desktop.
NOTA: L'esecuzione di smxi -G in un terminale root mentre si ¢ all'interno di una sessione X
in corso consente di eseguire alcune funzioni di smxi, come la rimozione di kernel indesiderati,
ecc.

home page smxi

Documentazione smxi

sgfxi

Questo script h-2 viene eseguito all'interno di smxi o separatamente e si occupa
dell'installazione dei driver grafici. Sgfxi attualmente supporta 1 driver ATI, fglrx e Nvidia.
Supporta anche la conversione da o verso driver xorg free come ati, intel o nv. Seguire la
procedura sopra descritta per avviare lo script, sostituendo smxi con sgfxi.

Sgfxi richiede una connessione internet funzionante! Alcune connessioni internet wireless
possono essere interrotte quando si opera al di fuori di X. Se questo ¢ il caso della vostra
connessione internet, passate temporaneamente a una connessione internet via cavo prima di
procedere o utilizzate le istruzioni "Installazione parziale in X, completamento al di fuori di X"
nella sezione successiva.

Lo script sgfxi scarica e installa automaticamente le intestazioni del kernel e tutto cio di cui ha
bisogno. Quindi scarica gli installatori dei driver grafici binari da Nvidia o ATI, prepara il
sistema, lo installa e poi imposta xorg.conf, il tutto in modo abbastanza pulito e
ragionevolmente intuitivo. Inoltre si aggiorna da solo, in modo da installare tutti i nuovi driver
rilasciati. Infine, sgfxi permette di passare facilmente dai driver proprietari non gratuiti, come
fglrx di ATI e nvidia, ai driver liberi di xorg.

NOTA: I'esecuzione di sgfxi su un sistema con chipset nvidia rimuove ddm-mx, il pacchetto
software utilizzato dagli installatori di MX Tools, quindi ¢ necessario reinstallarlo se si desidera
utilizzarlo.

manuale sgfxi

inxi


http://smxi.org/
http://smxi.org/docs/
http://smxi.org/docs/sgfxi-manual.htm

Un terzo script di h-2 incluso in MX Linux ¢ inxi, un comodo script di informazioni sul sistema
a riga di comando. Digitate inxi -4 in un terminale per vedere tutte le opzioni disponibili, che
comprendono un'opzione



L'intera gamma di informazioni, dall'uscita dei sensori alle condizioni meteorologiche. Questo
¢ 1l comando che sta dietro a MX Quick System Info.

ALTRO: Wiki MX/antiX

6.5.5 Suggerimenti e trucchi

* Per impostazione predefinita, il doppio clic su uno script di shell lo apre nell'editor di
Featherpad invece di eseguirlo. Questa ¢ una misura di sicurezza per evitare l'esecuzione
accidentale di script non previsti. Per modificare questo comportamento, fare clic su
Impostazioni > Editor tipi mimetici. Individuare x-application/x-shellscript e cambiare
l'applicazione predefinita in bash.

* Un editor piu avanzato per la programmazione di script ¢ geany, installato di default.
E un IDE/editor decente, con interfaccia grafica, leggero, multipiattaforma, flessibile
e potente.

6.6 Strumenti MX avanzati

Oltre alle applicazioni MX per la configurazione descritte nella Sezione 3.2, MX Linux include
utility per 1'utente avanzato disponibili in MX Tools.

6.6.1 Scansione di salvataggio di Chroot (CLI)

Un insieme di comandi che consentono di entrare in un sistema anche se il file initrd.img ¢ rotto.
Consente inoltre di accedere a piu sistemi senza riavviare. Dettagli e immagini nel file HELP.

AIUTO: qui.

6.6.2 Aggiornamento del kernel tramite Live-usb (CLI)

Cambiare il kernel su una live-USB antiX o MX

ATTENZIONE: solo per l'uso in una sessione dal vivo!

Questa applicazione da riga di comando puo aggiornare il kernel su una MX LiveUSB con
qualsiasi kernel installato. Questa applicazione viene visualizzata in MX Tools solo quando ¢ in
corso una sessione Live.


https://mxlinux.org/wiki/antix-faqs-applications/guide-smxisgfxiinxi
https://www.geany.org/
https://en.wikipedia.org/wiki/Integrated_development_environment
https://mxlinux.org/wiki/system/chroot-rescue-scan/
https://www.youtube.com/watch?v=UWvwbwTGOZ8&t=2s

Figura 6-6: Lo strumento di aggiornamento del kernel live-usb pronto a passare a un nuovo kernel

AIUTO: qui.

6.6.3 Creatore di MXLive Usb

Si usa per creare una live-usb partendo da un file iso, da un live -cd/dvd o da una live-usb
esistente o anche da un sistema live in esecuzione. Sebbene UNetbootin sia disponibile per
impostazione predefinita (vedere Sezione 2.2.3), live-usb maker presenta una serie di vantaggi:

+ E piu veloce.

» Salvai file di stato tra i riavvii

* LiveUSB-Storage per salvare i file direttamente sulla live-usb
* Persistenza

* Rimasterizzazione

* Ora offre 1'opzione dd

» Aggiornamento del kernel in tempo reale

NOTA: il modulo CLI (live-usb-maker, eseguito come root) offre molte opzioni avanzate.

Select Target USB Device | sdb  29.3G USB_Flash_Drive  Lexar :: | Refresh drive list
Select ISO file | B select 150 | | Show advanced options
Options Mode

|_| Dry run (no change to system) |_| Clone an existing live system * Full-featured mode - writable LiveUSB

| Encrypt Image mode - read-only LiveUSB (dd)

Percent of USB-device to use: |100 v‘
_———

Label ext partition:

For distros other than antiX/MX use
image mode (dd).

About... | | Help Next | Close |



https://mxlinux.org/wiki/help-files/help-live-usb-kernel-updater
https://en.wikipedia.org/wiki/Dd_(Unix)

Figura 6-7: Lo strumento live-usb maker pronto a selezionare l'ISO da utilizzare

AIUTO: qui.

6.6.4 Rimasterizzazione live/persistenza (RemasterCC)

Eseguire un'istantanea di un sistema installato

MX-17: creare una USB live con persistenza

MX-17: installare applicazioni su una USB live con persistenza

NOTA: questa applicazione viene visualizzata in MX Tools solo quando si esegue una sessione Live.

Rimasterizzazione

ATTENZIONE: solo per l'uso in una sessione dal vivo!

Lo scopo principale della rimasterizzazione live ¢ quello di rendere il piu sicuro, facile e
conveniente possibile per gli utenti creare la propria versione personalizzata di MX Linux che
puo essere distribuita ad altri computer.

L'idea ¢ quella di usare una LiveUSB (o una LiveHD, una "installazione frugale"; si veda la
Wiki MX/antiX) su una partizione del disco rigido come ambiente di sviluppo e test. Aggiungete

o sottraete pacchetti e poi, quando siete pronti per la rimasterizzazione, usate un semplice script
di rimasterizzazione o un'interfaccia grafica per eseguire la rimasterizzazione e poi riavviate. Se
qualcosa va storto, ¢ sufficiente riavviare di nuovo con l'opzione di rollback per avviare
I'ambiente precedente.

I membri della MX Community utilizzano la rimasterizzazione Live per produrre versioni non
ufficiali, come il set di strumenti noto come Workbench.

MX 16 - Rimasterizzare il vostro Live-USB

MX Spins: Banco di lavoro!



https://mxlinux.org/wiki/help-files/help-live-usb-maker
https://www.youtube.com/watch?v=ExVkxXcVDAw
https://www.youtube.com/watch?v=2vF_dw6Kpo8
https://www.youtube.com/watch?v=6BsCx1-v3Ro
https://mxlinux.org/wiki/system/frugal-installation
https://www.youtube.com/watch?v=LpI_a4xPKdM
https://www.youtube.com/watch?v=zwLz2vLc_qg

MX Spins: Il KDE di Stevo!

Persistenza

ATTENZIONE: solo per 1'uso in una sessione dal vivo!

AVVERTENZA: puo fallire con aggiornamenti di grandi dimensioni che possono
sovraccaricare la RAM. Sono disponibili procedure alternative.

» Eseguire l'aggiornamento in piu fasi, utilizzando ogni volta quantita ridotte (ad esempio, 200 MB).

* Attendere il prossimo snapshot mensile e reinstallare. Assicurarsi di copiare prima
tutte le cartelle non di sistema dalla chiavetta.

USB live con persistenza (modalita legacy)

USB live con persistenza (modalita UEFI)

La persistenza ¢ un ibrido tra un LiveMedium e un'installazione completa; consente di
conservare tutti i1 file installati o aggiunti durante una sessione live. I programmi installati o
rimossi dai file utente "demo" durante la persistenza dal vivo e le personalizzazioni apportate a
questi ultimi saranno trasferiti al sistema installato.

Figura 6-8: Strumento di rimasterizzazione e persistenza

AIUTO: qui.

6.6.5 Istantanea

Questo strumento esegue una copia del sistema in esecuzione e ne crea una [SO.


https://www.youtube.com/watch?v=87Qb3_S8dGA
https://www.youtube.com/watch?v=RC4SmhsG3K0
https://www.youtube.com/watch?v=DJmukS-bSxw
https://mxlinux.org/wiki/help-files/help-live-remasterpersistence-remastercc

L'ISO puo essere messa su un LiveMedium nel modo consueto (vedere Sezione 2.2). Per
installare dal LiveMedium, aprire un terminale root e inserire il comando: minstall.

Figura 6-9: Schermata di apertura dell'istantanea

AIUTO: qui.

6.7 SSH

SSH (Secure Shell) & un protocollo utilizzato per accedere in modo sicuro ai sistemi remoti. E il

modo pit comune per accedere a computer remoti Linux e Unix-like. MX Linux viene fornito
con 1 principali pacchetti necessari per eseguire SSH in modalita attiva, il principale dei quali €
OpenSSH, un'implementazione gratuita di Secure Shell che consiste in un'intera suite di
applicazioni.

e Avviare o riavviare il demone ssh come root con il comando:
/etc/init.d/ssh start

* Per avviare automaticamente il demone ssh all'avvio del computer, fare clic su Tutte le
impostazioni > Sessione e avvio > Avvio automatico applicazioni. Fate clic sul
pulsante Aggiungi, quindi nella finestra di dialogo inserite un nome, ad esempio
StartSSH, una breve descrizione, se desiderate, € il comando

/etc/init.d/ssh start

Premere OK e il gioco ¢ fatto. Al successivo riavvio, il demone SSH sara attivo.

* Gli utenti di KDE su MX Linux possono fare lo stesso usando Preferenze > Impostazioni > Avvio e
arresto

> Avvio automatico.


https://mxlinux.org/wiki/help-files/help-mx-save-system-iso-snapshot
http://en.wikipedia.org/wiki/Secure_Shell

6.7.1 Risoluzione dei problemi

A volte, SSH non funziona in modalita passiva, inviando un messaggio di connessione negata.
Allora si puo provare quanto segue:

* Modificare come root il file '/etc/ssh/sshd-config'. Alla riga 16 si trova il parametro
'UsePrivilegeSeparation yes'. Modificarlo in

UsePrivilegeSeparation no

* Aggiungere se stessi (o gli utenti previsti) al gruppo 'ssh' utilizzando MX User Manager o
modificando come root il file /etc/group.

* A volte i certificati possono essere mancanti o non aggiornati; un modo semplice per
ricostruirli € eseguire (come root) il comando

ssh-keygen -A
* Controllare se sshd ¢ in esecuzione digitando
/etc/init.d/ssh status

Il sistema dovrebbe rispondere "[ ok | sshd ¢ in esecuzione".

* Se si utilizza un firewall, verificare che la porta 22 non sia bloccata. Deve consentire il
traffico in entrata e in uscita.

ALTRO: Manuale Openssh

6.8 Sincronizzazione

La sincronizzazione dei file (o sincronizzazione) consente di mantenere identici i file in

posizioni diverse. Si presenta in due forme:
* unidirezionale ("mirroring"), in cui un computer sorgente viene copiato su altri ma non il contrario
* bidirezionale, in cui pit computer sono mantenuti identici

Per esempio, gli utenti di MX Linux lo trovano utile per gestire installazioni multiple per se
stessi, per 1 membri della famiglia o per altri gruppi, eliminando cosi la necessita di aggiornare
piu di una volta. Esiste una grande quantita di software di sincronizzazione, ma i due seguenti

sono stati testati e si sono dimostrati utili per gli utenti di MX Linux:
* unison-gtk (nei repo)
e FreeFileSync


http://www.openssh.com/manual.html
https://en.wikipedia.org/wiki/File_synchronization
https://en.wikipedia.org/wiki/Comparison_of_file_synchronization_software
https://www.cis.upenn.edu/~bcpierce/unison/
https://www.freefilesync.org/

7 Sotto il cofano

7.1 Introduzione

MX Linux eredita il suo design fondamentale da Unix, un sistema operativo che esiste in varie
forme dal 1970, molto prima di MS Windows. Da esso ¢ stato sviluppato Linux, da cui Debian
produce la sua distribuzione. Il sistema operativo di base ¢ l'argomento di questa sezione. Gli
utenti che provengono da MS Windows di solito trovano molti concetti sconosciuti e si sentono
frustrati nel cercare di fare le cose nel modo in cui sono abituati a farle.

Questa sezione fornisce una panoramica concettuale di alcuni aspetti fondamentali di MX
Linux e di come si differenziano da altri sistemi per facilitare la transizione.
Collegamenti

¢  Wikipedia: Unix

¢ Pagina iniziale di Linux

¢ Wikipedia Debian

7.2 La struttura del file system

Esistono due usi fondamentali del termine "file system".

» Il primo ¢ il Filesystem del sistema operativo. Si tratta dei file e della loro
organizzazione che il sistema operativo utilizza per tenere traccia di tutte le risorse
hardware e software a sua disposizione durante il funzionamento.

* L'altro uso del termine file system si riferisce al Disk Filesystem, progettato per
l'archiviazione e il recupero dei file su un dispositivo di archiviazione dati, piu
comunemente un'unita disco. Il file system del disco viene impostato quando la
partizione del disco viene formattata per la prima volta, prima di scrivere qualsiasi dato
sulla partizione.

Il file system del sistema operativo

Se si apre Thunar e si fa clic su File System nel riquadro di sinistra, si notera una serie di
directory con nomi basati sulla gerarchia standard del filesystem Unix.



http://en.wikipedia.org/wiki/Unix
http://www.linux.org/
http://en.wikipedia.org/wiki/Debian
https://refspecs.linuxfoundation.org/FHS_3.0/fhs/index.html

Name
il bin
Fﬁ boot
ﬁ dev
i etc
(@ home
o
ﬁ’ lost+found
ﬁ media
) mnt
{3 opt
(i proc
ﬁ root
3 run
ﬁ shin
B sda2
(i selinux
i sys
‘itmp
B usr
i var

v Size Type Date Modified
4.1 kB folder 12/23/2014
4.1 kB folder 01/27/2015
3.3 kB folder Today

12.3 kB folder Today
4.1 kB folder 01/05/2015
4.1 kB folder Yesterday
16.4 kB folder 12/11/2014
4.1 kB folder Today
4.1 kB folder 12/11/2014
4.1 kB folder Yesterday
0 bytes folder 01/28/2015
4.1 kB folder 01/08/2015
880 bytes folder Yesterday
12.3 kB folder 01/28/2015
4.1 kB folder 12/11/2014
4.1 kB folder 06/10/2012
0 bytes folder 01/28/2015
4.1 kB link to var/tmp Today
4.1 kB folder 01/06/2014
4.1 kB folder 12/11/2014

Figura 7-1: 1l filesystem MX visualizzato in Thunar

Ecco una semplice descrizione delle principali directory di MX Linux e un esempio di quando

gli utenti lavorano comunemente con i file in queste directory:

¢ /bin

e /boot

e /dev

e Jetc

Questa directory contiene i file di programma binari che vengono utilizzati dal
sistema durante 1'avvio, ma che possono anche essere richiesti dalle azioni
dell'utente una volta che il sistema ¢ completamente operativo.

Esempio: Qui si trovano molti programmi di base della riga di comando, come la
shell Bash, e utility come /dd/, /grep/, /ls/ € /mount/, oltre ai programmi utilizzati
solo dal sistema operativo.

Come si puo intuire, qui si trovano i file necessari a Linux per l'avvio. Il
kernel Linux, il nucleo del sistema operativo Linux, & conservato qui, cosi
come i bootloader come GRUB.

Esempio: nessun file ¢ comunemente consultato dagli utenti.

In questa directory si trovano i file speciali che collegano 1 vari dispositivi di
input/output del sistema.

Esempio: nessun file qui ¢ comunemente accessibile direttamente dagli
utenti, tranne che nei comandi di montaggio della CLI.

Questa directory contiene 1 file di configurazione del sistema e i file di
configurazione delle applicazioni.



» Esempio: Il file /etc/fstab specifica i punti di montaggio per ulteriori filesystem
su dispositivi, partizioni, ecc. che possono essere configurati per un uso
ottimale.

* Esempio: i problemi di visualizzazione a volte comportano la modifica del file
/etc/X11/xorg.conf.

¢ /home

* Qui risiedono le directory personali dell'utente (dati e impostazioni). Se c'¢ piu di
un utente, viene creata una sottodirectory separata per ciascuno. Nessun utente
(eccetto root) puo leggere la directory personale di un altro utente. La directory
dell'utente contiene sia file nascosti (dove il nome del file ¢ preceduto da un
punto) sia file visibili; 1 file nascosti possono essere rivelati facendo clic su
Visualizza >Mostra file nascosti (o Ctrl-H) in Thunar.

* Esempio: all'inizio gli utenti organizzano 1 propri file utilizzando le
directory predefinite come Documenti, Musica, ecc.

* Esempio: un profilo Firefox si trova nella directory nascosta .mozilla/firefox/
« /lib

* Questa directory contiene librerie di oggetti condivisi (analoghe alle DLL di
Windows) che sono necessarie all'avvio. In particolare, i moduli del kernel si

trovano qui, sotto la voce
/lib/moduli.

* Esempio: nessun file ¢ comunemente consultato dagli utenti.
* /media

+ I file per i supporti rimovibili come CDrom, unita floppy e chiavette USB
vengono installati qui quando i supporti vengono montati automaticamente.

» Esempio: Dopo aver montato dinamicamente una periferica come un'unita flash,
¢ possibile accedervi da qui.

e /mnt

» I dispositivi di archiviazione fisica devono essere montati qui prima di potervi
accedere. Dopo che le unita o le partizioni sono state definite nel file /etc/fstab, il
loro file system viene montato qui.

» Esempio: Gli utenti possono accedere alle unita e alle partizioni montate qui.
* /opt

« E la posizione prevista per i principali sottosistemi applicativi di terze parti
installati dall'utente.

» Ad esempio, se si installa Google Earth, ¢ qui che verra installato. Alcune
distro collocano i programmi installati dall'utente anche nelle sottodirectory
/opt.



* /proc
» La posizione delle informazioni di processo e di sistema

* Esempio: nessun file € comunemente consultato dagli utenti.



e /root

« E la directory principale dell'utente root (amministratore). Si noti che non ¢ la
stessa cosa di "/", la radice del file system.

* Esempio: nessun file qui ¢ comunemente accessibile agli utenti, ma i file salvati
durante 'accesso come utente root possono essere salvati qui.

e /sbin

* Qui vengono installati i programmi richiesti dagli script di avvio del sistema,
ma che normalmente non vengono eseguiti da utenti diversi da root, ovvero le
utilita di amministrazione del sistema.

» Esempio: nessun file qui ¢ comunemente accessibile agli utenti, ma qui si
trovano file come modprobe e ifconfig.

* E la posizione dei file temporanei prodotti dai programmi, come ad esempio 1 compilatori.
-mentre vengono eseguiti. In generale, si tratta di file temporanei a breve termine,
utili a un programma solo durante la sua esecuzione.

* Esempio: nessun file € comunemente consultato dagli utenti.
e /usr

* Questa directory contiene molti file per le applicazioni dell'utente ed ¢ per certi
versi analoga alla directory "Program Files" di Windows.

* Esempio: molti eseguibili si trovano in (/ust/bin)

» Esempio: la documentazione (/usr/docs) e i file di configurazione, la grafica e
le icone sono in (/ustr/share).

e /var

* Questa directory contiene file che cambiano continuamente durante 1'esecuzione di Linux,
Ad esempio, i log, la posta di sistema e 1 processi in coda.

» Esempio: si puo guardare in /var/log/ quando si cerca di determinare cosa ¢
successo durante un processo come l'installazione di un pacchetto.

Il file system del disco

11 file system del disco ¢ qualcosa di cui 1'utente medio non deve preoccuparsi piu di tanto. Il
file system predefinito utilizzato da MX Linux si chiama ext4, una versione del file system ext2
che ¢ di tipo journaled, cio¢ scrive le modifiche in un registro prima di eseguirle, rendendolo
piu robusto. Il file system ext4 viene impostato durante l'installazione, quando il disco rigido
viene formattato.



In linea di massima, ext4 ha piu anni di esperienza rispetto a tutti i suoi rivali e combina stabilita
e velocita; per queste ragioni, non consigliamo di installare MX Linux su un file system diverso
a meno che non siate ben informati sulle differenze. Tuttavia, MX Linux ¢ in grado di leggere e
scrivere su molti altri filesystem formattati e puo essere installato su alcuni di essi, se per
qualche motivo se ne preferisce uno a ext4.

Collegamenti

e ]l sistema di file di Wikipedia

* Wikipedia. Confronto tra filesystem

* Wikipedia Ext4

7.3 Permessi

MX Linux ¢ un sistema operativo basato su account. Cio significa che nessun programma puo
essere eseguito senza un account utente e che qualsiasi programma in esecuzione ¢ limitato dai
permessi concessi all'utente che lo ha avviato.

NOTA: Gran parte della sicurezza e della stabilita per cui Linux € conosciuto si basa sull'uso
corretto di account utente limitati e sulla protezione fornita dai permessi predefiniti di file e
directory. Per questo motivo, si dovrebbe operare come root solo per le procedure che lo
richiedono. Non accedete mai a MX Linux come root per eseguire le normali attivita del
computer: l'esecuzione di un browser web come utente root, ad esempio, € uno dei pochi modi
per contrarre un virus su un sistema Linux!

Informazioni di base

La struttura predefinita dei permessi dei file in Linux ¢ piuttosto semplice, ma piu che adeguata
per la maggior parte delle situazioni. Per ogni file o cartella, ci sono tre permessi che possono
essere concessi € tre entita (proprietario/creatore, gruppo, altri/mondo) a cui sono concessi. |
permessi sono:

» Il permesso di lettura significa che i dati possono essere letti dal file; significa anche che

il file puo essere copiato. Se non si ha il permesso di lettura per una directory, non si
possono nemmeno vedere i nomi dei file in essa elencati.

» Il permesso di scrittura significa che il file o la cartella possono essere modificati,

aggiunti o eliminati. Per le directory, specifica se un utente puo scrivere sui file della
directory.

» Il permesso di esecuzione indica se I'utente puod eseguire o meno il file come script o

programma. Per le directory, determina se 1'utente puo entrare e diventare la directory di
lavoro corrente. Ogni file e cartella acquisisce un singolo utente designato come
proprietario quando viene creato nel sistema. (Si noti che se si sposta un file da un'altra
partizione in cui ha un proprietario diverso, manterra il proprietario originale; ma se lo si


http://en.wikipedia.org/wiki/File_system
http://en.wikipedia.org/wiki/File_system
http://en.wikipedia.org/wiki/Ext4

copia e incolla, verra assegnato all'utente). Ha anche un singolo gruppo designato come
gruppo, per impostazione predefinita



il gruppo a cui appartiene il proprietario. Le autorizzazioni concesse agli altri riguardano
tutti coloro che non sono il proprietario o il gruppo di appartenenza.

NOTA: Per gli utenti avanzati ¢ possibile impostare altri attributi speciali oltre a
lettura/scrittura/esecuzione: sticky bit, SUID e SGID. Per ulteriori informazioni, vedere la
sezione Collegamenti di seguito.

Visualizzazione, impostazione e modifica delle autorizzazioni

In MX Linux sono disponibili molti strumenti per visualizzare e gestire 1 permessi.
* INTERFACCIA GRAFICA

* Thunar. Per visualizzare o modificare le autorizzazioni di un file, fare clic con il
pulsante destro del mouse sul file e selezionare Proprieta. Fare clic sulla scheda
Autorizzazioni. Qui € possibile impostare le autorizzazioni concesse al
proprietario, al gruppo e ad altri utilizzando 1 menu a discesa. Per alcuni file
(come gli script, ad esempio), ¢ necessario selezionare la casella per renderli
eseguibili, mentre per le cartelle ¢ possibile selezionare una casella per limitare
l'eliminazione dei file al suo interno ai soli proprietari.

* NOTA: per modificare i permessi di un file o di una directory il cui proprietario
¢ root ¢ necessario operare come root. Per le cartelle piu grandi € necessario
aggiornare la finestra di Thunar, altrimenti i permessi verranno visualizzati in
modo errato, anche se i permessi sono stati effettivamente modificati. Basta
premere F5 per aggiornare la finestra, altrimenti si vedranno 1 permessi originali.

* MX User Manager ¢ un modo semplice per modificare le autorizzazioni
associando un utente a gruppi specifici.

 CLI

* Partizioni interne. Per impostazione predefinita, per montare le partizioni
interne ¢ necessaria la password di root/superuser. Per modificare questo
comportamento, fare clic su MX Tweak, scheda Altro.

* Nuove partizioni esterne. La formattazione di una nuova partizione con ext4
richiede i1 permessi di root, il che puo portare a un risultato inaspettato o
indesiderato: 1'utente normale non puo scrivere alcun file nella partizione. Per
modificare questo comportamento, consultare il Wiki MX/antiX.

* Operazioni manuali. Sebbene MX User Manager copra la maggior parte delle
situazioni quotidiane, a volte puo essere preferibile utilizzare la riga di comando.
I permessi di base sono rappresentati da r (lettura), w (scrittura) e x (esecuzione);
un trattino indica l'assenza di permessi. Per visualizzare i permessi di un file alla
riga di comando, digitate: /s -/ NomeFile. Potrebbe essere necessario utilizzare il
percorso completo del file (ad esempio, /ust/bin/gimp). L'opzione -1 fa si che il
file venga elencato in formato lungo, mostrando i suoi permessi e altre
informazioni.


https://mxlinux.org/wiki/system/format-ext4-filesystem-be-owned-regular-user

v Terminal
jb@UTRA: ~
$ -rw-r--r-- newbie users 277 Jan 7 14:42 .asoundrc

Figura 7-2: Visualizzazione dei permessi dei file

I caratteri subito dopo il trattino di apertura (che indica che si tratta di un file
regolare) contengono le tre autorizzazioni (lettura/scrittura/esecuzione) per il
proprietario, il gruppo e altri: 9 caratteri in totale. Qui si vede che il proprietario
ha i permessi di lettura e scrittura ma non di esecuzione (rw-), mentre il gruppo
e gli altri possono solo leggere. In questo caso il proprietario ¢ "newbie", che
appartiene al gruppo "users".

Se per qualche motivo fosse necessario cambiare la proprieta di questo file a root
usando la riga di comando, si dovrebbe usare il comando chown come in questo
esempio:

chown root /home/newbie/.asoundrc
Per i dettagli sull'uso di chown e del piu dettagliato chmod, si veda la sezione Collegamenti.

Collegamenti

e Wiki MX/antiX: Permessi

¢ Permessi dei file

7.4 File di configurazione

7.4.1 File di configurazione utente

I file che contengono le impostazioni individuali dell'utente (come i punteggi piu alti dei giochi o
la disposizione del desktop) sono memorizzati all'interno della home directory di un utente, in
genere come file o directory nascosti, € possono essere modificati solo da quell'utente o da root.
Questi file di configurazione personale sono in realta meno spesso modificati direttamente
rispetto ai file di sistema, perché la maggior parte della configurazione dell'utente avviene
graficamente attraverso le applicazioni stesse. Quando si apre un'applicazione e si fa clic su
Modifica > Preferenze, ad esempio, le selezioni vengono scritte in un file di configurazione
(solitamente nascosto) nella propria directory utente. Allo stesso modo in Firefox, quando si
digita about:config nella barra degli indirizzi, si modificano 1 file di configurazione nascosti. |
file di configurazione di Xfce sono memorizzati in ~/.config/.

7.4.2 File di configurazione del sistema

I file che contengono le configurazioni o le impostazioni predefinite del sistema (come il file
che determina quali servizi vengono avviati automaticamente all'avvio) sono in gran parte
memorizzati nella directory /etc/ e sono modificabili solo da root. La maggior parte di questi file
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non viene mai toccata direttamente dagli utenti normali, come ad esempio questi:

* Jetc/re.d/re5.d - Contiene i file per controllare il runlevel 5 in cui MX Linux si avvia
dopo il login.



 Jetc/sysconfig/keyboard - Utilizzato per configurare la tastiera.
* Jetc/network/interfaces - Definisce le interfacce Internet del sistema.

Alcuni file di configurazione possono contenere solo poche righe, o addirittura essere vuoti,
mentre altri possono essere piuttosto lunghi. L'importante € che se si cerca un file di
configurazione per un'applicazione o un processo, si vada nella directory /etc e si cerchi.
Attenzione: poiché questi file influenzano l'intero sistema, 1) fate un backup di qualsiasi file che
intendete modificare (la cosa piu semplice in Thunar: copiate e incollate, aggiungendo BAK alla
fine del nome del file) e 2) fate molta attenzione!

7.4.3 Esempio

I problemi audio possono essere risolti con una serie di strumenti grafici e a riga di comando, ma
ogni tanto l'utente deve modificare direttamente il file di configurazione del sistema. Per molti
sistemi, questo sara /etc/modprobe.d/snd-hda-intel.conf. Si tratta di un semplice file il cui
paragrafo superiore ha questo aspetto:

# alcuni chip richiedono che il modello sia
impostato manualmente # per esempio la serie asus
g71 puo richiedere model=g71v

opzioni snd-hda-intel model=auto

Per cercare di ottenere il suono, si potrebbe decidere di sostituire le informazioni esatte sul
modello di suono con la parola "auto". Per conoscere il vostro modello di suono, potete aprire
un terminale e digitare:

lspci | grep Audio
L'output dipendera dal sistema, ma avra la forma seguente:

00:05.0 Dispositivo audio: nVidia Corporation MCP61 High Definition Audio (rev aZ2)
Ora ¢ possibile reinserire queste informazioni nel file di configurazione:

# alcuni chip richiedono che il modello sia
impostato manualmente # per esempio la serie asus
g7l pud richiedere le opzioni model=g71lv snd-hda-
intel model=nvidia

Salvare il file, riavviare il computer e, se tutto va bene, I'audio dovrebbe funzionare. Si puo
anche provare con maggiore precisione utilizzando model=nvidia mcp61, se il primo non
funziona.

Collegamenti

¢ Conoscere i file di configurazione di Linux

¢ Permessi dei file

7.5 Livelli di corsa

MX Linux si avvia per impostazione predefinita utilizzando sysVinit (come opzione ¢ presente
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anche un metodo diverso, systemd, che non utilizza i runlevel nello stesso modo). Dopo aver
completato il processo di avvio, init esegue tutti gli script di avvio in una directory specificata
dal runlevel predefinito (questo runlevel ¢ dato dalla voce id in /etc/inittab). Come la maggior
parte delle altre versioni di Linux, MX Linux ha 7 runlevel:



Tabella 10: Livelli di esecuzione in MX Linux

Livello Commento
di
esecuzio
ne
0 Arresto del sistema
1 Modalita monoutente: fornisce una console di root senza
accesso.

Utile se si perde la password di root

2 Multiutente senza rete

3 Accesso da console, senza X (cio¢ senza GUI)
4 Non utilizzato/personalizzato

5 Accesso predefinito alla GUI

6 Riavviare il sistema

MX Linux ha come impostazione predefinita il livello di esecuzione 5, pertanto qualsiasi script
di avvio impostato nel file di configurazione di livello 5 verra eseguito all'avvio.

Utilizzo

La comprensione dei livelli di esecuzione puo essere utile. Quando gli utenti hanno un problema
con X Window Manager, per esempio, non possono correggerlo nel runlevel 5 predefinito,
perché X ¢ in esecuzione a quel livello. Ma possono accedere al livello di esecuzione 3 per
risolvere il problema in due modi.

* Dal desktop: premere Ctrl-Alt-F1 per uscire da X. Per passare effettivamente al
runlevel 3, diventare root e digitare telinit 3; questo arrestera tutti gli altri servizi
ancora attivi sul runlevel 5.

* Dal menu di GRUB: premere e (per modificare) quando si visualizza la schermata di
GRUB. Nella schermata successiva, aggiungete uno spazio ¢ il numero 3 alla fine della
riga (per impostazione predefinita dove si trova la parola "quiet") che inizia con "linux"
e che si trova una volta sopra la riga piu bassa (il comando di avvio vero e proprio).
Premere F-10 per avviare il sistema.

Una volta che il cursore si trova su un prompt, effettuare il login con il proprio nome utente e la
propria password. Se necessario, ¢ possibile effettuare il login anche come "root" e fornire la
password amministrativa. I comandi utili quando si guarda il prompt al runlevel 3 sono:



Tabella 11: Comandi comuni del runlevel 3

Comando Commento
livello di Restituisce il numero del runlevel in cui ci si
esecuzione trova.
alt Eseguire come root. Spegne il computer. Se il sistema non funziona, provare con
poweroff.
riavvio Eseguire come root. Riavvia la macchina.
<applicazione | Esegue I'applicazione, purché non sia grafica. Ad esempio, ¢ possibile utilizzare il
> comando nano per modificare i file di testo, ma non leafpad.
Ctrl-Alt-F7 Se si ¢ usato Ctrl-Alt-F1 per uscire da un desktop in esecuzione ma non si ¢
proseguito fino al livello di esecuzione 3, questo comando riporta al
desktop.
telinit 5 Eseguire come root. Se si ¢ al runlevel 3, inserire questo comando per accedere

al gestore di login lightdm.
NOTA: questi comandi potrebbero cambiare in futuro se MX Linux passa a un nuovo gestore di

sistema.

Collegamenti

* Wikipedia: Runlevel

¢ [l progetto Linux Information: Definizione del livello di esecuzione

7.6 1l kernel

7.6.1 Introduzione

Questa sezione tratta le interazioni comuni con il kernel da parte dell'utente. Per altri aspetti piu
tecnici, consultare i link

7.6.2 Aggiornamento/Diminuzione

Base

A differenza di altri software del sistema, il kernel non viene aggiornato automaticamente se
non al di sotto del livello di revisione minore (indicato dal terzo numero nel nome del kernel).
Prima di cambiare il kernel attuale, € bene porsi alcune domande:

* Perché voglio aggiornare il kernel? Ad esempio, c'¢ un driver che mi serve per un
nuovo hardware?

* Devo aggiornare il kernel? Ad esempio, 1 processori Core2 Duo tendono ad avere
strani problemi con il kernel predefinito di MX-Linux che si risolvono passando al
kernel predefinito di Debian 4.9 (utilizzando MX Package Installer).

* Sono consapevole che 1 cambiamenti non necessari potrebbero portare problemi di un tipo o di un altro?
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MX Linux offre un metodo semplice per aggiornare/ridimensionare il kernel predefinito: aprire
MX Package Installer e fare clic sulla categoria "Kernel". Li si vedra una serie di kernel
disponibili per l'utente. Selezionate quello che volete usare (chiedete sul forum se non siete
sicuri) e installatelo.

Una volta controllato e installato il nuovo kernel, riavviare ¢ verificare che il nuovo kernel sia
evidenziato; in caso contrario, fare clic sulla riga delle opzioni e selezionare cio che si desidera.

Kernels

Debian 5.10
Debian 5.8
Default De

Debian B rnel Meltdown patche
vieltdown patched, 64 bit latest f

Figura 7-3: Opzioni del kernel in MX Package Installer per l'architettura a 64 bit

Avanzato

Ecco un approccio di base per aggiornare manualmente il kernel Linux sul vostro sistema.

* Per prima cosa, € necessario scoprire cosa ¢ attualmente installato. Aprite un
terminale e digitate inxi S. Ad esempio, un utente della versione MX-19 a 64 bit
potrebbe vedere qualcosa di simile:

Kernel: 5.8.0-2-amd64 x86 64 bit
Assicurarsi di annotare il nome del kernel dall'output del comando.

* In secondo luogo, selezionare e installare un nuovo kernel. Aprite Synaptic, cercate
linux-image e cercate un numero di kernel piu alto che corrisponda all'architettura (ad
esempio, 686) e al processore (ad esempio, PAE) che avete gia, a meno che non abbiate
una buona ragione per cambiare. Installare quello desiderato o necessario nel modo
consueto.

* In terzo luogo, installare il pacchetto linux-headers che corrisponde al nuovo kernel
selezionato. Ci sono due metodi per farlo.

* Osservare attentamente le voci di Synaptic che iniziano con linux-headers e
che corrispondono al kernel.

 In alternativa, ¢ possibile installare le intestazioni piu facilmente dopo il riavvio
del nuovo kernel digitando il seguente codice in un terminale root:

apt-get install linux-headers-$(uname -r)
Le intestazioni vengono installate anche se si usa un comando come m-a prepare.

* Alriavvio, si dovrebbe avviare automaticamente il kernel piu alto disponibile. Se non
funziona, potete tornare a quello che stavate usando: riavviate e quando vedete la
schermata di GRUB evidenziate Opzioni avanzate per la partizione che volete avviare,
quindi selezionate il kernel e premete Invio.

7.6.3 Aggiornamento del kernel e dei driver

Il Dynamic Kernel Module Support (DKMS) ricompila automaticamente tutti 1 moduli driver



https://en.wikipedia.org/wiki/Dynamic_Kernel_Module_Support

DKMS quando viene installata una nuova versione del kernel. Questo permette ai driver e ai
dispositivi non appartenenti alla linea principale di



per continuare a funzionare dopo un aggiornamento del kernel Linux. L'eccezione riguarda 1
driver grafici proprietari (Sezione 3.3.2).

* Driver NVidia
» Se sono stati installati con sgfxi, devono essere ricostruiti con sgfxi, vedere Sezione 6.5.3.

* Se ¢ stato installato con il programma di installazione dei driver MX Nvidia o
tramite synaptic/apt-get, potrebbe essere necessario ricostruire i moduli del
kernel. Il riavvio del programma di installazione dei driver MX Nvidia dal menu
dovrebbe offrire la possibilita di reinstallare e ricostruire i moduli. Se il riavvio si
blocca al prompt della console, diventare root e inserire "ddm-mx -i nvidia" per
reinstallare e ricostruire i moduli del driver.

¢ Driver Intel

* Potrebbe essere necessario aggiornare il driver, a seconda del kernel
selezionato per I'aggiornamento.

7.6.4 Altre opzioni

Esistono altre considerazioni e scelte in merito ai kernel:

* Esistono altri kernel pre-rollati, come il kernel Liquorix, che ¢ una versione del kernel
Zen e ha lo scopo di fornire una migliore esperienza di utilizzo del desktop in termini
di reattivita, anche sotto carichi pesanti come durante i giochi, oltre a una bassa latenza
(importante per l'audio). MX Linux aggiorna frequentemente i kernel Liquorix, per cui
¢ piu facile installarli attraverso 'MX Package Installer, nella sezione Kernel.

* Le distro (ad esempio, la distro sorella di MX, antiX) spesso si autoproducono.

* Le persone competenti possono compilare un kernel specifico per un determinato hardware.

7.6.5 Collegamenti
* Wikipedia: Kernel Linux

¢ Anatomia del kernel Linux

* Archivi del kernel Linux

e Mappa interattiva del kernel Linux

7.6.6 Panico e recupero del kernel

11 kernel panic ¢ un'azione relativamente rara intrapresa dal sistema MX Linux quando rileva un
errore fatale interno dal quale non puo riprendersi in modo sicuro. Puo essere causato da una
serie di fattori diversi che vanno da problemi hardware a un bug del sistema stesso. Quando si
verifica un kernel panic, provare a riavviare con MX Linux LiveMedium, che superera
temporaneamente qualsiasi problema software e, auspicabilmente, consentira di vedere e
scaricare 1 dati. Se non funziona, scollegare tutto 'hardware non necessario e riprovare.
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La prima preoccupazione ¢ quella di accedere e proteggere i dati. Si spera che sia stato eseguito
un backup da qualche parte. In caso contrario, € possibile utilizzare uno dei programmi di
recupero dati, come ddrescue, fornito con MX Linux. L'ultima risorsa ¢ portare il disco rigido
da un'azienda di recupero professionale.

Per ripristinare un sistema MX Linux funzionante, una volta messi al sicuro i dati, ¢ necessario
seguire una serie di passaggi, anche se alla fine potrebbe essere necessario reinstallare
utilizzando LiveMedium. A seconda del tipo di guasto, possono essere eseguite le seguenti
operazioni:

1. Rimuovere i pacchetti che hanno danneggiato il sistema.
2. Reinstallare il driver grafico.

3. Reinstallare GRUB utilizzando MX Boot Repair.

4. Reimpostare la password di root.

5. Reinstallare MX Linux, selezionando la casella di controllo nella schermata 2 per
mantenere /home, in modo da non perdere le configurazioni personali.

Se avete domande su queste procedure, chiedete pure sul Forum.

Collegamenti

¢ Libreria GNU C Home Page

¢ Ddrescue

7.7 Le nostre posizioni

7.7.1 Systemd

MX Linux viene fornito con due sistemi di init: SysVinit (predefinito) e systemd. Poiché 1'uso
di "systemd" come gestore di sistemi e servizi € stato controverso, vogliamo essere chiari sulla
sua funzione in MX Linux: systemd & incluso ma non abilitato. E possibile scansionare il
sistema MX e trovare file con nomi di systemd*, ma questi forniscono semplicemente un
aggancio/un punto di ingresso per la compatibilita quando necessario.

MX Linux utilizza systemd-shim, che emula le funzioni di systemd necessarie per eseguire gli
helper senza utilizzare effettivamente il servizio. Cio significa che SysVinit rimane I'init
predefinito, ma MX Linux puo utilizzare i pacchetti Debian che hanno dipendenze da systemd,
come CUPS e Network Manager. Questo approccio consente inoltre all'utente di mantenere la
possibilita di scegliere il proprio init preferito all'avvio, selezionando la voce systemd.
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7.7.2 Software non libero

MX Linux ¢ fondamentalmente orientato all'utente, quindi include una certa quantita di
software non libero per assicurare che il sistema funzioni il piu possibile. L'utente puod vedere

un elenco aprendo una console o un terminale e digitando:

vrms
Esempi:
* Il driver "wl" (broadcom-sta) ¢ il firmware non libero con componenti proprietari.
* Uno strumento dedicato all'installazione dei driver grafici Nvidia.
* Adobe Flash Player (distribuito su autorizzazione).

Il nostro ragionamento: per gli utenti avanzati ¢ molto piu facile rimuovere questi driver che
installarli per gli utenti normali. Ed ¢ particolarmente difficile installare un driver per una
scheda di rete senza accesso a Internet!


https://www.gnu.org/philosophy/categories.en.html
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Glossario

I termini di Linux possono essere confusi e sconcertanti all'inizio, quindi questo glossario

fornisce un elenco di quelli utilizzati in questo manuale per iniziare.

applet: Un programma progettato per essere eseguito all'interno di un'altra

applicazione. A differenza di un'applicazione, le applet non possono essere eseguite
direttamente dal sistema operativo.

backend: Anche /back-end./ Il backend comprende i vari componenti di un

programma che elaborano i dati immessi dall'utente attraverso il frontend. Vedi anche
frontend.

backport: I backport sono nuovi pacchetti che sono stati ricompilati per essere

eseguiti su una distribuzione rilasciata, al fine di mantenerla aggiornata.

BASH: la shell (interprete della riga di comando) predefinita sulla maggior parte dei
sistemi Linux e su Mac OS X, BASH ¢ I'acronimo di Bourne-again shell.

BitTorrent: Anche/bit torrent/ o /torrent./ Metodo inventato da Bram Cohen per
distribuire file di grandi dimensioni senza che un singolo individuo debba fornire le
risorse hardware, di hosting e di larghezza di banda necessarie.

blocco di avvio: Un'area di un disco al di fuori dell'MBR contenente

informazioni per il caricamento del sistema operativo necessario per avviare il

computer.

bootloader: Programma che sceglie inizialmente un sistema operativo da caricare dopo
che il BIOS ha terminato l'inizializzazione dell'hardware. Di dimensioni estremamente
ridotte, il bootloader ha il solo compito di passare il controllo del computer al kernel del
sistema operativo. I bootloader avanzati offrono un menu per scegliere tra diversi sistemi
operativi installati.

caricamento a catena: Invece di caricare direttamente un sistema operativo, un gestore
di avvio come GRUB puo utilizzare il caricamento a catena per passare il controllo da se
stesso a un settore di avvio su una partizione del disco rigido. Il settore di avvio di
destinazione viene caricato dal disco (sostituendo il settore di avvio da cui ¢ stato caricato
il boot manager stesso) e viene eseguito il nuovo programma di avvio. Oltre a quando ¢
necessario, come nel caso dell'avvio di Windows da GRUB, il vantaggio del chainloading
¢ che ogni sistema operativo sul disco rigido - € potrebbero essercene decine - puo essere
responsabile di avere i dati corretti nel proprio settore di avvio. In questo modo GRUB,
che risiede nel'MBR, non deve essere riscritto a ogni modifica. GRUB puo
semplicemente caricare a catena le informazioni rilevanti dal settore di avvio di una
determinata partizione, sia che questa sia cambiata sia che sia rimasta la stessa dall'ultimo
avvio.

codice cheat: I codici possono essere inseriti all'avvio di un LiveMedium per

modificare il comportamento di avvio. Vengono utilizzati per passare opzioni al

sistema operativo MX Linux e impostare parametri per ambienti particolari.

interfaccia a riga di comando (CLI): Conosciuta anche come console, terminale,
prompt dei comandi, shell o bash. Si tratta di un'interfaccia di testo in stile UNIX, a cui
anche MS-DOS ¢ stato progettato per assomigliare. Una console di root € quella in cui



sono stati acquisiti 1 privilegi amministrativi dopo aver inserito la password di root.
ambiente desktop: il software che fornisce un desktop grafico (finestre, icone, desktop,
barra delle applicazioni, ecc.) all'utente di un sistema operativo.

immagine del disco: Un file che contiene il contenuto completo e la struttura di

un supporto o di un dispositivo di archiviazione dati, come un disco rigido o un

DVD. Vedere anche ISO.



* Distribuzione: Una distribuzione Linux, o distro, ¢ una particolare confezione del kernel
Linux con vari pacchetti software GNU e diversi desktop o window manager. Poiché, a
differenza del codice proprietario utilizzato nei sistemi operativi di Microsoft e Apple,
GNU/Linux ¢ un software libero e open-source, chiunque al mondo ne abbia la
possibilita puo liberamente costruire su cio che ¢ stato fatto e innovare una nuova visione
del sistema operativo GNU/Linux. MX Linux ¢ una distro basata sulla famiglia Debian
Linux.

+ file system: Anche file system. Si riferisce al modo in cui i file e le cartelle sono
disposti logicamente sui dispositivi di archiviazione di un computer in modo da poter
essere trovati dal sistema operativo. Puo anche riferirsi al tipo di formattazione di un
dispositivo di archiviazione, come i comuni formati Windows NTFS e FAT32, 01
formati Linux ext3, ext4 o ReiserFS, e in questo senso si riferisce al metodo
effettivamente utilizzato per codificare i dati binari sul disco rigido, sul floppy,
sull'unita flash, ecc.

* Firmware. I piccoli programmi e le strutture di dati che controllano internamente i
componenti elettronici.

* libero come il linguaggio: La parola inglese "free" ha due possibili significati: 1) senza
costi e 2) senza restrizioni. In parte della comunita del software open-source,
un'analogia utilizzata per spiegare la differenza ¢ 1) "free" come la birra vs. 2) "free"
come il linguaggio. La parola
L'espressione /freeware/ ¢ usata universalmente per riferirsi al software che ¢
semplicemente senza costi, mentre 1'espressione /free software/ si riferisce vagamente al
software che ¢ piu propriamente chiamato software open-source, concesso in licenza
sotto qualche tipo di licenza open source.

* frontend: Anche front-end. Il frontend ¢ la parte di un sistema software che
interagisce direttamente con l'utente. Vedi anche backend.

+ GPL: Licenza pubblica generale GNU. E una licenza con cui vengono rilasciate molte
applicazioni open-source. Specifica che ¢ possibile visualizzare, modificare e
ridistribuire il codice sorgente delle applicazioni rilasciate sotto questa licenza, entro
certi limiti; ma non ¢ possibile distribuire il codice eseguibile a meno che non si
distribuisca anche il codice sorgente a chiunque lo richieda.

* GPT: Schema di partizionamento utilizzato da UEFI nativo.

* Interfaccia grafica utente (GUI): Si riferisce all'interfaccia di un programma o di un
sistema operativo che utilizza immagini (icone, finestre, ecc.), in contrapposizione alle
interfacce testuali (a riga di comando).

* directory home: Una delle 17 directory di primo livello che si diramano dalla directory
principale in MX Linux, /home contiene una sottodirectory per ogni utente registrato nel
sistema. All'interno di ogni directory home gli utenti hanno privilegi di lettura e scrittura
completi. Inoltre, la maggior parte dei file di configurazione specifici dell'utente per 1
vari programmi installati sono memorizzati in sottodirectory nascoste all'interno della
directory /home/username/, cosi come la posta elettronica scaricata. Gli altri file
scaricati vanno di solito per impostazione predefinita in home/username/Documents o in
/home/username/Desktop sottodirectory.

* IMAP: L'Internet Message Access Protocol ¢ un protocollo che consente a un client di



posta elettronica di accedere a un server di posta remoto. Supporta modalita di
funzionamento sia on-line che off-line.

interfaccia: Punto di interazione tra i componenti di un computer, spesso riferito al
collegamento tra un computer e una rete. Esempi di nomi di interfaccia in MX Linux
sono WLAN (wireless) e ethQ (cablata di base).



IRC: Internet Relay Chat, un vecchio protocollo per facilitare lo scambio di

messaggi di testo.

ISO: un'immagine del disco conforme a uno standard internazionale che contiene file di
dati e metadati del file system, compresi codice di avvio, strutture ¢ attributi. E il
metodo normale per distribuire versioni di Linux come MX Linux su Internet. Vedere
anche immagine disco.

kernel: 11 livello di software di un sistema operativo che interagisce direttamente

con I'hardware.

LiveCD/DVD: Disco compatto avviabile da cui € possibile eseguire un sistema
operativo, solitamente con un ambiente desktop completo, applicazioni e funzionalita
hardware essenziali.

LiveMedium: un termine generale che include sia LiveCD/DVD che LiveUSB.
LiveUSB: Un'unita flash USB su cui ¢ stato caricato un sistema operativo in modo da
poterlo avviare ed eseguire. Vedere LiveDVD.

indirizzo mac: indirizzo hardware che identifica in modo univoco ogni nodo (punto di
connessione) di una rete. E formato da una stringa di solito di sei serie di due cifre o
caratteri, separati da due punti.

pagina man: Abbreviazione di manuale, le pagine man contengono in genere
informazioni dettagliate su interruttori, argomenti e talvolta sul funzionamento interno
di un comando. Anche i programmi dell'interfaccia grafica hanno spesso pagine man,
che descrivono in dettaglio le opzioni disponibili sulla riga di comando. E disponibile
nel menu Start digitando un # prima del nome della pagina man desiderata nella casella
di ricerca, ad esempio: #pulseaudio.

MBR: Master Boot Record: il primo settore di 512 byte di un disco rigido avviabile. |
dati speciali scritti nel MBR consentono al BIOS del computer di passare il processo di
avvio a una partizione con un sistema operativo installato.

mdSsum: Programma che calcola e verifica l'integrita dei dati di un file. L'hash MDS5 (o
checksum) funziona come un'impronta digitale compatta di un file. E estremamente
improbabile che due file non identici abbiano lo stesso hash MDS5. Poiché quasi tutte le
modifiche apportate a un file causano la modifica del suo hash MD5, 1'hash MD5 ¢
comunemente utilizzato per verificare l'integrita dei file.

specchio: Anche sito mirror. Copia esatta di un altro sito Internet, comunemente
utilizzata per fornire piu fonti delle stesse informazioni e per fornire un accesso
affidabile a download di grandi dimensioni.

modulo: I moduli sono pezzi di codice che possono essere caricati e scaricati nel kernel
su richiesta. Estendono le funzionalita del kernel senza la necessita di riavviare il sistema.
mountpoint: Il punto del file system principale in cui un dispositivo fisso o rimovibile
¢ collegato (montato) e accessibile come sottodirectory. Tutto 1'hardware del computer
deve avere un punto di montaggio nel file system per essere utilizzabile. La maggior
parte dei dispositivi standard, come la tastiera, il monitor e il disco rigido primario,
vengono montati automaticamente all'avvio.

mtp: MTP ¢ I'acronimo di Media Transfer Protocol e opera a livello di file in modo

che il dispositivo non esponga l'intero dispositivo di archiviazione. I vecchi dispositivi
Android utilizzavano la memoria di massa USB per trasferire i file da un computer



all'altro.



NTFS®: Il New Technology File System di Microsoft ha debuttato nel 1993 sul sistema
operativo Windows NT, destinato alle reti aziendali, e con le successive revisioni ¢
entrato nei computer desktop degli utenti Windows con le versioni successive di
Windows 2000. E il file system standard dall'introduzione di Windows XP alla fine del
2001. Le persone orientate a Unix/Linux dicono che sta per "Nice Try File System"!
open-source: Software il cui codice sorgente ¢ stato reso disponibile al pubblico con
una licenza che consente ai singoli di modificare e ridistribuire il codice sorgente. In
alcuni casi, le licenze open-source limitano la distribuzione del codice binario
eseguibile.

pacchetto: Un pacchetto ¢ un insieme discreto di dati non eseguibili che include
istruzioni per il gestore di pacchetti sull'installazione. Un pacchetto non sempre contiene
una singola applicazione; potrebbe contenere solo una parte di un'applicazione di grandi
dimensioni, diverse piccole utility, dati di font, grafica o file di aiuto.

gestore di pacchetti: Un gestore di pacchetti, come Synaptic o Gdebi, ¢ un insieme

di strumenti per automatizzare il processo di installazione, aggiornamento,
configurazione e rimozione dei pacchetti software.

Pannello: Il pannello altamente configurabile di Xfce4 appare di default sul lato

sinistro dello schermo e contiene le icone di navigazione, 1 programmi aperti e le
notifiche di sistema.

Tabella delle partizioni: Una tabella di partizione ¢ un'architettura del disco rigido che
amplia il vecchio schema di partizionamento Master Boot Record (MBR) utilizzando
identificatori unici globali (GUID) per consentire I'esistenza di piu delle quattro partizioni
originali.

persistenza: la capacita di mantenere le modifiche apportate durante la sessione live

di LiveUSB.

porta: Una connessione dati virtuale che puo essere utilizzata dai programmi per
scambiare dati direttamente, invece di passare attraverso un file o un'altra posizione di
archiviazione temporanea. Le porte hanno numeri assegnati a protocolli e applicazioni
specifici, come 80 per HTTP, 5190 per AIM, ecc.

purge: Un comando che rimuove non solo il pacchetto nominato, ma anche tutti i file di
configurazione e di dati ad esso associati (ma non quelli nella home directory
dell'utente).

repo: Forma abbreviata di repository.

repository: Un repository software ¢ un luogo di archiviazione su Internet da cui ¢
possibile recuperare e installare pacchetti software tramite un gestore di pacchetti.

root: Root ha due significati comuni in un sistema operativo UNIX/Linux; sono
intimamente connessi, ma la distinzione ¢ importante da capire.

+ Il file system principale ¢ la struttura logica di base di tutti i file a cui il sistema
operativo puo accedere, siano essi programmi, processi, pipe o dati. Deve seguire
lo standard della gerarchia dei file system di Unix, che specifica la posizione nella
gerarchia di tutti 1 tipi di file.

* L'utente root ¢ il proprietario del file system root - e quindi ha tutti i permessi
necessari per fare qualsiasi cosa a qualsiasi file. Sebbene a volte sia necessario
assumere temporaneamente i poteri dell'utente /root/ per installare o configurare



programmi, ¢ pericoloso e viola la struttura di sicurezza di base di Unix/Linux
accedere e operare come /root/ se non ¢ assolutamente necessario. In
un'interfaccia a riga di comando, un utente normale puo diventare
temporaneamente root lanciando il comando su e inserendo la password di root.



* runlevel: Un runlevel ¢ uno stato operativo preimpostato in un sistema operativo Unix-
like. Un sistema puo essere avviato in uno dei diversi livelli di esecuzione, ciascuno dei
quali € rappresentato da un numero intero a una cifra. Ogni runlevel designa una diversa
configurazione del sistema e consente I'accesso a una diversa combinazione di processi
(cio¢ istanze di programmi in esecuzione). Si veda la Sezione 7.5.

escript: Un file di testo eseguibile, contenente comandi in un linguaggio
interpretato. Di solito si riferisce agli script BASH, molto utilizzati "sotto il
cofano" del sistema operativo Linux, ma possono essere utilizzati anche altri
linguaggi.

» sessione: Una sessione di login ¢ il periodo di attivita che intercorre tra il login e il
logout di un utente da un sistema. In MX Linux, questo indica tipicamente la durata di
un particolare "processo" dell'utente (il codice del programma e la sua attivita
corrente) che Xfce invoca.

SSD: Un'unita a stato solido (SSD) ¢ un dispositivo di archiviazione non volatile che

memorizza dati persistenti su una memoria flash a stato solido.

* codice sorgente: Il codice leggibile dall'uomo in cui il software ¢ scritto prima di
essere assemblato o compilato in codice di linguaggio macchina.

» switch: Uno switch (anche /flag/, /option/ o /parameter/) ¢ un modificatore aggiunto a
un comando per cambiarne il comportamento. Un esempio comune ¢ -R (ricorsivo),
che indica al computer di eseguire il comando attraverso tutte le sottodirectory.

» symlink: Anche link simbolico e soft link. Un tipo speciale di file che punta a un altro

file o directory e non a dati. Permette allo stesso file di avere nomi e/o posizioni diverse.

tarball: Un formato di archiviazione, come lo zip, molto diffuso sulla piattaforma
Linux. A differenza dei file zip, pero, i tarball possono utilizzare uno dei diversi formati
di compressione, come gzip o bzip2. Di solito terminano con estensioni di file come
.tgz, .tar.gz o .tar.bz2.

Molti formati di archivio sono supportati in MX con un'applicazione grafica chiamata
Archive Manager. Di solito un archivio pud essere estratto semplicemente facendo clic
con il tasto destro del mouse su di esso in Thunar.

(U)EFI: Unified Extensible Firmware Interface ¢ un tipo di firmware di sistema
utilizzato nelle macchine recenti. Definisce un'interfaccia software tra un sistema
operativo e il firmware della piattaforma e rappresenta il successore del vecchio

BIOS.

* Unix: Anche UNIX. Il sistema operativo su cui si basa Linux, sviluppato alla fine degli
anni '60 presso 1 Bell Labs e utilizzato principalmente per server e mainframe. Come
Linux, Unix ha molte varianti.

UUID (Universally Unique IDentifier). Un identificatore univoco universale (UUID) ¢

un numero di 128 bit che identifica oggetti o dati Internet unici.

» gestore di finestre: Un componente di un ambiente desktop che fornisce le funzioni di
base di massimizzazione/minimizzazione/chiusura/spostamento delle finestre
nell'ambiente GUI. A volte puo essere usato come alternativa a un ambiente desktop
completo. In MX Linux, il window manager predefinito ¢ Xfce4.

* X: anche X11, xorg. Il sistema X Window ¢ un protocollo di rete e di visualizzazione



che fornisce finestre su display bitmap. Fornisce il toolkit ¢ il protocollo standard per la
creazione di interfacce utente grafiche (GUI) su sistemi operativi Unix-like e
OpenVMS ed ¢ supportato da quasi tutti gli altri sistemi operativi moderni.



